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     [bookmark: pgfId-1054345]Overview
      
      
 
     
 
 
     [bookmark: pgfId-1054346]This chapter describes the role of the CMX Analytics service, that is supported on the Cisco mobility services engine (MSE).
 
     [bookmark: pgfId-1054347]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-1055058]About CMX Analytics Service
 
     	 [bookmark: pgfId-1054355]CMX Analytics Service Within the Cisco Unified Wireless Network
 
     	 [bookmark: pgfId-1054367]Getting Information on Your Network
 
    
 
   
 
    
     [bookmark: pgfId-1054369][bookmark: 84592]About CMX Analytics Service
 
     [bookmark: pgfId-1056612]The CMX analytics is a system that provides a set of data analytic tools packaged for analyzing Wi-Fi device location that comes from the MSE. The CMX analytics service is part of advanced location service, which has been integrated into the MSE in Release 7.4.
 
     [bookmark: pgfId-1057232]When a wireless device is enabled in a network, it transmits probe request packets to identify the wireless network in its vicinity. Even after connecting to the access point in the WLAN, the client devices continue to transmit probe request packets to identify other access points for better quality of service. The access point gathers the request and the associated Receiver Signal Strength Indicator (RSSI) from the various wireless devices and forwards them to the Wireless LAN Controller (WLC). The controller then forwards this information to the MSE for analysis.
 
     [bookmark: pgfId-1057233]The basic data that is collected from various APs, when analyzed, produces information and knowledge about the movement and behavior patterns of people who are using Wi-Fi devices in the building. For example, the building can be an airport, shopping mall, city center, and so on.
 
     [bookmark: pgfId-1056626]The CMX analytics system provides the following benefits to the venue owners:
 
     
     	 [bookmark: pgfId-1057291]Analyze business performance by measuring the in-venue activities and improve marketing.
 
     	 [bookmark: pgfId-1057303]Improve the signage, make changes to the underutilized areas.
 
     	 [bookmark: pgfId-1057319]Improve customer satisfaction though sufficient staffing during peak times.
 
    
 
     [bookmark: pgfId-1056467]The following table describes the steps to be followed while setting up the CMX analytics system.
 
     
      
       
        [bookmark: pgfId-1056354]Table 1-1 [bookmark: 80247]Process for Setting up the CMX analytics System
 
       
      
        
        	 
          
          [bookmark: pgfId-1056358]Process
         
  
        	 
          
          [bookmark: pgfId-1056360]Description
         
  
       
 
        
        	 [bookmark: pgfId-1056362] 1. Set up the Prime Infrastructure
  
        	 [bookmark: pgfId-1056472]See the Setting Up Prime Infrastructure for more information.
  
       
 
        
        	 [bookmark: pgfId-1056366] 2. Start the Prime Infrastructure
  
        	 [bookmark: pgfId-1056368]See the Starting the Prime Infrastructure Server for more information.
  
       
 
        
        	 [bookmark: pgfId-1056451] 3. Log into the Prime Infrastructure user interface
  
        	 [bookmark: pgfId-1056453]See the Logging into Prime Infrastructure User Interface for more information.
  
       
 
        
        	 [bookmark: pgfId-1056447] 4. Add Prime Infrastructure software license
  
        	 [bookmark: pgfId-1056449]See the Managing Licenses for more information.
  
       
 
        
        	 [bookmark: pgfId-1056443] 5. Add Mobility Services Engine to the Prime Infrastructure
  
        	 [bookmark: pgfId-1056445]See the Adding a Mobility Services Engine to the Prime Infrastructure for more information.
  
       
 
        
        	 [bookmark: pgfId-1056439] 6. Configure the MSE tracking and history parameters
  
        	 [bookmark: pgfId-1056441]See the Configuring MSE Tracking and History Parameters for more information.
  
       
 
        
        	 [bookmark: pgfId-1056435] 7. Check if the Prime Infrastructure is showing clients in real time.
  
        	 [bookmark: pgfId-1056437] See the Viewing Clients and Users for more information.
  
       
 
        
        	 [bookmark: pgfId-1056431] 8. Add floor areas to either a campus building or standalone building in the Prime Infrastructure
  
        	 [bookmark: pgfId-1056433]See the Adding Floor Areas to a Campus Buildingand the Adding Floor Plans to a Standalone Building for more information.
  
       
 
        
        	 [bookmark: pgfId-1056427] 9. Define a coverage area in the Prime Infrastructure
  
        	 [bookmark: pgfId-1056429]See the Defining Coverage Areafor more information.
  
       
 
        
        	 [bookmark: pgfId-1056423] 10. Add the GPS markers on all floors.
  
        	 [bookmark: pgfId-1056425]See the Adding a GPS Marker to a Floor Map for more information.
  
       
 
        
        	 [bookmark: pgfId-1056419] 11. Enable and start the CMX analytics service
  
        	 [bookmark: pgfId-1056421]See the Enabling CMX Analytics Service on the Mobility Services Engine for more information.
  
       
 
        
        	 [bookmark: pgfId-1056411]Note If there is data available in the MSE database, then you must wait for 15-20 minutes for sufficient data to get collected and uploaded to analytics. If the MSE is collecting data for first time, it takes more than an hour for sufficient data to get collected for analytics to take place. Once the data has started transferring from MSE to analytics database, it takes more than an hour to first become available for analytics. Points are assembled into path/visits and only the completed paths are written to the database. A path is closed if there are no new points that have appeared for over an hour.
  
       
 
        
        	 [bookmark: pgfId-1056458] 12. Start the CMX analytics user interface.
  
        	 [bookmark: pgfId-1056460]See the Logging into CMX Analytics User Interface for more information.
  
       
 
      
     
 
    
 
   
 
    
     [bookmark: pgfId-1054373][bookmark: 32943]CMX Analytics Service Within the Cisco Unified Wireless Network
 
     [bookmark: pgfId-1055658]Cisco Unified Wireless Network (CUWN) solution ensures that your business achieves the highest level of network security and versatility. Cisco UWN solution empowers your network with the ability to offer secure wireless networking, either within your office for increased mobility or bridging between your office buildings. The following are the components of CUWN:
 
     
     	 [bookmark: pgfId-1057090]Access Points—The Access point is the end point on the network side that provides the wireless access. The following access points are supported:
 
    
 
     [bookmark: pgfId-1057111]–[image: ] Cisco Aironet 801, 802, 1000, 1040, 1100, 1130, 1140, 1200, 1230, 1240, 1250, 1260, 1310, 1500,
 
     [bookmark: pgfId-1057092]–[image: ] 1524, 1552, 1600i, 1600e, 2600i, 2600e, 3500i, 3500e, 3500p, 3600i, and 3600e Series Lightweight Access Points.
 
     [bookmark: pgfId-1057094]–[image: ] Cisco Aironet 1040, 1100, 1130, 1141, 1142, 1200, 1240, 1250, 1260, 2600i, and 2600e Autonomous Access Points.
 
     [bookmark: pgfId-1057096]–[image: ] Cisco 600 Series OfficeExtend Access Points.
 
     [bookmark: pgfId-1057097]–[image: ] Cisco Aironet Access Points running Lightweight Access Point Protocol (LWAPP) or Control and Provisioning of Wireless Access Points (CAPWAP) protocol.
 
     
     	 [bookmark: pgfId-1057071]Wireless LAN Controllers—The WLAN controllers are highly scalable and flexible platforms that enables system wide services for mission-critical wireless in medium to large-sized enterprises and campus environments. Designed for 802.11n performance and maximum scalability, the WLAN controllers offer enhanced uptime with the ability to simultaneously manage from 5000 access points to 250 access points; superior performance for reliable streaming video and toll quality voice; and improved fault recovery for a consistent mobility experience in the most demanding environments.The controller actively manages these APs w.r.t what channel it operates, how does the client gets attach to it, what security types are supported and so on.
 
     	 [bookmark: pgfId-1055295]Cisco Prime Infrastructure—With the Prime Infrastructure, network administrator have a single solution for RF prediction, policy provisioning, network optimization, troubleshooting, user tracking, security monitoring, and wired and wireless LAN systems management. Robust graphical interfaces make wired and wireless LAN deployment and operations simple and soft-effective. Detailed trending and analysis reports make the Prime Infrastructure vital to ongoing network operations.
 
     	 [bookmark: pgfId-1057122]Mobility Services Engine—The Cisco MSE is an open platform that provides a new approach for delivery of the mobility services and applications. The MSE is managed by the Prime Infrastructure and supports various services.The Cisco 3300 Series Mobility Services Engine operates with CAS, which is a component of the CAM solution. There are two models of the mobility services engine:
 
    
 
     [bookmark: pgfId-1057132]–[image: ] Cisco 3310 Mobility Services Engine
 
     [bookmark: pgfId-1057135]–[image: ] Cisco 3355 Mobility Services Engine 
 
     [bookmark: pgfId-1055126]The following figure shows the overall architecture within which the CMX analytics system fits in. The CMX analytics system contains the following components:
 
     
     	 [bookmark: pgfId-1054375]Analysis
 
     	 [bookmark: pgfId-1054376]Reporting
 
     	 [bookmark: pgfId-1054377]Administration
 
    
 
     [bookmark: pgfId-1054381]Figure 1-1 CMX analytics Architecture
 
     
     [image: ] 
    
 
   
 
    
     [bookmark: pgfId-1055482][bookmark: 41680]Getting Information on Your Network
 
     [bookmark: pgfId-1055507]The process of downloading and creating a database of devices or path information is automatic. If the installation is new, then the collection of data starts immediately and continues to download increments of data every 15 minutes. If you are upgrading to an existing MSE that has been collecting data, then the system downloads data from the previous 3 days or from the last successful download (whatever is shortest) before continuing every 15 minutes. The analytics is available immediately when the data is in the database.
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1054569]Getting Started
      
      
 
     
 
 
     [bookmark: pgfId-1061137]This chapter provides information on prerequisites, system requirements, and enabling the Cisco CMX analytics service.
 
     [bookmark: pgfId-1061138]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-1101574]Prerequisites for Enabling CMX Analytics Service
 
     	 [bookmark: pgfId-1101582]Prime Infrastructure Delivery Modes
 
     	 [bookmark: pgfId-1101922]Reinstalling Prime Infrastructure on a Physical Appliance
 
     	 [bookmark: pgfId-1101586]Deploying Prime Infrastructure Virtual Appliance
 
     	 [bookmark: pgfId-1101591]Setting Up Prime Infrastructure
 
     	 [bookmark: pgfId-1101622]Starting the Prime Infrastructure Server
 
     	 [bookmark: pgfId-1101627]Logging into Prime Infrastructure User Interface
 
     	 [bookmark: pgfId-1101632]Managing Licenses
 
     	 [bookmark: pgfId-1101645]Adding a Mobility Services Engine to the Prime Infrastructure
 
     	 [bookmark: pgfId-1101650]Information About Synchronizing the Prime Infrastructure and Mobility Services Engines
 
     	 [bookmark: pgfId-1101662]Prerequisites for Synchronizing the Mobility Services Engine
 
     	 [bookmark: pgfId-1101667]Working with Third-Party Elements
 
     	 [bookmark: pgfId-1101696]Synchronizing Controllers with a Mobility Services Engine
 
     	 [bookmark: pgfId-1101701]Configuring Automatic Database Synchronization and Out-of-Sync Alerts
 
     	 [bookmark: pgfId-1101706]Viewing Mobility Services Engine Synchronization Status
 
     	 [bookmark: pgfId-1101715]Viewing Clients and Users
 
     	 [bookmark: pgfId-1101748]Adding Floor Areas
 
     	 [bookmark: pgfId-1101753]Defining Coverage Area
 
     	 [bookmark: pgfId-1101758]Monitoring Geo-Location
 
     	 [bookmark: pgfId-1101763]Inclusion and Exclusion Areas on a Floor
 
     	 [bookmark: pgfId-1101788]Enabling CMX Analytics Service on the Mobility Services Engine
 
     	 [bookmark: pgfId-1101817]Managing User Accounts
 
     	 [bookmark: pgfId-1101846]Logging into CMX Analytics User Interface
 
     	 [bookmark: pgfId-1101875]WebGL Requirements
 
     	 [bookmark: pgfId-1101896]Validating Analytics
 
    
 
   
 
    
     [bookmark: pgfId-1067488][bookmark: 56189]Prerequisites for Enabling CMX Analytics Service
 
     
     	 [bookmark: pgfId-1057469]The CMX analytics system takes input from the Cisco Mobilily Service Engine (MSE). The CMX analytics is installed as part of the MSE installation but you must select CMX Analytics service explicitly from the list of available services in the Prime Infrastructure UI. For details on enabling the CMX analytics service, see the “Enabling CMX Analytics Service on the Mobility Services Engine” section.
 
     	 [bookmark: pgfId-1084769]If you want to use data from specific parts of your network, then you must edit the mse.properties (/opt/mse/analytics/intellify/tools/MSEclient/mse.properties) file in order to select either network, building, or floor that you want to analyze. 
 
    
 
     [bookmark: pgfId-1093858]Follow these guidelines when editing the mse.properties file. 
 
     [bookmark: pgfId-1093859]–[image: ] Network, building, or floors—By default, the analytics takes all the data that is available in the MSE. These three settings allow you to download only a subset. For example, if you have three building B1, B2, and B3 in network N and want to run analytics only on building B1 and building B2, then you need to specify as buildings=N>B1,N>B2.
 
     [bookmark: pgfId-1093860]–[image: ] max-history—By default, when the analytics becomes active for the first time, it searches for the previous three days data in the MSE history file and tries to fetch data if there is any. If there is more data available in the history file and you want to retrieve, then you must set this to a different value.
 
     [bookmark: pgfId-1093861]If you set the max-history to nnnD, then it retrieves nnn days and if you set to nnnW, then it retrieves nnn weeks.
 
     [bookmark: pgfId-1084289]–[image: ] Control the size of the database—A new parameter Prune db parameters is added in the mse.properties file to help control the size of the database. Once the database reaches the threshold value of 5million points, it removes the oldest data to reset the size to 4.9 million points.
 
     
      
    
 
    
 
    [bookmark: pgfId-1084290]Note In order for the CMX analytics to access data from the MSE, you must set the history parameters on the MSE. For more information, see the “Configuring MSE Tracking and History Parameters” section.

     
     
 
    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-1083651]Note Depending on your browser and the hardware, images over 2MB may not appear in the 3D environment. In the mse.properties file, set the value of max-dimension. For example, setting max-dimension to 2048 can reduce the resolution of the picture to at most 2048 pixels on the longest side.

     
     
 
    

    
 
     [bookmark: pgfId-1057551]–[image: ] All settings (including the above mentioned information) are documented in the properties file.
 
     
     	 [bookmark: pgfId-1057552]CMX analytics requires both floor plans and coverage areas to be defined in the Prime Infrastructure UI in order for CMX analytics visualization and reporting to function. You need to provide floor numbers for each floor plan. Floors on the same level should have the same number and floors above should have a higher number. The choice of coverage areas correspond to the zones which you want to report on. If you want to know the details of location A, then an area defining that location should be made available in the Prime Infrastructure. See the “Adding Floor Areas” section and “Defining Coverage Area” section for more information.
 
     	 [bookmark: pgfId-1057669]You must define at least three GPS markers for each floor in the Prime Infrastructure UI.
 
     	 [bookmark: pgfId-1066085]You need three APs to get any location information on the device.
 
    
 
   
 
    
     [bookmark: pgfId-1093888][bookmark: 30699]Prime Infrastructure Delivery Modes
 
     [bookmark: pgfId-1093889]Prime Infrastructure comes preinstalled on a physical appliance with various performance characteristics. Prime Infrastructure software runs on either a dedicated Prime Infrastructure appliance or on a VMware server. Prime Infrastructure software image does not support the installation of any other packages or applications on this dedicated platform. The inherent scalability of Prime Infrastructure allows you to add appliances to a deployment and increase performance and resiliency.
 
     [bookmark: pgfId-1093890]Prime Infrastructure is delivered in two modes, the physical appliance and the virtual appliance. This section contains the following topics:
 
     
     	 [bookmark: pgfId-1093894]Physical Appliance
 
     	 [bookmark: pgfId-1093898]Virtual Appliance
 
     	 [bookmark: pgfId-1093902]Operating Systems Requirements
 
     	 [bookmark: pgfId-1093906]Client Requirements
 
     	 [bookmark: pgfId-1080223]Prerequisites
 
    
 
     
      [bookmark: pgfId-1093916][bookmark: 73663]Physical Appliance
 
      [bookmark: pgfId-1093918]The physical appliance is a dual Intel 2.40 GHz Xeon E5620 quad core processor, with 16 GB RAM, and four hard drives running in a RAID level 5 configuration. The physical appliance runs the latest 64-bit Red Hat Linux Operating System.
 
      [bookmark: pgfId-1093919]The physical appliance supports up to 15000 Cisco Aironet lightweight access points, 5000 standalone access points, 5000 switches and 1200 Cisco wireless LAN controllers.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080233]Note To receive the expected results with the Prime Infrastructure, you need a high performance physical appliance with built-in redundancy for hard disks, power supplies and internal cooling fans.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1093929][bookmark: 68457]Virtual Appliance
 
      [bookmark: pgfId-1093936]Prime Infrastructure is also offered as a virtual appliance to help support lower level deployments. Prime Infrastructure can be run on a workstation or a server and access points can be distributed unevenly across controllers.
 
      [bookmark: pgfId-1093937]Prime Infrastructure virtual appliance software is distributed as an Open Virtualization Archive (OVA) file. There are three recommended levels of Prime Infrastructure distribution with different resources and numbers of devices supported. 
 
      [bookmark: pgfId-1093938]This section contains the following topics:
 
      
      	 [bookmark: pgfId-1093942]Virtual Appliance for Large Deployment
 
      	 [bookmark: pgfId-1093946]Virtual Appliance for Medium Deployment
 
      	 [bookmark: pgfId-1093950]Virtual Appliance for Small Deployment
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1093951]Note You can deploy the OVA file directly from the vSphere Client; you do not need to extract the archive before performing the deployment. 

      
      
 
     

     
 
      [bookmark: pgfId-1093952]You can install the Prime Infrastructure virtual appliance using any of the methods for deploying an OVF supported by the VMware environment. Before starting, make sure that Prime Infrastructure virtual appliance distribution archive is in a location that is accessible to the computer on which you are running the vSphere Client. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1093953]Note For more information about setting up your VMware environment, see the VMware vSphere 4.0 documentation.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1080258][bookmark: 72750]Virtual Appliance for Large Deployment
 
      
      	 [bookmark: pgfId-1080259]Supports up to 15000 Cisco Aironet lightweight access points, 5000 standalone access points, 5000 switches, and 1200 Cisco wireless LAN controllers.
 
      	 [bookmark: pgfId-1080260]16 Processors at 2.93 GHz or better.
 
      	 [bookmark: pgfId-1080261]16-GB RAM.
 
      	 [bookmark: pgfId-1080262]300 GB minimum free disk space is required on your hard drive.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080263]Note The free disk space listed is a minimum requirement but might be different for your system depending on the number of backups that are performed.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1093959][bookmark: 81940]Virtual Appliance for Medium Deployment
 
      
      	 [bookmark: pgfId-1093960]Supports up to 7500 Cisco Aironet lightweight access points, 2500 standalone access points, 2500 switches, and 600 Cisco wireless LAN controllers.
 
      	 [bookmark: pgfId-1093961]8 Processors at 2.93 GHz or better.
 
      	 [bookmark: pgfId-1093962]12-GB RAM.
 
      	 [bookmark: pgfId-1093963]300 GB minimum free disk space is required on your hard drive.
 
     
 
    
 
     
      [bookmark: pgfId-1093969][bookmark: 96976]Virtual Appliance for Small Deployment
 
      
      	 [bookmark: pgfId-1093970]Supports up to 3000 Cisco Aironet lightweight access points, 1000 standalone access points, 1000 switches, and 240 Cisco wireless LAN controllers.
 
      	 [bookmark: pgfId-1093971]4 Processors at 2.93 GHz or better.
 
      	 [bookmark: pgfId-1093972]8-GB RAM.
 
      	 [bookmark: pgfId-1093973]200 GB minimum free disk space is required on your hard drive.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1093974]Note The free disk space listed is a minimum requirement, but several variables (such as backups) impact the disk space.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1080280][bookmark: 69116]Operating Systems Requirements
 
      [bookmark: pgfId-1080281]The following operating systems are supported:
 
      
      	 [bookmark: pgfId-1080282]Red Hat Linux Enterprise server 5.4 64-bit operating system installations are supported.
 
      	 [bookmark: pgfId-1080283]Red Hat Linux version support on VMware ESX version 3.0.1 and later with either local storage or SAN over fiber channel.
 
      	 [bookmark: pgfId-1080284]The recommended deployments for a virtual appliance are UCS and ESX/ESXi.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080285]Note Individual operating systems running Prime Infrastructure in VMware must follow the specifications for the size of Prime Infrastructure that you intend to use.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1080287][bookmark: 87661]Client Requirements
 
      [bookmark: pgfId-1080288]Prime Infrastructure user interface requires Mozilla Firefox 11.0 or 12.0 or Internet Explorer 8 or 9 with the Chrome plug-in releases or Google Chrome 19.0.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080289]Note We strongly advise that you do not enable third-party browser extensions. In Internet Explorer, you can disable third-party browser extensions by choosing Tools > Internet Options and unselecting the Enable third-party browser extensions check box on the Advanced tab.

      
      
 
     

     
 
      [bookmark: pgfId-1080290]The client running the browser must have a minimum of 1 GB of RAM and a 2-GHz processor. The client device should not be running any CPU or memory-intensive applications.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080291]Note We recommend a minimum screen resolution of 1280 x 800 pixels.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1080293][bookmark: 37942]Prerequisites
 
      [bookmark: pgfId-1080294]Before installing Prime Infrastructure, ensure that you have completed the following:
 
      
      	 [bookmark: pgfId-1080295]Meet the necessary hardware and software requirements for Prime Infrastructure.
 
      	 [bookmark: pgfId-1080296]Check the compatibility matrix for the supported controller, Cisco IOS software releases.
 
      	 [bookmark: pgfId-1080297]Update your system with the necessary critical updates and service packs.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080298]Note See the latest release notes for information on the service packs and patches required for correct operation of Prime Infrastructure.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080299]To receive the expected results, you should run no more than 3 concurrent Prime Infrastructure setups for standard server use (4 GB memory and 3 GHz CPU speed) and no more than 5 concurrent Prime Infrastructure setups for high-end server use (8 GB memory and 3 GHz CPU speed).
 
      	 [bookmark: pgfId-1080300]Verify that the following ports are open during installation and startup:
 
     
 
      [bookmark: pgfId-1080301]–[image: ] HTTP: configurable during install (80 by default)
 
      [bookmark: pgfId-1080302]–[image: ] HTTPS: configurable during install (443 by default)
 
      [bookmark: pgfId-1080303]–[image: ] 1315
 
      [bookmark: pgfId-1080304]–[image: ] 1299
 
      [bookmark: pgfId-1080305]–[image: ] 6789
 
      [bookmark: pgfId-1080306]–[image: ] 8009
 
      [bookmark: pgfId-1080307]–[image: ] 8456
 
      [bookmark: pgfId-1080308]–[image: ] 8005
 
      [bookmark: pgfId-1080309]–[image: ] 69
 
      [bookmark: pgfId-1080310]–[image: ] 21
 
      [bookmark: pgfId-1080311]–[image: ] 162
 
      [bookmark: pgfId-1080312]–[image: ] 8457
 
      [bookmark: pgfId-1080313]–[image: ] 1522 (for HA configuration between the primary and secondary Prime Infrastructure)
 
      
       
     
 
     
 
     [bookmark: pgfId-1080314]Note Make sure your firewall rules are not restrictive. You can check the current rules on Linux with the built-in iptables -L command.

      
      
 
     

     
 
    
 
   
 
    
     [bookmark: pgfId-1093980][bookmark: 84334]Reinstalling Prime Infrastructure on a Physical Appliance
 
     [bookmark: pgfId-1093981]You must have root privileges to install Prime Infrastructure on a physical appliance.
 
     [bookmark: pgfId-1093982]To reinstall Prime Infrastructure on a physical appliance, follow these steps:
 
    
 
     [bookmark: pgfId-1093983] Step 1[image: ] Insert the provided Prime Infrastructure software Image DVD. The system boots up and the following console appears:
 
    
     [bookmark: pgfId-1093984]ISOLINUX 3.11 2005-09-02 Copyright (C) 1994-2005 
    

    
     [bookmark: pgfId-1093985]
    

    
     [bookmark: pgfId-1093986] Welcome to Cisco Prime Infrastructure
    

    
     [bookmark: pgfId-1093987]
    

    
     [bookmark: pgfId-1093988]To boot from hard disk, press <Enter>.
    

    
     [bookmark: pgfId-1093989]
    

    
     [bookmark: pgfId-1093990]Available boot options:
    

    
     [bookmark: pgfId-1093991]
    

    
     [bookmark: pgfId-1093992] [1] Prime Infrastructure Installation (Keyboard/Monitor)
    

    
     [bookmark: pgfId-1093993] [2] Prime Infrastructure Installation (Serial Console)
    

    
     [bookmark: pgfId-1093994] [3] Recover administrator password. (Keyboard/Monitor)
    

    
     [bookmark: pgfId-1093995] [4] Recover administrator password. (Serial Console)
    

    
     [bookmark: pgfId-1093996] <Enter> Boot existing OS from Hard Disk.
    

    
     [bookmark: pgfId-1093997]
    

    
     [bookmark: pgfId-1093998]Enter boot option and press <return>.
    

    
     [bookmark: pgfId-1093999]
    

    
     [bookmark: pgfId-1094000]boot:
    

    
     [bookmark: pgfId-1094001]
    

     [bookmark: pgfId-1094002]Step 2[image: ] Select option 1 to reinstall Prime Infrastructure software image. The system reboots and the configure appliance screen appears.
 
     [bookmark: pgfId-1094003]Step 3[image: ] Enter the initial setup parameters and the system reboots again. Remove the DVD and follow the steps to start the Prime Infrastructure server.
 
     [bookmark: pgfId-1094004]

     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1094006][bookmark: 61001]Deploying Prime Infrastructure Virtual Appliance
 
     [bookmark: pgfId-1094008][bookmark: marker-1094007]This section describes how to deploy the Prime Infrastructure virtual appliance from the VMware vSphere Client using the Deploy OVF Wizard or from the command line. (VMware vSphere Client is a Windows application for managing and configuring the vCenter Server.) This section contains the following topics:
 
     
     	 [bookmark: pgfId-1094012]Deploying Prime Infrastructure Virtual Appliance from the VMware vSphere Client
 
     	 [bookmark: pgfId-1094016]Deploying Prime Infrastructure Virtual Appliance using the Command Line Client 
 
    
 
     
      [bookmark: pgfId-1094022][bookmark: 85905]Deploying Prime Infrastructure Virtual Appliance from the VMware vSphere Client
 
      [bookmark: pgfId-1094023]Prime Infrastructure Virtual Image is packaged as an OVA file. An OVA is a collection of items in a single archive. In the vSphere Client, you can use the Deploy OVF Wizard to create a virtual machine, running the Prime Infrastructure virtual appliance application, as described in this section.
 
      
       
     
 
     
 
     [bookmark: pgfId-1094024]Note While the following procedure provides a general guideline for how to deploy the Prime Infrastructure virtual appliance, the exact steps that you need to perform might vary depending on the characteristics of your VMware environment and setup.

      
      
 
     

     
 
      [bookmark: pgfId-1094025]To deploy the Prime Infrastructure virtual appliance, follow these steps:
 
     
 
      [bookmark: pgfId-1094026] Step 1[image: ] From the VMware vSphere Client main menu, choose  File >  Deploy OVF Template . The Deploy OVF Template Source window appears (see Figure 2-1).
 
      [bookmark: pgfId-1094031]Figure 2-1 [bookmark: 20934]Deploy OVF Template Window
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1094036]Step 2[image: ] Choose  Deploy from file and choose the OVA file that contains the Prime Infrastructure virtual appliance distribution.
 
      [bookmark: pgfId-1094037]Step 3[image: ] Click  Next . The OVF Template Details window appears. VMware ESX/ESXi reads the OVA attributes. The details include the product you are installing, the size of the OVA file (download size), and the amount of disk space that needs to be available for the virtual machine (size on disk).
 
      [bookmark: pgfId-1094038]Step 4[image: ] Verify the OVF Template details and click  Next . The Name and Location window appears (see Figure 2-2).
 
      [bookmark: pgfId-1094043]Figure 2-2 [bookmark: 75386]Name and Location Window
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1094048]Step 5[image: ] Either keep the default name for the VM to be deployed in the Name text box or provide a new one and click  Next . This name value is used to identify the new virtual machine in the VMware infrastructure; you should use any name that distinguishes this particular VM in your environment. The Host / Cluster[image: ] window appears (see Figure 2-3).
 
      [bookmark: pgfId-1094056]Figure 2-3 [bookmark: 11047]Host/Cluster Window
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1094057]Step 6[image: ] Choose the destination host or HA cluster on which you want to deploy the Prime Infrastructure VM, and click  Next . The Resource Pool window appears.
 
      [bookmark: pgfId-1094058]Step 7[image: ] If you have more than one resource pool in your target host environment, choose the resource pool to use for the deployment, and click  Next . The Ready to Complete window appears. 
 
      [bookmark: pgfId-1094059]Step 8[image: ] Review the settings shown for your deployment and, if needed, click  Back to modify any of the settings shown. 
 
      [bookmark: pgfId-1094060]Step 9[image: ] Click  Finish to complete the deployment. A message notifies you when the installation completes and you can see the Prime Infrastructure virtual appliance in your inventory.
 
      [bookmark: pgfId-1094061]Step 10[image: ] Click  Close to dismiss the Deployment Completed Successfully dialog box.
 
      [bookmark: pgfId-1080397]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1094067][bookmark: 47750]Deploying Prime Infrastructure Virtual Appliance using the Command Line Client
 
      [bookmark: pgfId-1094068]This section describes how to deploy Prime Infrastructure virtual appliance from the command line. As an alternative to using the vSphere Client to deploy Prime Infrastructure OVA distribution, you can use the VMware OVF Tool, which is a command-line client.
 
      [bookmark: pgfId-1094069]To deploy an OVA with the VMware OVF Tool, use the  ovftool command, which takes the name of the OVA file to be deployed and the target location as arguments, as in the following example:
 
     
      [bookmark: pgfId-1094070]ovftool Prime Infrastructure-VA-X.X.X-large.ova vi://my.vmware-host.example.com/ 
     

     
      [bookmark: pgfId-1094071]
     

      [bookmark: pgfId-1094072]In this case, the OVA file to be deployed is Prime Infrastructure-VA-X.X.X-large.ova and the target ESX host is my.vmware-host.example.com. For complete documentation on the VMware OVF Tool, see the VMware vSphere 4.0 documentation.
 
    
 
   
 
    
     [bookmark: pgfId-1094078][bookmark: 30075]Setting Up Prime Infrastructure
 
     [bookmark: pgfId-1094079]This section describes how to configure the initial settings of Prime Infrastructure virtual appliance. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1094080]Note These steps need to be performed only once, upon first installation of Prime Infrastructure virtual appliance.

     
     
 
    

    
 
     [bookmark: pgfId-1080411]To configure the basic network and login settings for Prime Infrastructure virtual appliance system, follow these steps. When the steps are completed, Prime Infrastructure virtual appliance is accessible over the network.
 
     
      
    
 
    
 
    [bookmark: pgfId-1080412]Note Once you put Prime Infrastructure Image DVD in the physical appliance for reinstallation, you get the same console prompt. Use the following steps to reinstall Prime Infrastructure for the physical appliance.

     
     
 
    

    
 
    
 
     [bookmark: pgfId-1094085] Step 1[image: ] At the login prompt, enter the  setup command.
 
    
     [bookmark: pgfId-1094086]localhost.localdomain login: setup

    

     [bookmark: pgfId-1094087]Prime Infrastructure configuration script starts. The script takes you through the initial configuration steps for Prime Infrastructure virtual appliance. In the first sequence of steps, you configure network settings. 
 
     [bookmark: pgfId-1094088]Step 2[image: ] When prompted, enter the following settings:
 
     [bookmark: pgfId-1094089] a.[image: ] The hostname for the virtual appliance.
 
     [bookmark: pgfId-1094090] b.[image: ] The IP address for the virtual appliance.
 
     [bookmark: pgfId-1094091] c.[image: ] The IP default subnet mask for the IP address entered.
 
     [bookmark: pgfId-1094092] d.[image: ] The IP address of the default gateway for the network environment in which you are creating the virtual machine.
 
     [bookmark: pgfId-1094093] e.[image: ] The default DNS domain for the target environment.
 
     [bookmark: pgfId-1094094] f.[image: ] The IP address or hostname of the primary IP nameserver in the network.
 
     [bookmark: pgfId-1094095] g.[image: ] At the Add/Edit another nameserver prompt, you can enter  y (yes) to add additional nameservers, if desired. Otherwise, press  Enter to continue.
 
     [bookmark: pgfId-1094096] h.[image: ] The NTP server location (or accept the default by pressing  Enter ). At the Add/Edit secondary NTP server prompt, you can enter  y (yes) to add another NTP server. Otherwise, enter  n (no) to continue. 
 
     [bookmark: pgfId-1094097]Step 3[image: ] Enter the username for the user account used to access Prime Infrastructure system running on the virtual machine. The default username is admin, but you can change this to another username by typing it here. 
 
     [bookmark: pgfId-1094098]Step 4[image: ] Enter the password for Prime Infrastructure. The password must be at least eight characters and must include both lowercase and uppercase letters and at least one number. It cannot include the username. After you enter the password, the script verifies the network settings you configured. For example, it attempts to reach the default gateway that you have configured.
 
 After verifying the network settings, the script starts Prime Infrastructure installation processes. This process can take several minutes, during which there is no screen feedback. When finished, the following banner appears on the screen: 
 
    
     [bookmark: pgfId-1094099]=== Initial Setup for Application: Prime Infrastructure ===

    

     [bookmark: pgfId-1094100]After this banner appears, the configuration starts with database scripts and reboots the server. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1094101]Note If you are installing a physical appliance, remove the ISO DVD from the DVD tray.

     
     
 
    

    
 
     [bookmark: pgfId-1094102]Step 5[image: ] Log in as admin and enter the admin password.
 
     [bookmark: pgfId-1094103]Step 6[image: ] Exit the console using the  exit command.
 
     [bookmark: pgfId-1080432]

     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1094110][bookmark: 89333]Starting the Prime Infrastructure Server
 
     [bookmark: pgfId-1094111]This section provides instructions for starting Prime Infrastructure on either a physical or virtual appliance.
 
     [bookmark: pgfId-1094112]To start Prime Infrastructure when it is installed on a physical or virtual appliance, follow these steps:
 
    
 
     [bookmark: pgfId-1094113] Step 1[image: ] Log into the system as administrator.
 
     [bookmark: pgfId-1094114]Step 2[image: ] Using the command-line interface, enter the following command:
 
    
     [bookmark: pgfId-1094115]ncs start
    

     [bookmark: pgfId-1094116]

     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1094127][bookmark: 42956]Logging into Prime Infrastructure User Interface
 
     [bookmark: pgfId-1094130]To log into Prime Infrastructure user interface through a web browser, follow these steps:
 
    
 
     [bookmark: pgfId-1094131] Step 1[image: ] Launch Internet Explorer 8 or 9 or Mozilla Firefox 11.0 or 12.0 on a different computer than the one on which you installed and started Prime Infrastructure.
 
     
      
    
 
    
 
    [bookmark: pgfId-1094132]Note When you use Firefox to log in and access Prime Infrastructure for the first time, the Firefox web browser displays a warning stating that the site is untrustable. When Firefox displays this warning, follow the prompts to add a security exception and download the self-signed certificate from Prime Infrastructure server. After you complete this procedure, Firefox accepts Prime Infrastructure server as a trusted site both now and during all future login attempts. 

     
     
 
    

    
 
     [bookmark: pgfId-1094133]Step 2[image: ] In the address line of browser, enter https://ncs-ip-address, where ncs-ip-address is the IP address of the server on which you installed and started Prime Infrastructure. Prime Infrastructure user interface displays the  Login  page.
 
     [bookmark: pgfId-1094134]Step 3[image: ] Enter your username. The default username is root.
 
     [bookmark: pgfId-1094135]Step 4[image: ] Enter the root password you created during setup.
 
     
      
    
 
    
 
    [bookmark: pgfId-1094136]Note If any licensing problems occur, a message appears in an alert box. If you have an evaluation license, the number of days until the license expires is shown. You are also alerted to any expired licenses. You have the option to go directly to the licensing page to address these problems. 

     
     
 
    

    
 
     [bookmark: pgfId-1094137]Step 5[image: ] Click  Login to log into Prime Infrastructure. Prime Infrastructure user interface is now active and available for use. Prime Infrastructure home page appears. Prime Infrastructure home page enables you to choose the information that you want to see. You can organize the information in user-defined tabs called dashboards. The default view comes with default dashboards and preselected dashlets for each, and you can arrange them as you like. You can predefine what appears on the home page by choosing the monitoring dashlets that are critical for your network. For example, you might want different monitoring dashlets for a mesh network so that you can create a customized mesh dashboard.
 
     
      
    
 
    
 
    [bookmark: pgfId-1094139]Note If the database or Apache web server does not start, check the launchout.txt file in Linux. You see a generic “failed to start database” or “failed to start the Apache web server” message.

     
     
 
    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-1094140]Note When an upgrade occurs, the user-defined tabs arranged by the previous user in the previous version are maintained. Therefore, the latest dashlets might not show. Look at the Edit dashboard link to find what new dashlets are added.

     
     
 
    

    
 
     [bookmark: pgfId-1094141]The home page provides a summary of the Cisco Unified Network Solution, including coverage areas, the most recently detected rogue access points, access point operational data, reported coverage holes, and client distribution over time. 
 
     [bookmark: pgfId-1094142]By default, you should see six dashboards in Prime Infrastructure home page: the General, Client, Security, Mesh, CleanAir, and ContextAware dashboards. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1094143]Note When you use Prime Infrastructure for the first time, the network summary pages show that the Controllers, Coverage Areas, Most Recent Rogue APs, Top 5 APs, and Most Recent Coverage Holes databases are empty. It also shows that no client devices are connected to the system. After you configure Prime Infrastructure database with one or more controllers, Prime Infrastructure home page provides updated information.

     
     
 
    

    
 
     [bookmark: pgfId-1094145]To exit Prime Infrastructure user interface, close the browser page or click  Log Out in the upper-right corner of the page. Exiting an Prime Infrastructure user interface session does not shut down Prime Infrastructure on the server.
 
     [bookmark: pgfId-1100851]When a system administrator stops Prime Infrastructure server during your Prime Infrastructure session, your session ends, and the web browser displays the message: “The page cannot be displayed.” Your session does not reassociate to Prime Infrastructure when the server restarts. You must restart Prime Infrastructure session.
 
   
 
    
     [bookmark: pgfId-1100840][bookmark: 90979]Managing Licenses
 
     [bookmark: pgfId-1080478]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1080482]License Center
 
     	 [bookmark: pgfId-1080486]Managing Prime Infrastructure Licenses
 
     	 [bookmark: pgfId-1080490]Monitoring Controller Licenses
 
     	 [bookmark: pgfId-1080494]Managing Mobility Services Engine (MSE) Licenses
 
    
 
     
      [bookmark: pgfId-1080498][bookmark: 79623]License Center
 
      [bookmark: pgfId-1080499]The License Center allows you to manage Prime Infrastructure, wireless LAN controllers, and MSE licenses. The License Center is available from Prime Infrastructure Administration menu. To view the License Center page, choose  Administration > License Center .
 
      
       
     
 
     
 
     [bookmark: pgfId-1080500]Note Although Prime Infrastructure and MSE licenses can be fully managed from the License Center, WLC licenses can only be viewed. You must use WLC or CLM to manage WLC licenses.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080502]Tip To learn more about Prime Infrastructure License Center, go to Cisco.com to watch a multimedia presentation. Here you can also find the learning modules for a variety of Prime Infrastructure topics. Over future releases, we will add more overview and technical presentations to enhance your learning.

      
      
 
     

     
 
      [bookmark: pgfId-1080503]This section contains the following topics:
 
      
      	 [bookmark: pgfId-1080507]Prime Infrastructure License Information
 
      	 [bookmark: pgfId-1080511]WLC Controller License Information
 
      	 [bookmark: pgfId-1080515]WLC Controller License Summary
 
      	 [bookmark: pgfId-1080519]Mobility Services Engine (MSE) License Information
 
      	 [bookmark: pgfId-1080523]Mobility Services Engine (MSE) License Summary
 
     
 
    
 
     
      [bookmark: pgfId-1080549][bookmark: 18427]Prime Infrastructure License Information
 
      [bookmark: pgfId-1080550]Prime Infrastructure Licenses portion of the License Center page displays the following:
 
      
      	 [bookmark: pgfId-1080552]Feature—The type of license. It can be Prime Infrastructure or DEMO.
 
      	 [bookmark: pgfId-1080553]Device Limit—The total number of licensed access points and switches.
 
      	 [bookmark: pgfId-1080554]Device Count—The current number of access points and switches using licenses.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080555]Note AP count includes both associated and unassociated access points. When you are near the AP limit, you can delete any unassociated access points to increase available license capacity. For a demo license, you can click the “If you do not have a Product Authorization Key (PAK), please click here for available licenses” link and choose Wireless Control System Trial License.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080556]Note Autonomous access points are not counted towards the total device count for your license.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080557]% Used—The percentage of access points and switches licensed across Prime Infrastructure. If the percentage drops to 75%, the value appears in red. At this level, a message also appears indicating that both associated and unassociated access points are part of the AP count.
 
      	 [bookmark: pgfId-1080559][bookmark: marker-1080558]Type—Permanent if all licenses are permanent. If any licenses are evaluations (or demos), it shows the number of days remaining on the license that has the fewest number of days until expiration.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080560]Note To obtain a new license for Prime Infrastructure, go to the Product License Registration link

(https://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet)

and provide your Product Authorization Key (PAK) and hostname.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080562]Note If you choose Summary > Prime Infrastructure from the left sidebar menu, only Prime Infrastructure license information is displayed.

      
      
 
     

     
 
      [bookmark: pgfId-1080563]See the  Cisco Wireless Control System Licensing and Ordering Guide at this URL:
  http://www.cisco.com/en/US/prod/collateral/wireless/ps5755/ps6301/ps6305/product_data_sheet0900aecd804b4646.html#wp9000156 . 
 
 It covers selecting the correct SKU, ordering the SKU, installing the software, registering the PAK certificate, and installing the license file on the server.
 
    
 
     
      [bookmark: pgfId-1080585][bookmark: 72733]WLC Controller License Information
 
      [bookmark: pgfId-1080587][bookmark: marker-1080586]The Controller Licensing portion of the License Center page provides the following information for both WPLUS and Base licenses:
 
      
      	 [bookmark: pgfId-1080588]Controller Count—The current number of licensed controllers.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080589]Note Only 5500 series controllers are included in the count. Prime Infrastructure provides only an inventory view and issues warnings if a license is expiring.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080590]Note Clicking the number in this column is the same as choosing Summary > Controller from the left sidebar menu, except that it is sorted by the feature you select. This page provides a summary of active controllers.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080591]AP Limit—The total number of licensed access points.
 
      	 [bookmark: pgfId-1080592]Type—The four different types of licenses are as follows:
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080593]Note For any controllers with a type other than Permanent, the least number of days left to expiration is shown.

      
      
 
     

     
 
      [bookmark: pgfId-1080595]–[image: ] Permanent—Licenses are node-locked and have no usage period associated with them. They are issued by the licensing portal of Cisco and must be installed using management interfaces on the device. Upon installation of these licenses, you have the necessary permissions across different versions.
 
      [bookmark: pgfId-1080597]–[image: ] Evaluation—Licenses are non-node-locked and are valid only for a limited period. They are used only when no permanent, extension, or grace period licenses exist. Before using an evaluation license, you must accept an End User License Agreement (EULA). Even though they are non-node-locked, their usage is recorded on the device. The number of days remaining on the evaluation license that has the fewest number of days until expiration is shown. 
 
      [bookmark: pgfId-1080599]–[image: ] Extension—Licenses are node-locked and metered. They are issued by licensing portal of Cisco and must be installed using management interfaces on the device. Before using an extension license, you must accept a EULA during installation.
 
      [bookmark: pgfId-1080601]–[image: ] Grace Period—Licenses are node-locked and metered. These licenses are issued by the licensing portal of Cisco as part of the permission ticket to rehost a license. They are installed on the device as part of the rehost operation, and you must accept a EULA as part of the rehost operation.
 
      [bookmark: pgfId-1080602]If you need to revoke a license from one controller and install it on another, it is called  rehosting . You might want to rehost a license to change the purpose of a controller.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080603]Note The licensing status is updated periodically. To initiate an immediate update, choose Administration > Background Tasks and run the Controller License Status task. 

      
      
 
     

     
 
      [bookmark: pgfId-1080604]If your network contains various Cisco licensed devices, you might want to consider using the Cisco License Manager (CLM) to manage all of the licenses using a single application. CLM is a secure client/server application that manages Cisco software licenses network wide. You can download the CLM software and access user documentation at this URL:  http://www.cisco.com/go/clm . You can either register a PAK certificate with CLM or with the licensing portal found at the following URL:  https://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet .
 
    
 
     
      [bookmark: pgfId-1080628][bookmark: 32351]WLC Controller License Summary
 
      [bookmark: pgfId-1080629]If you want to see more details about controller licensing, from the left sidebar menu, choose the  Summary > Controller . The License Center page appears. All currently active licenses on the controller are summarized. 
 
      [bookmark: pgfId-1080630]All licensed controllers and their information in the bulleted list below are displayed. If you want to change how the controller results are displayed, click Edit View. In the Edit View page, highlight License Status, and click Hide to remove the column from the display. 
 
      [bookmark: pgfId-1080631]Above the Controller Summary list is a series of filters that allow you to filter the list by Controller Name, Feature, Type, or Greater Than Percent Used. For example, if you enter 50, the list shows any WLCs that have more than 50% of its licenses used.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080632]Note You can also use the Advanced Search link to sort the list of controllers.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080633]Controller Name—Provides a link to the Files > Controller Files page.
 
      	 [bookmark: pgfId-1080634]Controller IP—The IP address of the controller.
 
      	 [bookmark: pgfId-1080635]Model—The controller model type.
 
      	 [bookmark: pgfId-1080636]Feature—The type of license, either Base or WPLUS. The Base license supports the standard software set, and the WPLUS license supports the premium Wireless Plus (WPLUS) software set. The WPLUS software set provides the standard feature set as well as added functionality for OfficeExtend access points, CAPWAP data encryptions, and enterprise wireless mesh.
 
      	 [bookmark: pgfId-1080637]AP Limit—The maximum capacity of access points allowed to join this controller.
 
      	 [bookmark: pgfId-1080638]AP Count—The current number of access points using licenses.
 
      	 [bookmark: pgfId-1080639]% Used—The percentage of licensed access points that are being used. If the percentage is greater than 75%, the bar appears red to indicate that the limit is being approached.
 
      	 [bookmark: pgfId-1080641]Type—The three different types of licenses are as follows:
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080642]Note For any controllers with a type other than Permanent, the least number of days left to expiration is shown.

      
      
 
     

     
 
      [bookmark: pgfId-1080643]–[image: ] Permanent—Licenses are node-locked and have no usage period associated with them. They are issued by licensing portal of Cisco and must be installed using management interfaces on the device. Upon installation of these licenses, you have the necessary permissions across different versions.
 
      [bookmark: pgfId-1080644]–[image: ] Evaluation—Licenses are non-node-locked and are valid only for a limited time period. They are used only when no permanent, extension, or grace period licenses exist. Before using an evaluation license, you must accept an End User License Agreement (EULA). Even though they are non-node-locked, their usage is recorded on the device. The number of days remaining on the evaluation license which has the fewest number of days until expiration is shown. 
 
      [bookmark: pgfId-1080645]–[image: ] Extension—Licenses are node-locked and metered. They are issued by licensing portal of Cisco and must be installed using management interfaces on the device. Before using an extension license, you must accept a EULA during installation.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080646]Note If a license shows as expired, the controller does not stop functioning. Only upon a reboot, the controller with the expired license become inactive.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080647]Status—In Use, Not in Use, Inactive, or EULA Not Accepted.
 
     
 
      [bookmark: pgfId-1080648]–[image: ] Inactive—The license level is being used, but this license is not being used. 
 
      [bookmark: pgfId-1080649]–[image: ] Not In Use—The license level is not being used and this license is not currently recognized.
 
      [bookmark: pgfId-1080650]–[image: ] Expired In Use—The license is being used, but is expired and will not be used upon next reboot.
 
      [bookmark: pgfId-1080651]–[image: ] Expired Not In Use—The license has expired and can no longer be used. 
 
      [bookmark: pgfId-1080652]–[image: ] Count Consumed—The ap-count license is In Use.
 
    
 
     
      [bookmark: pgfId-1080673][bookmark: 28140]Mobility Services Engine (MSE) License Information
 
      [bookmark: pgfId-1080676][bookmark: marker-1080674][bookmark: marker-1080675]There are three types of licenses:
 
      
      	 [bookmark: pgfId-1080678]Permanent—Licenses are node-locked and have no usage period associated with them. They are issued by licensing portal of Cisco and must be installed using management interfaces on the device. Upon installation of these licenses, you have the necessary permissions across different versions.
 
      	 [bookmark: pgfId-1080680]Evaluation—Licenses are non-node-locked and are valid only for a limited time period. They are used only when no permanent, extension, or grace period licenses exist. Before using an evaluation license, you must accept an End User License Agreement (EULA). Even though they are non-node-locked, their usage is recorded on the device. The number of days remaining on the evaluation license which has the fewest number of days until expiration is shown. 
 
      	 [bookmark: pgfId-1080682]Extension—Licenses are node-locked and metered. They are issued by licensing portal of Cisco and must be installed using management interfaces on the device. Before using an extension license, you must accept a EULA during installation.
 
     
 
      [bookmark: pgfId-1080683]The MSE Licenses portion of the License Center page provides information for each service. See ( Table 2-1 ).
 
      
       
        
         [bookmark: pgfId-1080693]Table 2-1 [bookmark: 80905]MSE License Information 
 
        
       
         
         	 
           
           [bookmark: pgfId-1080697]Field
          
  
         	 
           
           [bookmark: pgfId-1080699]Description
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1080701]CAS Elements
          
  
        
 
         
         	 [bookmark: pgfId-1080705]Permanent Limit
  
         	 [bookmark: pgfId-1080707]The total number of CAS elements with permanent licenses.
  
        
 
         
         	 [bookmark: pgfId-1080709]Evaluation Limit
  
         	 [bookmark: pgfId-1080711]The total number of CAS elements with evaluation licenses.
  
        
 
         
         	 [bookmark: pgfId-1080713]Count
  
         	 [bookmark: pgfId-1080715]The number of CAS elements currently licensed across MSEs.
  
        
 
         
         	 [bookmark: pgfId-1080717]% Used
  
         	 [bookmark: pgfId-1080719]The percentage of CAS elements licensed across MSEs.
  
        
 
         
         	 
           
           [bookmark: pgfId-1080721]wIPS Monitor Mode APs
          
  
        
 
         
         	 [bookmark: pgfId-1080725]Permanent Limit
  
         	 [bookmark: pgfId-1080727]The total number of wIPS Monitor Mode APs with permanent licenses.
  
        
 
         
         	 [bookmark: pgfId-1080729]Evaluation Limit
  
         	 [bookmark: pgfId-1080731]The total number of wIPS Monitor Mode APs with evaluation licenses.
  
        
 
         
         	 [bookmark: pgfId-1080733]Count
  
         	 [bookmark: pgfId-1080735]The number of wIPS Monitor Mode APs currently licensed across MSEs.
  
        
 
         
         	 [bookmark: pgfId-1080737]% Used
  
         	 [bookmark: pgfId-1080739]The percentage of wIPS Monitor Mode APs licensed across MSEs.
  
        
 
         
         	  [bookmark: pgfId-1080741]Under wIPS Monitor Mode Aps or wIPS Local Mode Aps, an active link takes you to a list of licensed access points. You cannot access a list of licensed clients and tags.
  
        
 
         
         	  [bookmark: pgfId-1080745]wIPS Local Mode APs
  
        
 
         
         	 [bookmark: pgfId-1080749]Permanent Limit
  
         	 [bookmark: pgfId-1080751]The total number of wIPS Local Mode APs with permanent licenses.
  
        
 
         
         	 [bookmark: pgfId-1080753]Evaluation Limit
  
         	 [bookmark: pgfId-1080755]The total number of wIPS Local Mode APs with evaluation licenses.
  
        
 
         
         	 [bookmark: pgfId-1080757]Count
  
         	 [bookmark: pgfId-1080759]The number of wIPS Local Mode APs currently licensed across MSEs.
  
        
 
         
         	 [bookmark: pgfId-1080761]% Used
  
         	 [bookmark: pgfId-1080763]The percentage of wIPS Local Mode APs licensed across MSEs.
  
        
 
         
         	  [bookmark: pgfId-1080765]Under wIPS Monitor Mode APs or wIPS Local Mode APs, an active link takes you to a list of licensed access points. You cannot access a list of licensed clients and tags.
  
        
 
       
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080769]Note • When a license is deleted, the mobility services engine automatically restarts to load the new license limits.
 
      
      	 [bookmark: pgfId-1087897]If Partner tag engine is up, then the MSE license information consists of information on tag licenses as well.
 
      	 [bookmark: pgfId-1088011]For more information on MSE licenses, see the  Cisco Connected Mobile Experiences Configuration Guide, Release 7.5 .
 
     
 
    
 
     
      [bookmark: pgfId-1087904][bookmark: 49669]Mobility Services Engine (MSE) License Summary
 
      [bookmark: pgfId-1080797]If you want to see more details about MSE licensing, choose  Summary > MSE  from the left sidebar menu. The License Center page appears.
 
      [bookmark: pgfId-1080798]All licensed MSEs are listed in the following columns:
 
      
      	 [bookmark: pgfId-1080799]MSE Name—Provides a link to the MSE license file list page.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080800]Note The icon to the left of the MSE Name/UDI indicates whether the mobility services engine is low-end or high-end. 
A high-end mobility services engine (3350) has a higher memory capacity and can track up to 18,000 clients and tags. A low-end mobility services engine (3310) can track up to 2000 clients and tags.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080801]Type—Specifies the type of MSE.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080802]Note Under wIPS Monitor Mode APs or wIPS Local Mode APs, an active link takes you to a list of licensed access points. You cannot access a list of licensed clients or tags.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080803]Limit—Displays the total number of client elements licensed across MSEs.
 
      	 [bookmark: pgfId-1080804]Count—Displays the number of client elements that are currently licensed across MSEs.
 
      	 [bookmark: pgfId-1080805]Unlicensed Count—Displays the number of client elements that are not licensed.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1080806]Note wIPS service does not process the alarms generated from these unlicensed access points.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080807]% Used—Displays the percentage of clients used across all MSEs.
 
      	 [bookmark: pgfId-1080808]License Type—The three different types of licenses are as follows:
 
     
 
      [bookmark: pgfId-1080809]–[image: ] Permanent—Licenses are node-locked and have no usage period associated with them. They are issued by licensing portal of Cisco and must be installed using management interfaces on the device. Upon installation of these licenses, you have the necessary permissions across different versions.
 
      [bookmark: pgfId-1080810]–[image: ] Evaluation—Licenses are non-node-locked and are valid only for a limited time period. They are used only when no permanent, extension, or grace period licenses exist. Before using an evaluation license, you must accept an End User License Agreement (EULA). Even though they are non-node-locked, their usage is recorded on the device. The number of days remaining on the evaluation license which has the fewest number of days until expiration is shown. 
 
      [bookmark: pgfId-1080811]–[image: ] Extension—Licenses are node-locked and metered. They are issued by licensing portal of Cisco and must be installed using management interfaces on the device. Before using an extension license, you must accept a EULA during installation.
 
      
      	 [bookmark: pgfId-1080812]Status 
 
     
 
      [bookmark: pgfId-1080813]–[image: ] Active—License is installed and being used by a feature.
 
      [bookmark: pgfId-1080814]–[image: ] Inactive—License is installed but not being used by a feature.
 
      [bookmark: pgfId-1080815]–[image: ] Expired—License has expired.
 
      [bookmark: pgfId-1080816]–[image: ] Corrupted—License is corrupted.
 
      
      	 [bookmark: pgfId-1088035]For more information on MSE licenses, see the  Cisco Connected Mobile Experiences Configuration Guide, Release 7.5 .
 
     
 
    
 
     
      [bookmark: pgfId-1080842][bookmark: 70122]Managing Prime Infrastructure Licenses
 
      [bookmark: pgfId-1080843]If you choose Files > Prime Infrastructure Files from the left sidebar menu, you can manage Prime Infrastructure licenses. This page displays the following information:
 
      
      	 [bookmark: pgfId-1080844]Product Activation Key (PAK)
 
      	 [bookmark: pgfId-1080845]Feature
 
      	 [bookmark: pgfId-1080846]Access point limit
 
      	 [bookmark: pgfId-1080847]Type
 
     
 
      [bookmark: pgfId-1080848]This section contains the following topics:
 
      
      	 [bookmark: pgfId-1080852]Adding a New Prime Infrastructure License File
 
      	 [bookmark: pgfId-1080856]Deleting a Prime Infrastructure License File
 
     
 
    
 
     
      [bookmark: pgfId-1080859][bookmark: 49016]Adding a New Prime Infrastructure License File
 
      [bookmark: pgfId-1080860]To add a new Prime Infrastructure license file, follow these steps:
 
     
 
      [bookmark: pgfId-1080861] Step 1[image: ] In the License Center > Files > Prime Infrastructure Files page, click Add.
 
      [bookmark: pgfId-1080862]Step 2[image: ] In the Add a License File dialog box, enter or browse to the applicable license file.
 
      [bookmark: pgfId-1080863]Step 3[image: ] Once displayed in the License File text box, click Upload.
 
      [bookmark: pgfId-1100937]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1080877][bookmark: 92280]Deleting a Prime Infrastructure License File
 
      [bookmark: pgfId-1080878]To delete a Prime Infrastructure license file, follow these steps:
 
     
 
      [bookmark: pgfId-1080879] Step 1[image: ] In the License Center > Files > Prime Infrastructure Files page, select the check box of Prime Infrastructure license file that you want to delete.
 
      [bookmark: pgfId-1080880]Step 2[image: ] Click Delete.
 
      [bookmark: pgfId-1080881]Step 3[image: ] Click OK to confirm the deletion.
 
      [bookmark: pgfId-1080882]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1080896][bookmark: 43909]Monitoring Controller Licenses
 
      [bookmark: pgfId-1080897]If you choose Files > Controller Files from the left sidebar menu, you can monitor the controller licenses.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080898]Note Prime Infrastructure does not directly manage controller licenses, rather it simply monitors the licenses. To manage the licenses you can use command-line interface, Web UI, or Cisco License Manager (CLM).

      
      
 
     

     
 
      [bookmark: pgfId-1080899]This page displays the following parameters:
 
      
      	 [bookmark: pgfId-1080900]Controller Name
 
      	 [bookmark: pgfId-1080901]Controller IP—The IP address of the controller.
 
      	 [bookmark: pgfId-1080902]Feature—License features include wplus-ap-count, wplus, base-ap-count, and base. 
 
     
 
      [bookmark: pgfId-1080903]For every physical license installed, two license files display in the controller: a feature level license and an ap-count license. For example if you install a “WPlus 500” license on the controller, “wplus” and “wplus-ap-count” features display. There are always two of these features active at any one time that combine to enable the feature level (WPlus or Base) and the AP count.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080904]Note You can have both a WPlus and Base license, but only one can be active at any given time.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080905]AP Limit—The maximum capacity of access points allowed to join this controller.
 
      	 [bookmark: pgfId-1080906]EULA status—Displays the status of the End User License Agreement and is either Accepted or Not Accepted.
 
      	 [bookmark: pgfId-1080907]Comments—User entered comments when the license is installed.
 
      	 [bookmark: pgfId-1080908]Type—The four different types of licenses are as follows:
 
     
 
      [bookmark: pgfId-1080909]–[image: ] Permanent—Licenses are node locked and have no usage period associated with them. They are issued by Cisco licensing portal and must be installed using management interfaces on the device. Upon installation of these licenses, you have the necessary permissions across different versions.
 
      [bookmark: pgfId-1080910]–[image: ] Evaluation—Licenses are non-node locked and are valid only for a limited time period. They are used only when no permanent, extension, or grace period licenses exist. Before using an evaluation license, you must accept an End User License Agreement (EULA). Even though they are non-node locked, their usage is recorded on the device. The number of days left displays for the evaluation license with the fewest number of remaining active license days.
 
      [bookmark: pgfId-1080911]–[image: ] Extension—Licenses are node locked and metered. They are issued by Cisco licensing portal and must be installed using management interfaces on the device. Before using an extension license, you must accept a EULA during installation.
 
      [bookmark: pgfId-1080912]–[image: ] Grace Period—Licenses are node locked and metered. These licenses are issued by Cisco licensing portal as part of the permission ticket to rehost a license. They are installed on the device as part of the rehost operation, and you must accept a EULA as part of the rehost operation.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080913]Note Types other than Permanent display the number of days left until the license expires. Licenses not currently in use do not have their counts reduced until they become “In Use”.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1080914]Status
 
     
 
      [bookmark: pgfId-1080915]–[image: ] In Use—The license level and the license are in use.
 
      [bookmark: pgfId-1080916]–[image: ] Inactive—The license level is being used, but this license is not being used. 
 
      [bookmark: pgfId-1080917]–[image: ] Not In Use—The license level is not being used and this license is not currently recognized.
 
      [bookmark: pgfId-1080918]–[image: ] Expired In Use—The license is being used, but is expired and will not be used upon next reboot.
 
      [bookmark: pgfId-1080919]–[image: ] Expired Not In Use—The license has expired and can no longer be used. 
 
      [bookmark: pgfId-1080920]–[image: ] Count Consumed—The ap-count license is In Use.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080921]Note If you need to filter the list of license files, you can enter a controller name, feature, or type and click Go.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1080925][bookmark: 87521]Managing Mobility Services Engine (MSE) Licenses
 
      [bookmark: pgfId-1080926]If you choose Files > MSE Files from the left sidebar menu, you can manage the mobility services engine licenses. 
 
      [bookmark: pgfId-1080927]This section contains the following topics:
 
      
      	 [bookmark: pgfId-1080931]Deleting a Mobility Services Engine License File
 
     
 
    
 
     
      [bookmark: pgfId-1080948][bookmark: 65186]Deleting a Mobility Services Engine License File
 
      [bookmark: pgfId-1080949]To delete a mobility services engine license file, follow these steps:
 
     
 
      [bookmark: pgfId-1080950] Step 1[image: ] In the License Center > Files > MSE Files page, select the check box of the mobility services engine license file that you want to delete.
 
      [bookmark: pgfId-1080951]Step 2[image: ] Click Delete.
 
      [bookmark: pgfId-1080952]Step 3[image: ] Click OK to confirm the deletion.
 
      [bookmark: pgfId-1080953]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1080957][bookmark: 82040]Adding a Mobility Services Engine to the Prime Infrastructure
 
     [bookmark: pgfId-1080958]You can add MSE using the Add Mobility Services Engine dialog box in the Mobility Service page. In this dialog box, you can add licensing files, tracking parameters, and assign maps to MSE. If you launch the wizard with an existing MSE for configuration, then the Add MSE option appears as Edit MSE Details. This section contains the following topics:
 
     
     	 [bookmark: pgfId-1080962]Enabling Services on the Mobility Services Engine
 
     	 [bookmark: pgfId-1080966]Configuring MSE Tracking and History Parameters
 
     	 [bookmark: pgfId-1080970]Assigning Maps to the MSE
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1080971]Note The Prime Infrastructure Release 1.0 recognizes and supports MSE 3355 appropriately.

     
     
 
    

    
 
     [bookmark: pgfId-1080972]To add a mobility services engine to the Prime Infrastructure, log into the Prime Infrastructure and follow these steps:
 
    
 
     [bookmark: pgfId-1080973] Step 1[image: ] Verify that you can ping the mobility services engine.
 
     [bookmark: pgfId-1080974]Step 2[image: ] Choose  Services > Mobility Services  to display the Mobility Services page.
 
     [bookmark: pgfId-1080975]Step 3[image: ] From the Select a command drop-down list, choose  Add   Mobility Services Engine . Click  Go .
 
     [bookmark: pgfId-1080976]Step 4[image: ] In the Device Name text box, enter a name for the mobility services engine.
 
     [bookmark: pgfId-1080977]Step 5[image: ] In the IP Address text box, enter the IP address of the mobility services engine.
 
     [bookmark: pgfId-1080978]Step 6[image: ] (Optional) In the Contact Name text box, enter the name of the mobility services engine administrator.
 
     [bookmark: pgfId-1080979]Step 7[image: ] In the User Name and Password text boxes, enter the username and password for the mobility services engine.
 
     [bookmark: pgfId-1080980]This refers to the Prime Infrastructure communication username and password created during the setup process.
 
     [bookmark: pgfId-1080981]If you have not specified the username and password during the setup process, use the defaults.
 
     [bookmark: pgfId-1080982]The default username and password are both  admin .
 
     
      
    
 
    
 
    [bookmark: pgfId-1080983]Note If you changed the username and password during the automatic installation script, enter those values here. If you did not change the default passwords, we recommend that you rerun the automatic installation script and change the username and password.

     
     
 
    

    
 
     [bookmark: pgfId-1080984]Step 8[image: ] Select the  HTTP check box to allow communication between the mobility services engine and third-party applications. By default, the Prime Infrastructure uses HTTPs to communicate with MSE.
 
     [bookmark: pgfId-1080985]Step 9[image: ] Select the  Delete synchronized service assignments check box if you want to permanently remove all service assignments from the mobility services engine. 
 
     [bookmark: pgfId-1080986]This option is applicable for network designs, wired switches, controllers and event definitions. The existing location history data is retained, however, you must use manual service assignments to perform any future location calculations. 
 
     [bookmark: pgfId-1080987]Step 10[image: ] Click  Next . The Prime Infrastructure automatically synchronizes the selected elements with the MSE.
 
     [bookmark: pgfId-1080988]After the synchronization, the MSE License Summary page appears. You can use the MSE License Summary page to install a license, add a license, remove a license, install an activation license, and install service license.The Select Mobility Service page appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-1080989]Note After adding a new mobility services engine, you can synchronize network designs (campus, building, and outdoor maps), controllers, switches (Catalyst Series 3000 only), and event groups on the local mobility services engine using the Prime Infrastructure. You can perform this synchronization immediately after adding a new mobility services engine or at a later time. To synchronize the local and the Prime Infrastructure databases, see the Information About Synchronizing the Prime Infrastructure and Mobility Services Engines.

     
     
 
    

    
 
     [bookmark: pgfId-1080993]

     
     
 
    
 
    
 
     
      [bookmark: pgfId-1080995][bookmark: 26108]Enabling Services on the Mobility Services Engine
 
      [bookmark: pgfId-1080996]To enable services on the mobility services engine, follow these steps:
 
     
 
      [bookmark: pgfId-1080997] Step 1[image: ] After adding the license file, the Select Mobility Service page appears.
 
      [bookmark: pgfId-1080998]Step 2[image: ] To enable a service on the mobility services engine, select the check box next to the service. The different type of services are as follows:
 
      
      	 [bookmark: pgfId-1080999]Context Aware Service—If you select the Context Aware Service check box, then you must select a location engine to perform location calculation. You can choose  CAS to track clients ,  rogues ,  interferers , and  tags . You can choose either of the following engines to track tags:
 
     
 
      [bookmark: pgfId-1081000]–[image: ] Cisco Context-Aware Engine for Clients and Tags
 
      [bookmark: pgfId-1081001]–[image: ] Partner Tag Engine
 
      
       
     
 
     
 
     [bookmark: pgfId-1081002]Note By default, the Context Aware Service check box and Cisco Context-Aware Engine for Clients and Tags radio button are enabled.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1081003]Wireless Intrusion Prevention System—If you select the Wireless Intrusion Prevention System check box, it detects wireless and performance threats.
 
      	 [bookmark: pgfId-1081004]MSAP Service—If you select the MSAP Service check box, it provides service advertisements that describe the available services for the mobile devices.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1081005]Note With MSE 6.0 and later, you can enable multiple services (CAS and wIPS) simultaneously. Before Version 6.0, mobility services engines only supported one active service at a time.

      
      
 
     

     
 
      [bookmark: pgfId-1081006]Step 3[image: ] Click  Next to configure the tracking and history parameters.
 
      [bookmark: pgfId-1081007]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1081009][bookmark: 51248]Configuring MSE Tracking and History Parameters
 
     
 
      [bookmark: pgfId-1081010] Step 1[image: ] After you enable services on the mobility services engine, the Select Tracking & History Parameters page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-1081011]Note If you skip configuring the tracking parameters, the default values are selected.

      
      
 
     

     
 
      [bookmark: pgfId-1081012]Step 2[image: ] You can select the clients that you want to keep track of by selecting the corresponding Tracking check box(es). The various tracking parameters are as follows:
 
      
      	 [bookmark: pgfId-1081013]Wired Clients
 
      	 [bookmark: pgfId-1081014]Wireless Clients
 
      	 [bookmark: pgfId-1081015]Rogue Access Points
 
     
 
      [bookmark: pgfId-1081016]–[image: ] Exclude Adhoc Rogue APs
 
      
      	 [bookmark: pgfId-1081017]Rogue Clients
 
      	 [bookmark: pgfId-1081018]Interferers
 
      	 [bookmark: pgfId-1081019]Active RFID Tags
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1084457]Note You must select Wireless Clients for CMX analytics.

      
      
 
     

     
 
      [bookmark: pgfId-1081020]Step 3[image: ] You can enable the history tracking of devices by selecting the corresponding devices check box(es). The different history parameters are as follows:
 
      
      	 [bookmark: pgfId-1081021]Wired Stations
 
      	 [bookmark: pgfId-1081022]Client Stations
 
      	 [bookmark: pgfId-1081023]Rogue Access Points
 
      	 [bookmark: pgfId-1081024]Rogue Clients
 
      	 [bookmark: pgfId-1081025]Interferers
 
      	 [bookmark: pgfId-1081026]Asset Tags
 
     
 
      [bookmark: pgfId-1081027]Step 4[image: ] Click Next to Assign Maps to the MSE.
 
      [bookmark: pgfId-1081028]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1081030][bookmark: 43565]Assigning Maps to the MSE
 
      
       
     
 
     
 
     [bookmark: pgfId-1081031]Note The Assigning Maps page is available only if you select CAS as one of the services to be enabled on the MSE.

      
      
 
     

     
 
     
 
      [bookmark: pgfId-1081032] Step 1[image: ] Once you configure MSE tracking and history parameters, the Assigning Maps page appears.
 
      [bookmark: pgfId-1081033]The Assign Maps page shows the following information:
 
      
      	 [bookmark: pgfId-1081034]Map Name
 
      	 [bookmark: pgfId-1081035]Type (building, floor, campus)
 
      	 [bookmark: pgfId-1081036]Status
 
     
 
      [bookmark: pgfId-1081037]Step 2[image: ] You can see the required map type by selecting All, Campus, Building, Floor Area, or Outdoor Area from the Filter option available on the page.
 
      [bookmark: pgfId-1081038]Step 3[image: ] To synchronize a map, select the  Name check box and click  Synchronize .
 
      [bookmark: pgfId-1081039]Upon synchronization of the network designs, the appropriate controllers that have APs assigned on a particular network design are synchronized with the MSE automatically. Click Done to save the MSE settings.
 
      [bookmark: pgfId-1082976]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1081041][bookmark: 77065]Information About Synchronizing the Prime Infrastructure and Mobility Services Engines
 
     [bookmark: pgfId-1081042]This section describes how to synchronize the Prime Infrastructure and mobility services engines manually and automatically.
 
     
      
    
 
    
 
    [bookmark: pgfId-1081043]Note The Services > Synchronize Services page is available only in the virtual domain in Release 7.3.101.0.

     
     
 
    

    
 
     [bookmark: pgfId-1081045]After adding a mobility services engine to the Prime Infrastructure, you can synchronize network designs (campus, building, floor, and outdoor maps), controllers (name and IP address), specific Catalyst 3000 series and 4000 series switches, and event groups with the mobility services engine.
 
     
     	 [bookmark: pgfId-1081046]Network Design—A logical mapping of the physical placement of access points throughout facilities. A hierarchy of a single campus, the buildings that comprise that campus, and the floors of each building constitute a single network design. 
 
     	 [bookmark: pgfId-1081047]Controller—A selected controller that is associated and regularly exchanges location information with a mobility services engine. Regular synchronization ensures location accuracy.
 
     	 [bookmark: pgfId-1081048]Wired Switches—Wired Catalyst switches that provide an interface to wired clients on the network. Regular synchronization ensures that location tracking of wired clients in the network is accurate.
 
    
 
     [bookmark: pgfId-1081049]–[image: ] The mobility services engine can be synchronized with Catalyst stackable switches (3750, 3750-E, 3560, 2960, IE-3000 switches), switch blades (3110, 3120, 3130, 3040, 3030, 3020), and switch ports. 
 
     [bookmark: pgfId-1081050]–[image: ] The mobility services engine can also be synchronized with the following Catalyst 4000 series switches: WS-C4948, WS-C4948-10GE, ME-4924-10GE, WS-4928-10GE, WS-C4900M, WS-X4515, WS-X4516, WS-X4013+, WS-X4013+TS, WS-X4516-10GE, WS-X4013+10GE, WS-X45-SUP6-E, and WS-X45-SUP6-LE.
 
     
     	 [bookmark: pgfId-1081051]Event Groups—A group of predefined events that define triggers that generate an event. Regular synchronization ensures that the latest defined events are tracked. Event groups can also be created by third-party applications. For more information on third-party application created event groups, see the “Configuring Automatic Database Synchronization and Out-of-Sync Alerts” section.
 
     	 [bookmark: pgfId-1081055]Third Party Elements—When you synchronize elements with MSE, there might be event groups on the MSE that have been created by third-party applications. You can either delete the unused elements or mark them as third-party elements.
 
     	 [bookmark: pgfId-1081056]Service Advertisements—MSAP provides service advertisements on mobile devices. This shows the service advertisement that is synchronized with the MSE.
 
    
 
   
 
    
     [bookmark: pgfId-1081059][bookmark: 12338]Prerequisites for Synchronizing the Mobility Services Engine
 
     
     	 [bookmark: pgfId-1081060]Be sure to verify software compatibility between the controller, Prime Infrastructure, and the mobility services engine before synchronizing. See the latest mobility services engine release notes at the following URL:
 
    
 
     [bookmark: pgfId-1102285] http://www.cisco.com/en/US/products/ps9742/tsd_products_support_series_home.html 
 
     
     	 [bookmark: pgfId-1098030]Communication between the mobility services engine, Prime Infrastructure, and the controller is in Coordinated Universal Time (UTC). Configuring NTP on each system provides devices with UTC time. The mobility services engine and its associated controllers must be mapped to the same NTP server and the same Prime Infrastructure server. An NTP server is required to automatically synchronize time between the controller, Prime Infrastructure, and the mobility services engine. However, the timezone for MSE should still be set to UTC. This is because wIPS alarms require that the MSE time be set to UTC.
 
    
 
   
 
    
     [bookmark: pgfId-1081065][bookmark: 24263]Working with Third-Party Elements
 
     [bookmark: pgfId-1081066]When you synchronize elements with MSE, there might be event groups on the MSE that have been created by third-party applications. You can either delete the unused elements or mark them as third-party elements.
 
     [bookmark: pgfId-1084890]This section contains the following topic:
 
     [bookmark: pgfId-1084892]Deleting Elements or Marking Them as Third-Party Elements
 
     
      [bookmark: pgfId-1081068][bookmark: 22771]Deleting Elements or Marking Them as Third-Party Elements
 
      [bookmark: pgfId-1081069]To delete elements or mark them as third-party elements, follow these steps:
 
     
 
      [bookmark: pgfId-1081070] Step 1[image: ] Choose Services > Synchronize Services.
 
      [bookmark: pgfId-1081071]The Network Designs page appears.
 
      [bookmark: pgfId-1081072]Step 2[image: ] In the Network Designs page, choose  Third Party Elements from the left sidebar menu.
 
      [bookmark: pgfId-1081073]The Third Party Elements page appears.
 
      [bookmark: pgfId-1081074]Step 3[image: ] Select one or more elements.
 
      [bookmark: pgfId-1081075]Step 4[image: ] Click one of the following buttons:
 
      
       
       	 [bookmark: pgfId-1081076] Delete Event Groups —Deletes the selected event groups.
 
       	 [bookmark: pgfId-1081077] Mark as 3rd Party Event Group(s) —Marks the selected event groups as third-party event groups.
 
      
 
     
 
      [bookmark: pgfId-1081078]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1081081][bookmark: 30620]Synchronizing Controllers with a Mobility Services Engine
 
     [bookmark: pgfId-1081082]This section describes how to synchronize a controller, assign an MSE to any wireless controller and also to unassign a network design, controller, wired switch, or event group from a mobility services engine. This section contains the following topics:
 
     
     	 [bookmark: pgfId-1084905]Synchronizing a Controller, Catalyst Switch, or Event Group
 
     	 [bookmark: pgfId-1084913]Assigning an MSE to the Controller
 
     	 [bookmark: pgfId-1084922]Unassigning a Network Design, Controller, Wired Switch, or Event Group from the MSE
 
    
 
     
      [bookmark: pgfId-1081084][bookmark: 99597]Synchronizing a Controller, Catalyst Switch, or Event Group
 
      [bookmark: pgfId-1081085]To synchronize network designs, a controller, a Catalyst switch, or event group with the mobility services engine, follow these steps:
 
     
 
      [bookmark: pgfId-1081086] Step 1[image: ] Choose  Services  > Synchronize Services .
 
      [bookmark: pgfId-1081087]The left sidebar menu contains the following options:  Network Designs ,  Controllers ,  Event Groups ,  Wired Switches ,  Third Party Elements , and  Service Advertisements . 
 
      [bookmark: pgfId-1081088]Step 2[image: ] From the left sidebar menu, choose the appropriate menu options.
 
      [bookmark: pgfId-1081089]Step 3[image: ] To assign a network design to a mobility services engine, in the Synchronize Services page, choose  Network Designs from the left sidebar menu. 
 
      [bookmark: pgfId-1081090]The Network Designs page appears.
 
      [bookmark: pgfId-1081091]Step 4[image: ] Select all the maps to be synchronized with the mobility services engine by selecting the corresponding Name check box.
 
      
       
     
 
     
 
     [bookmark: pgfId-1081092]Note Through Release 6.0, you can assign only up to a campus level to a mobility services engine. Starting with Release 7.0 this option is granular to a floor level. For example, you can choose to assign floor1 to MSE 1, floor2 to MSE 2, and floor3 to MSE 3.

      
      
 
     

     
 
      [bookmark: pgfId-1081093]Step 5[image: ] Click  Change MSE Assignment .
 
      [bookmark: pgfId-1081094]Step 6[image: ] Select the mobility services engine to which the maps are to be synchronized.
 
      [bookmark: pgfId-1081095]Step 7[image: ] Click either of the following in the MSE Assignment dialog box:
 
      
       
       	 [bookmark: pgfId-1081096] Save —Saves the  mobility services engine assignment.  The following message appears in the Messages column of the Network Designs page with a yellow arrow icon:
 
      
 
     
 
      [bookmark: pgfId-1081097]“To be assigned - Please synchronize.”
 
      
       
       	 [bookmark: pgfId-1081098] Cancel — Discards the changes to the mobility services engine assignment and returns to the Network Designs page. 
 
      
 
     
 
      [bookmark: pgfId-1081099] You can also click Reset to undo the  mobility services engine assignments.
 
      
       
     
 
     
 
     [bookmark: pgfId-1081100]Note A network design may include a floor in a campus or a large campus with several buildings, each monitored by a different mobility services engine. Because of this, you may need to assign a single network design to multiple mobility services engines.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1081101]Note Network design assignments also automatically picks up the corresponding controller for synchronization.

      
      
 
     

     
 
      [bookmark: pgfId-1081102]Step 8[image: ] Click  Synchronize to update the mobility services engine(s) database(s).
 
      [bookmark: pgfId-1081103]When items are synchronized, a green two-arrow icon appears in the Sync. Status column for each synchronized entry.
 
      [bookmark: pgfId-1081104]You can use the same procedure to assign wired switches or event groups to a mobility services engine. To assign a controller to a mobility services engine, see “Synchronizing Controllers with a Mobility Services Engine” section for more information.
 
      [bookmark: pgfId-1081108]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1081110][bookmark: 90354]Assigning an MSE to the Controller
 
      [bookmark: pgfId-1081111]To assign a mobility services engine with any wireless controller on a per-service basis (CAS or wIPS), follow these steps:
 
     
 
      [bookmark: pgfId-1081112] Step 1[image: ] Choose Services > Synchronize Services.
 
      [bookmark: pgfId-1081113]Step 2[image: ] In the Network Designs page, choose  Controller from the left sidebar menu.
 
      [bookmark: pgfId-1081114]Step 3[image: ] Select the controllers to be assigned to the mobility services engine by selecting the corresponding Name check box.
 
      [bookmark: pgfId-1081115]Step 4[image: ] Click  Change MSE Assignment .
 
      [bookmark: pgfId-1081116]Step 5[image: ] Choose the mobility services engine to which the controllers must be synchronized.
 
      [bookmark: pgfId-1081117]Step 6[image: ] Click either of the following in the Choose MSEs dialog box:
 
      
       
       	 [bookmark: pgfId-1081118] Save —Saves the  mobility services engine assignment.  The following message appears in the Messages column of the Controllers page with a yellow arrow icon:
 
      
 
     
 
      [bookmark: pgfId-1081119]“To be assigned - Please synchronize.”
 
      
       
       	 [bookmark: pgfId-1081120] Cancel —Discards the changes to mobility services engine assignment and returns to the Controllers page.
 
      
 
     
 
      [bookmark: pgfId-1081121] You can also click Reset to undo the  mobility services engine assignments. 
 
      [bookmark: pgfId-1081122]Step 7[image: ] Click  Synchronize to complete the synchronization process.
 
      [bookmark: pgfId-1081123]Step 8[image: ] Verify that the mobility services engine is communicating with each of the controllers for only the chosen service. This can be done by clicking the NMSP status link in the status page.
 
      
       
     
 
     
 
     [bookmark: pgfId-1081124]Note After Synchronizing a controller, verify that the timezone is set on the associated controller.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1081125]Note Controller names must be unique for synchronizing with a mobility services engine. If you have two controllers with the same name, only one is synchronized.

      
      
 
     

     
 
      [bookmark: pgfId-1081126]You can use the same procedure to assign Catalyst switches or event groups to a mobility services engine. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1081127]Note A switch can only be synchronized with one mobility services engine. However, a mobility services engine can have many switches attached to it.

      
      
 
     

     
 
      [bookmark: pgfId-1081128]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1081130][bookmark: 29395]Unassigning a Network Design, Controller, Wired Switch, or Event Group from the MSE
 
      [bookmark: pgfId-1081131]To unassign a network design, controller, wired switch, or event group from a mobility services engine, follow these steps:
 
     
 
      [bookmark: pgfId-1081132] Step 1[image: ] Choose  Services >  Synchronize Services .
 
      [bookmark: pgfId-1081133]Step 2[image: ] From the left sidebar menu, choose the appropriate menu options.
 
      [bookmark: pgfId-1081134]Step 3[image: ] Select one or more elements by selecting the Name check box, and click  Change MSE Assignment . The Choose MSEs dialog box appears. 
 
      [bookmark: pgfId-1081135]Step 4[image: ] Unselect the mobility services engine if you do not want the elements to be associated with that mobility services engine by selecting either the CAS or wIPS check box.
 
      [bookmark: pgfId-1081136]Step 5[image: ] Click  Save to save the assignment changes.
 
      [bookmark: pgfId-1081137]Step 6[image: ] Click  Synchronize .
 
      [bookmark: pgfId-1081138]The Sync Status column appears blank.
 
      [bookmark: pgfId-1081139]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1081145][bookmark: 33330]Configuring Automatic Database Synchronization and 
 Out-of-Sync Alerts
 
     [bookmark: pgfId-1081146]Manual synchronization of the Prime Infrastructure and mobility services engine databases is immediate. However, future deployment changes (such as changes to maps and access point positions) can yield incorrect location calculations and asset tracking until resynchronization.
 
     [bookmark: pgfId-1081147]To prevent out-of-sync conditions, use the Prime Infrastructure to carry out synchronization. This policy ensures that synchronization between the Prime Infrastructure and mobility services engine databases is triggered periodically and any related alarms are cleared.
 
     [bookmark: pgfId-1081149]Any change to one or more of any synchronized component is automatically synchronized with the mobility services engine. For example, if a floor with access points is synchronized with a particular mobility services engine and then one access point is moved to a new location on the same floor or another floor that is also synchronized with the mobility services engine, then the changed location of the access point is automatically communicated. 
 
     [bookmark: pgfId-1081150]To further ensure that the Prime Infrastructure and MSE are in sync, smart synchronization happens in the background. 
 
     [bookmark: pgfId-1081151]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1081155]Configuring Automatic Database Synchronization
 
     	 [bookmark: pgfId-1081159]Smart Controller Assignment and Selection Scenarios
 
     	 [bookmark: pgfId-1081163]Out-of-Sync Alarms
 
    
 
     
      [bookmark: pgfId-1081166][bookmark: 94971]Configuring Automatic Database Synchronization
 
      [bookmark: pgfId-1081167]To configure smart synchronization, follow these steps:
 
     
 
      [bookmark: pgfId-1081169] Step 1[image: ] Choose  Administration >Background Tasks .
 
      [bookmark: pgfId-1081170]Step 2[image: ] Select the  Mobility Service Synchronization  check box.
 
      [bookmark: pgfId-1081171]The Mobility Services Synchronization page appears.
 
      [bookmark: pgfId-1081172]Step 3[image: ] To set the mobility services engine to send out-of-sync alerts, select the Out of Sync Alerts  Enabled  check box.
 
      [bookmark: pgfId-1081173]Step 4[image: ] To enable smart synchronization, select the Smart Synchronization  Enabled  check box.
 
      
       
     
 
     
 
     [bookmark: pgfId-1081174]Note Smart synchronization does not apply to elements (network designs, controllers, or event groups) that have not yet been assigned to a mobility services engine. However, out-of-sync alarms are still generated for these unassigned elements. For smart synchronization to apply to these elements, you must manually assign them to a mobility services engine.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1081175]Note When a mobility services engine is added to an Prime Infrastructure, the data in the Prime Infrastructure is always treated as the primary copy that is synchronized with the mobility services engine. All synchronized network designs, controllers, event groups and wired switches that are present in the mobility services engine and not in the Prime Infrastructure are removed automatically from mobility services engine.

      
      
 
     

     
 
      [bookmark: pgfId-1081176]Step 5[image: ] Enter the time interval, in minutes, that the smart synchronization is to be performed.
 
      [bookmark: pgfId-1081177]By default, the smart-sync is enabled.
 
      [bookmark: pgfId-1081178]Step 6[image: ] Click  Submit .
 
      [bookmark: pgfId-1081179]

      
      
 
     
 
     
 
      [bookmark: pgfId-1081182]For Smart controller assignment and selection scenarios, see the “Smart Controller Assignment and Selection Scenarios” section.
 
    
 
     
      [bookmark: pgfId-1081186][bookmark: 26327]Smart Controller Assignment and Selection Scenarios
 
      [bookmark: pgfId-1081187] Scenario 1 
 
      [bookmark: pgfId-1081188]If a floor having at least one access point from a controller is chosen to be synchronized with the mobility services engine in the Network Designs menu of the Synchronize Services page, then the controller to which that access point is connected is automatically selected to be assigned to the mobility services engine for CAS service. 
 
      [bookmark: pgfId-1081189] Scenario 2 
 
      [bookmark: pgfId-1081190]When at least one access point from a controller is placed on a floor that is synchronized with the mobility services engine, the controller to which the access point is connected is automatically assigned to the same mobility services engine for the CAS service.
 
      [bookmark: pgfId-1081191] Scenario 3 
 
      [bookmark: pgfId-1081192]An access point is added to a floor and assigned to a mobility services engine. If that access point is moved from controller A to controller B, then controller B is automatically synchronized to the mobility services engine.
 
      [bookmark: pgfId-1081193] Scenario 4 
 
      [bookmark: pgfId-1101006]If all access points placed on a floor that is synchronized to the MSE are deleted, then that controller is automatically removed from the mobility services engine assignment or unsynchronized.
 
    
 
     
      [bookmark: pgfId-1101008][bookmark: 11279]Out-of-Sync Alarms
 
      [bookmark: pgfId-1101010]Out-of-sync alarms are of the minor severity (yellow), and are raised in response to the following conditions:
 
      
      	 [bookmark: pgfId-1081201]Elements are modified in the Prime Infrastructure (the auto-sync policy pushes these elements)
 
      	 [bookmark: pgfId-1081202]Elements other than controllers exist in the mobility services engine database but not in the Prime Infrastructure
 
      	 [bookmark: pgfId-1081203]Elements are not assigned to any mobility services engine (the auto-sync policy does not apply)
 
     
 
      [bookmark: pgfId-1081204]Out-of-sync alarms are cleared when the following occurs:
 
      
      	 [bookmark: pgfId-1081205]The mobility services engine is deleted
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1081206]Note When you delete a mobility services engine, the out-of-sync alarms for that system are also deleted. In addition, if you delete the last available mobility services engine, the alarm for the following event: “elements not assigned to any server” is deleted.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1081207]Elements are synchronized manually or automatically
 
      	 [bookmark: pgfId-1081208]User manually clears the alarms (although the alarms may reappear in the future when the scheduled task is next executed)
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1081212][bookmark: 98340]Viewing Mobility Services Engine Synchronization Status
 
     [bookmark: pgfId-1081214]You can use the Synchronize Services feature in the Prime Infrastructure to view the status of network design, controller, switch, and event group synchronization with a mobility services engine.
 
     [bookmark: pgfId-1081215]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1081219]Viewing Mobility Services Engine Synchronization Status
 
     	 [bookmark: pgfId-1081223]Viewing Synchronization History
 
     	 [bookmark: pgfId-1102560]Deleting an MSE License File
 
     	 [bookmark: pgfId-1102581]Deleting a Mobility Services Engine from the Prime Infrastructure
 
    
 
     
      [bookmark: pgfId-1081226][bookmark: 73535]Viewing Mobility Services Engine Synchronization Status
 
      [bookmark: pgfId-1081227]To view the synchronization status, follow these steps:
 
     
 
      [bookmark: pgfId-1081228] Step 1[image: ] Choose  Services > Synchronize Services .
 
      [bookmark: pgfId-1081229]Step 2[image: ] From the left sidebar menu, choose  Network Designs ,  Controllers , Event Groups,  Wired  Switches , Third Party Elements, or Service Advertisements.
 
      [bookmark: pgfId-1081230]For each of the elements, the Sync. Status column shows the synchronization status. A green two-arrow icon indicates that its corresponding element is synchronized with the specified server such as a mobility services engine. A gray two-arrow icon with a red circle indicates that its corresponding item is not synchronized with a provided server.
 
      [bookmark: pgfId-1081231]The Message column shows the reason for failure if the elements are out of sync.
 
      [bookmark: pgfId-1081232]You can also view the synchronization status at  Monitor > Site Maps > System Campus > Building >  Floor. 
 
      [bookmark: pgfId-1081233]where  Building is the building within the campus and  Floor is a specific floor in that campus building.
 
      [bookmark: pgfId-1081234]The MSE Assignment option on the left sidebar menu shows which mobility services engine the floor is currently assigned to. You can also change the mobility services engine assignment in this page.
 
      [bookmark: pgfId-1081235]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1081238][bookmark: 80497]Viewing Synchronization History
 
      [bookmark: pgfId-1081240]You can view the synchronization history for the last 30 days for a mobility services engine. This is especially useful when automatic synchronization is enabled as alarms are automatically cleared. Synchronization history provides a summary of those cleared alarms.
 
      [bookmark: pgfId-1081241]To view synchronization history choose  Services > Synchronization History . The Synchronization History page appears. Click the column headings to sort the entries.
 
      [bookmark: pgfId-1081242]
 
      [bookmark: pgfId-1081246] Table 2-2  describes the table column headings that appear in the Synchronization History page.
 
      [bookmark: pgfId-1081291]
 
      
       
        
         [bookmark: pgfId-1081250]Table 2-2 [bookmark: 11796]Synchronization History Page
 
        
       
         
         	
           
           [bookmark: pgfId-1081254]Text Boxes
          
  
         	
           
           [bookmark: pgfId-1081256]Description
          
  
        
 
         
         	 [bookmark: pgfId-1081258]Timestamp
  
         	 [bookmark: pgfId-1081260]The date and time at which the synchronization has happened.
  
        
 
         
         	 [bookmark: pgfId-1081262]Server
  
         	 [bookmark: pgfId-1081264]The mobility services engine server.
  
        
 
         
         	 [bookmark: pgfId-1081266]Element Name
  
         	 [bookmark: pgfId-1081268]The name of element that was synchronized.
  
        
 
         
         	 [bookmark: pgfId-1081270]Type
  
         	 [bookmark: pgfId-1081272]The type of the element that was synchronized.
  
        
 
         
         	 [bookmark: pgfId-1081274]Sync Operation
  
         	 [bookmark: pgfId-1081276]The sync operation that was performed. 
  [bookmark: pgfId-1081277]It can be an Update, Add, or Delete.
  
        
 
         
         	 [bookmark: pgfId-1081279]Generated By
  
         	 [bookmark: pgfId-1081281]The method of synchronization.
  [bookmark: pgfId-1081282]It can be Manual or Automatic.
  
        
 
         
         	 [bookmark: pgfId-1081284]Status
  
         	 [bookmark: pgfId-1081286]The status of the synchronization. It can be either Success or Failed.
  
        
 
         
         	 [bookmark: pgfId-1081288]Message
  
         	 [bookmark: pgfId-1081290]Any additional message about the synchronization.
  
        
 
       
      
 
     
 
      [bookmark: pgfId-1081293]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1081294][bookmark: 15619]Deleting an MSE License File
 
      [bookmark: pgfId-1081295]To delete an MSE license file, follow these steps:
 
     
 
      [bookmark: pgfId-1081296] Step 1[image: ] Choose  Services >  Mobility Service Engine .
 
      [bookmark: pgfId-1081297]The Mobility Services page appears.
 
      [bookmark: pgfId-1081298]Step 2[image: ] Click  Device Name to delete a license file for a particular service.
 
      [bookmark: pgfId-1081299]Step 3[image: ] From the Select a command drop-down list, choose Edit Configuration.
 
      [bookmark: pgfId-1081300]The Edit Mobility Services Engine dialog box appears.
 
      [bookmark: pgfId-1081301]Step 4[image: ] Click  Next in the Edit Mobility Services Engine dialog box.
 
      [bookmark: pgfId-1081302]The MSE License Summary page appears.
 
      [bookmark: pgfId-1081303]Step 5[image: ] Choose the MSE license file that you want to delete in the MSE License Summary page.
 
      [bookmark: pgfId-1081304]Step 6[image: ] Click  Remove License .
 
      [bookmark: pgfId-1081305]Step 7[image: ] Click  OK to confirm the deletion or  Cancel to close this page without deleting the license.
 
      [bookmark: pgfId-1081306]Step 8[image: ] Click  Next to enable services on the mobility services engine.
 
      [bookmark: pgfId-1081307]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1081310][bookmark: 39494]Deleting a Mobility Services Engine from the Prime Infrastructure
 
      [bookmark: pgfId-1081311]To delete one or more mobility services engines from the Prime Infrastructure database, follow these steps:
 
      
       
     
 
     
 
     [bookmark: pgfId-1094331]Note The Services > Mobility Services Engine page is available only in the virtual domain in Release 7.3.

      
      
 
     

     
 
     
 
      [bookmark: pgfId-1081313] Step 1[image: ] Choose  Services > Mobility Services. 
 
      [bookmark: pgfId-1081314]The Mobility Services page appears.
 
      [bookmark: pgfId-1081315]Step 2[image: ] Select the mobility services engine to be deleted by selecting the corresponding  Device Name check box(es).
 
      [bookmark: pgfId-1081316]Step 3[image: ] From the Select a command drop-down list, choose  Delete Service(s).  Click  Go .
 
      [bookmark: pgfId-1081317]Step 4[image: ] Click  OK to confirm that you want to delete the selected mobility services engine from the Prime Infrastructure database.
 
      [bookmark: pgfId-1081318]Step 5[image: ] Click  Cancel to stop deletion.
 
      [bookmark: pgfId-1081319]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1081331][bookmark: 20201]Viewing Clients and Users
 
     [bookmark: pgfId-1081332]To view clients and users in the Prime Infrastructure UI, follow these steps:
 
    
 
     [bookmark: pgfId-1081333] Step 1[image: ] Choose Monitor >  Clients and Users  to view both wired and wireless clients information. The Clients and Users page appears.
 
     [bookmark: pgfId-1081334]The Clients and Users table displays a few columns by default. If you want display the additional columns that are available, click [image: ] , and then click  Columns . The available columns appear. Select the columns that you want to show in the Clients and Users table. When you click anywhere in a row, the row is selected and the client details are shown. 
 
     [bookmark: pgfId-1081338]The following columns are available in the Clients and Users table:
 
     
      
      	 [bookmark: pgfId-1081339]MAC Address—Client MAC address.
 
      	 [bookmark: pgfId-1081340]IP Address—Client IP address.
 
     
 
    
 
     [bookmark: pgfId-1081341]The IP address that appears in the IP Address column is determined by a predefined priority order. The first IP address available in the following order appears in the IP address field:
 
     [bookmark: pgfId-1081342]–[image: ] IPv4 address.
 
     [bookmark: pgfId-1081343]–[image: ] IPv6 unique global address. If there are multiple addresses of this type, most recent IPv6 address the client received are shown, because a user can have two global IPv6 addresses but one might be from an older router advertisement that is being aged out.
 
     [bookmark: pgfId-1081344]–[image: ] IPv6 unique local address. If there are multiple IPv6 unique local addresses, the most recent one is used.
 
     [bookmark: pgfId-1081345]–[image: ] IPv6 link-local address. The IPv6 clients always have at least one link-local address.
 
     [bookmark: pgfId-1081346]The following are the different IPv6 address types:
 
     [bookmark: pgfId-1081347]–[image: ] Link-local Unicast—The link-local addresses are designed to be used for addressing on a single link for purposes such as auto-address configuration, neighbor discovery, or when no routers are present.
 
     [bookmark: pgfId-1081348]–[image: ] Site-local Unicast—The site-local addresses are designed to be used for addressing inside of a site without the need for a global prefix.
 
     [bookmark: pgfId-1081349]–[image: ] Global Unicast—The global unicast address uniquely identifies the client in the global network and is equivalent to a public IPv4 address. A client can have multiple global unicast addresses.
 
     
      
    
 
    
 
    [bookmark: pgfId-1081350]Note When there is more than one IP address of the same type, only the most recent IP address of that type appears, and the rest appear in the QuickView page when you hover your mouse cursor over the QuickView (+) icon. 

     
     
 
    

    
 
     
      
      	 [bookmark: pgfId-1081351]IP Address Type—The IP address type such as IPv4 and IPv6.
 
      	 [bookmark: pgfId-1094336]PMIP Client—Specifies if the client is a PMIP client.
 
      	 [bookmark: pgfId-1094337]PMIP State—State of the PMIP client. The available states are as follows:
 
     
 
    
 
     [bookmark: pgfId-1094338]–[image: ] Unknown—Indicates that the state of the client cannot be determined.
 
     [bookmark: pgfId-1094339]–[image: ] Activated—Indicates that the client is ready to establish a tunnel.
 
     [bookmark: pgfId-1094340]–[image: ] Tunneled—Indicates that a bidirectional tunnel is established.
 
     
      
      	 [bookmark: pgfId-1081357]Global Unique—The aggregate global unicast address of an IPv6 address. This field is populated only if a client is assigned a global unique IPv6 address.
 
      	 [bookmark: pgfId-1081358]Unique Local—The local unicast address of an IPv6 address. This field is populated only if a client is assigned a local unique IPv6 address.
 
      	 [bookmark: pgfId-1081359]Link Local—The link-local unicast address of an IPv6 address. This field is populated only if a client is assigned a link-local IPv6 address.
 
      	 [bookmark: pgfId-1081360]User Name—Username based on 802.1x authentication or Web authentication. Unknown is displayed for a client connected without a username.
 
      	 [bookmark: pgfId-1081361]Type—Indicates the client type.
 
     
 
    
 
     [bookmark: pgfId-1081365]–[image: ] [image: ] Indicates a lightweight client
 
     [bookmark: pgfId-1081369]–[image: ] [image: ] indicates a wired client
 
     [bookmark: pgfId-1081373]–[image: ] [image: ] Indicates an autonomous client
 
     
      
      	 [bookmark: pgfId-1081374]Vendor—Device vendor derived from OUI.
 
      	 [bookmark: pgfId-1081375]AP Name—Wireless only
 
      	 [bookmark: pgfId-1081376]Device Name—Network authentication device name, for example, WLC, switch.
 
      	 [bookmark: pgfId-1081377]Location—Map location of connected device.
 
      	 [bookmark: pgfId-1081378]ISE—Yes/No. This column represents whether the client is authenticated using the ISE, which is added to Prime Infrastructure.
 
      	 [bookmark: pgfId-1081379]Endpoint Type—Endpoint type as reported by the ISE, available only when the ISE is added (for example, iPhone, iPad, Windows workstation).
 
      	 [bookmark: pgfId-1081380]Posture—Latest client posture status
 
      	 [bookmark: pgfId-1081381]SSID—Wireless only
 
      	 [bookmark: pgfId-1081382]Profile Name—Wireless only
 
      	 [bookmark: pgfId-1081383]VLAN——Indicates the access VLAN ID for this client.
 
      	 [bookmark: pgfId-1081384]Status—Current client status
 
     
 
    
 
     [bookmark: pgfId-1081385]–[image: ] Idle—Normal operation; no rejections of client association requests.
 
     [bookmark: pgfId-1081386]–[image: ] Auth Pending—Completing a AAA transaction.
 
     [bookmark: pgfId-1081387]–[image: ] Authenticated—802.11 authentication complete.
 
     [bookmark: pgfId-1081388]–[image: ] Associated—802.11 association complete. This is also used by wired clients to represent that a client is currently connected to the network.
 
     [bookmark: pgfId-1081389]–[image: ] Power Save—Client is in power save mode. 
 
     [bookmark: pgfId-1081390]–[image: ] Disassociated—802.11 disassociation complete. This is also used by wired clients to represent that a client is currently not on the network.
 
     [bookmark: pgfId-1081391]–[image: ] To Be Deleted—The client that is deleted after disassociation.
 
     [bookmark: pgfId-1081392]–[image: ] Excluded—Automatically disabled by the system due to perceived security threat. 
 
     
      
      	 [bookmark: pgfId-1081393]Interface—Controller interface (wireless) or switch interface (wired) that the client is connected to.
 
      	 [bookmark: pgfId-1081394]Protocol
 
     
 
    
 
     [bookmark: pgfId-1081395]–[image: ] 802.11—wireless
 
     [bookmark: pgfId-1081396]–[image: ] 802.3—wired
 
     
      
      	 [bookmark: pgfId-1081397]Speed—Ethernet port speed (wired only). Displays “N/A” for wireless.
 
      	 [bookmark: pgfId-1081398]Association Time—Last association start time (for wireless client). For a wired client, this is the time when the client is connected to a switch port. This column is blank for a client that is associated but has problems being on the network.
 
      	 [bookmark: pgfId-1081399]Session Length—Session length.
 
      	 [bookmark: pgfId-1081400]First Seen—Indicates the date and time when the client was first detected.
 
      	 [bookmark: pgfId-1081401]Authentication Type—WPA, WPA2, 802.1x, MAC Auth Bypass, or Web Auth.
 
      	 [bookmark: pgfId-1081402]Authorization Profile Names—Authorization profiles applied to this client by the ISE. This contains data only when the ISE is added and the client is authenticated by the ISE.
 
      	 [bookmark: pgfId-1081403]Traffic (MB)—Traffic (transmitted/received) in this session in MB.
 
      	 [bookmark: pgfId-1081404]Average Session Throughput (kbps)—Average session throughput in kbps.
 
      	 [bookmark: pgfId-1081405]Automated Test Run—Indicates whether the client is in auto test mode. This is applicable for wireless clients only.
 
      	 [bookmark: pgfId-1081406]AP MAC Address—Wireless only.
 
      	 [bookmark: pgfId-1081407]AP IP Address—Wireless only.
 
      	 [bookmark: pgfId-1081408]Anchor Controller—Lightweight wireless only.
 
      	 [bookmark: pgfId-1081409]On Network—Shows Yes for the clients that are associated and have successfully finished authentication, if required.
 
      	 [bookmark: pgfId-1081410]CCX—Lightweight wireless only.
 
      	 [bookmark: pgfId-1081411]Client Host Name—Wired and wireless. Result of DNS reverse lookup.
 
      	 [bookmark: pgfId-1081412]Device IP Address—IP address of the connected device (WLC, switch. or autonomous AP).
 
      	 [bookmark: pgfId-1081413]Port—Switch port on WLC.
 
      	 [bookmark: pgfId-1081414]E2E—Lightweight wireless only.
 
      	 [bookmark: pgfId-1081415]Encryption Cipher—Wireless only.
 
      	 [bookmark: pgfId-1081416]MSE—MSE server managing this client.
 
      	 [bookmark: pgfId-1081417]RSSI—Wireless only.
 
      	 [bookmark: pgfId-1081418]SNR—Wireless only.
 
      	 [bookmark: pgfId-1081419]Router Advertisements Dropped—The router advertisements that are dropped for each client for a particular session.
 
      	 [bookmark: pgfId-1081420]Session ID—Audit-session-ID used in the ISE and on the switch.
 
      	 [bookmark: pgfId-1081421]FlexConnect Local Authentication—Indicates if the FlexConnect Local Authentication is enabled for this client.
 
      	 [bookmark: pgfId-1081422]WGB Status—Indicates the status of the work group bridge mode.
 
      	 [bookmark: pgfId-1081423]Mobility Status—Indicates the mobility status of the wireless client.
 
      	 [bookmark: pgfId-1081424]SNMP NAC State—Indicates the state of the NAC appliance in out-of-band mode.
 
     
 
    
 
     [bookmark: pgfId-1081425]Step 2[image: ] Select a client or user. The following information appears:
 
     
     	 [bookmark: pgfId-1081426]Client Attributes
 
     	 [bookmark: pgfId-1081427]Client Statistics
 
     	 [bookmark: pgfId-1081428]Client Association History
 
     	 [bookmark: pgfId-1081429]Client Event Information
 
     	 [bookmark: pgfId-1081430]Client Location Information
 
     	 [bookmark: pgfId-1081431]Client CCXv5 Information
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1081432]Note Client Statistics shows statistical information after the client details are shown.

     
     
 
    

    
 
     [bookmark: pgfId-1081433]

     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1077240][bookmark: 13766]Adding Floor Areas
 
     [bookmark: pgfId-1077241]This section describes how to add floor plans to either a campus building or a standalone building in the Prime Infrastructure database.
 
     [bookmark: pgfId-1077242]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1077246]Adding Floor Areas to a Campus Building
 
     	 [bookmark: pgfId-1077250]Adding Floor Plans to a Standalone Building
 
    
 
     
      [bookmark: pgfId-1077252][bookmark: 87235]Adding Floor Areas to a Campus Building
 
      [bookmark: pgfId-1077253]After you add a building to a campus map, you can add individual floor plan and basement maps to the building.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077254]Note Use the zoom controls at the top of the campus image to enlarge or decrease the size of the map view and to hide or show the map grid (which shows the map size in feet or meters).

      
      
 
     

     
 
      [bookmark: pgfId-1077255]To add a floor area to a campus building, follow these steps:
 
     
 
      [bookmark: pgfId-1077256] Step 1[image: ] Save your floor plan maps in .PNG, .JPG, ,JPEG, or .GIF format.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077257]Note For CMX analytics, it is recommended that the size of image file is maximum of 500k. Loading large images into the 3D version of CMX analytics causes certain browsers to show black images. The mse.properties file can also be configured to automatically compress the image.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077258]Note If there are problems converting the auto-cad file, an error message is displayed. The Prime Infrastructure uses a native image conversion library to convert auto-cad files into raster formats like .png. If the native library cannot be loaded, the Prime Infrastructure shows an “unable to convert the auto-cad file” message. If you receive this error, make sure all the required dependencies are met for the native library. To find any dependency problems, use ldd on Linux platforms. The following DLLs must be present under the /webnms/rfdlls Prime Infrastructure installation directory: LIBGFL254.DLL, MFC71.DLL, MSVCR71.DLL, and MSVCP71.DLL. If dependency problems occurs, you have to install the required libraries and restart Prime Infrastructure.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077259]Note The floor map image is enhanced for zooming and panning. The floor image is not visible completely until this operation is complete. You can zoom in and out to view the complete map image. For example, if you have a high resolution image (near 181 megapixels) whose size is approximately 60 megabytes, it may take two minutes to appear on the map.

      
      
 
     

     
 
      [bookmark: pgfId-1077260]Step 2[image: ] Choose Monitor > Site Maps.
 
      [bookmark: pgfId-1077261]Step 3[image: ] From the Maps Tree View or the Monitor > Site Maps list, choose the applicable campus building to open the Building View page.
 
      [bookmark: pgfId-1077262]Step 4[image: ] Hover your mouse cursor over the name within an existing building rectangle to highlight it.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077263]Note You can also access the building from the Campus View page. In the Campus View page, click the building name to open the Building View page.

      
      
 
     

     
 
      [bookmark: pgfId-1077264]Step 5[image: ] From the Select a command drop-down list, choose New Floor Area.
 
      [bookmark: pgfId-1077265]Step 6[image: ] Click Go. The New Floor Area page appears.
 
      [bookmark: pgfId-1077266]Step 7[image: ] In the New Floor Area page, follow these steps to add floors to a building in which to organize related floor plan maps:
 
      [bookmark: pgfId-1077267] a.[image: ] Enter the floor area and contact names.
 
      [bookmark: pgfId-1077268] b.[image: ] Choose the floor or basement number from the Floor drop-down list.
 
      [bookmark: pgfId-1077269] c.[image: ] Choose the floor or basement type (RF Model).
 
      [bookmark: pgfId-1077270] d.[image: ] Enter the floor-to-floor height in feet.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077271]Note To change the unit of measurement (feet or meters), choose Monitor > Site Maps, and choose Properties from the Select a command drop-down list.

      
      
 
     

     
 
      [bookmark: pgfId-1077272] e.[image: ] Select the Image or CAD File check box. 
 
      [bookmark: pgfId-1077273] f.[image: ] Browse to and choose the desired floor or basement image or CAD filename, and click Open.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077274]Note If you are importing a CAD file, use the Convert CAD File drop-down list to determine the image file for conversion.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077275]Tip It is not recommended to use a .JPEG (.JPG) format for an auto-cad conversion. Unless a JPEG is specifically required, use .PNG or .GIF format for higher quality images.

      
      
 
     

     
 
      [bookmark: pgfId-1077276] g.[image: ] Click Next. At this point, if a CAD file was specified, a default image preview is generated and loaded. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1077277]Note The Prime Infrastructure uses a native image conversion library to convert auto-cad files into raster formats like .PNG. When there are issues loading the native library, Prime Infrastructure shows the following error: "Unable to convert the auto-cad file. Reason: Error while loading the auto-cad image conversion library.” For more information see Prime Infrastructure online help or Prime Infrastructure documentation.

      
      
 
     

     
 
      [bookmark: pgfId-1077278]The names of the CAD file layers are listed with check boxes to the right side of the image indicating which are enabled.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077279]Note When you choose the floor or basement image filename, the Prime Infrastructure shows the image in the building-sized grid.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077280]Note The maps can be of any size because the Prime Infrastructure automatically resizes the maps to fit the workspace. 

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077281]Note The map must be saved in .PNG, .JPG, .JPEG, or .GIF format.

      
      
 
     

     
 
      [bookmark: pgfId-1077282] h.[image: ] If you have CAD file layers, you can select or deselect as many as you want and click Preview to view an updated image. Click Next when you are ready to proceed with the selected layers. 
 
      [bookmark: pgfId-1077283]Enter the remaining parameters for the floor area.
 
      [bookmark: pgfId-1077284] i.[image: ] Either leave the Maintain Aspect Ratio check box selected to preserve the original image aspect ratio or unselect the check box to change the image aspect ratio.
 
      [bookmark: pgfId-1077285] j.[image: ] Enter an approximate floor or basement horizontal and vertical span (width and depth on the map) in feet.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077286]Note The horizontal and vertical spans should be smaller than or the same size as the building horizontal and vertical spans in the Prime Infrastructure database.

      
      
 
     

     
 
      [bookmark: pgfId-1077287] k.[image: ] If applicable, enter the horizontal position (distance from the corner of the outdoor area rectangle to the left edge of the campus map) and vertical position (distance from the corner of the outdoor area rectangle to the top edge of the campus map) in feet or meters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077288]Tip Use Ctrl-click to resize the image within the building-sized grid.

      
      
 
     

     
 
      [bookmark: pgfId-1077289] l.[image: ] If desired, select the Launch Map Editor after floor creation check box to rescale the floor and draw walls.
 
      [bookmark: pgfId-1077290] m.[image: ] Click OK to save this floor plan to the database. The floor is added to the Maps Tree View and the  Design > Site  Maps list.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077291]Note Use different floor names in each building. If you are adding more than one building to the campus map, do not use a floor name that exists in another building. This overlap causes incorrect mapping information between a floor and a building.

      
      
 
     

     
 
      [bookmark: pgfId-1077292]Step 8[image: ] Click any of the floor or basement images to view the floor plan or basement map. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1077293]Note You can zoom in or out to view the map at different sizes and you can add access points.

      
      
 
     

     
 
      [bookmark: pgfId-1077294]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1077298][bookmark: 60437]Adding Floor Plans to a Standalone Building
 
      [bookmark: pgfId-1077300][bookmark: marker-1077299]After you have added a standalone building to the Prime Infrastructure database, you can add individual floor plan maps to the building. 
 
      [bookmark: pgfId-1077301]To add floor plans to a standalone building, follow these steps:
 
     
 
      [bookmark: pgfId-1077302] Step 1[image: ] Save your floor plan maps in .PNG, .JPG, or .GIF format.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077303]Note The maps can be of any size because the Prime Infrastructure automatically resizes the maps to fit the workspace.

      
      
 
     

     
 
      [bookmark: pgfId-1077304]Step 2[image: ] Browse to and import the floor plan maps from anywhere in your file system. You can import CAD files in DXF or DWG formats or any of the formats you created in Step 1.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077305]Note If there are problems converting the auto-cad file, an error message is displayed. the Prime Infrastructure uses a native image conversion library to convert auto-cad files into raster formats like .PNG. If the native library cannot be loaded, the Prime Infrastructure shows an “unable to convert the auto-cad file” message. If you receive this error, make sure all the required dependencies are met for the native library. To find any dependency problems, use ldd on Linux platforms. The following DLLs must be present under the /webnms/rfdlls the Prime Infrastructure installation directory: LIBGFL254.DLL, MFC71.DLL, MSVCR71.DLL, and MSVCP71.DLL. If dependency problems occurs, you must install the required libraries and restart the Prime Infrastructure.

      
      
 
     

     
 
      [bookmark: pgfId-1077306]Step 3[image: ] Choose Monitor > Site Maps. 
 
      [bookmark: pgfId-1077307]Step 4[image: ] From the Maps Tree View or the Design > Site Maps left sidebar menu, choose the desired building to display the Building View page. 
 
      [bookmark: pgfId-1077308]Step 5[image: ] From the Select a command drop-down list, choose New Floor Area.
 
      [bookmark: pgfId-1077309]Step 6[image: ] Click Go. 
 
      [bookmark: pgfId-1077310]Step 7[image: ] In the New Floor Area page, add the following information:
 
      
       
       	 [bookmark: pgfId-1077311]Enter the floor area and contact names.
 
       	 [bookmark: pgfId-1077312]Choose the floor or basement number from the Floor drop-down list.
 
       	 [bookmark: pgfId-1077313]Choose the floor or basement type (RF Model).
 
       	 [bookmark: pgfId-1077314]Enter the floor-to-floor height in feet.
 
       	 [bookmark: pgfId-1077315]Select the Image or CAD File check box. 
 
       	 [bookmark: pgfId-1077316]Browse to and choose the desired floor or basement Image or CAD file, and click Open.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077317]Note If you are importing a CAD file, use the Convert CAD File drop-down list to determine the image file for conversion.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077318]Tip A .JPEG (.JPG) format is not recommended for an auto-cad conversion. Unless a .JPEG is specifically required, use a .PNG or .GIF format for higher quality images.

      
      
 
     

     
 
      [bookmark: pgfId-1077319]Step 8[image: ] Click Next. At this point, if a CAD file was specified, a default image preview is generated and loaded.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077320]Note The Prime Infrastructure uses a native image conversion library to convert auto-cad files into raster formats like .PNG. When there are issues loading the native library, the Prime Infrastructure shows the following error: “Unable to convert the auto-cad file. Reason: Error while loading the auto-cad image conversion library. For more information, see the Prime Infrastructure online help or the Prime Infrastructure documentation”.

      
      
 
     

     
 
      [bookmark: pgfId-1077321]The names of the CAD file layers are listed with check boxes to the right side of the image indicating which are enabled.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077322]Note When you choose the floor or basement image filename, the Prime Infrastructure shows the image in the building-sized grid.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077323]Note The maps can be any size because the Prime Infrastructure automatically resizes the maps to fit the workspace.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077324]Note The map must be saved in .PNG, .JPG, .JPEG, or .GIF format.

      
      
 
     

     
 
      [bookmark: pgfId-1077325]If you have CAD file layers, you can select or deselect as many as you want and click Preview to view an updated image. Click Next when you are ready to proceed with the selected layers. 
 
      [bookmark: pgfId-1077326]Step 9[image: ] Enter the remaining parameters for the floor area.
 
      
       
       	 [bookmark: pgfId-1077327]Either leave the Maintain Aspect Ratio check box selected to preserve the original image aspect ratio or unselect the check box to change the image aspect ratio.
 
       	 [bookmark: pgfId-1077328]Enter an approximate floor or basement horizontal and vertical span (width and depth on the map) in feet.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077329]Note The horizontal and vertical spans should be smaller than or the same size as the building horizontal and vertical spans in the Prime Infrastructure Prime Infrastructure database.

      
      
 
     

     
 
      
       
       	 [bookmark: pgfId-1077330]If applicable, enter the horizontal position (distance from the corner of the outdoor area rectangle to the left edge of the campus map) and vertical position (distance from the corner of the outdoor area rectangle to the top edge of the campus map) in feet or meters.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1077331]Tip Use Ctrl-click to resize the image within the building-sized grid.

      
      
 
     

     
 
      
       
       	 [bookmark: pgfId-1077332]Adjust the floor characteristics with the Prime Infrastructure map editor by selecting the check box next to Launch Map Editor. 
 
      
 
     
 
      [bookmark: pgfId-1077333]Step 10[image: ] Click OK to save this floor plan to the database. The floor is added to the Maps Tree View and the  Design > Site  Maps list.
 
      [bookmark: pgfId-1077334]Step 11[image: ] Click any of the floor or basement images to view the floor plan or basement map. 
 
      [bookmark: pgfId-1077335]You can zoom in or out to view the map at different sizes and you can add access points.
 
      [bookmark: pgfId-1077336]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1077338][bookmark: 55063]Defining Coverage Area
 
     [bookmark: pgfId-1077339]To draw a coverage area using the Prime Infrastructure UI, follow these steps:
 
     
      
    
 
    
 
    [bookmark: pgfId-1077340]Note You must add floor plan before drawing a coverage area.

     
     
 
    

    
 
    
 
     [bookmark: pgfId-1077341] Step 1[image: ] Add the floor plan if it is not already represented in the Prime Infrastructure.
 
     [bookmark: pgfId-1077342]Step 2[image: ] Choose Monitor > Site Maps.
 
     [bookmark: pgfId-1077343]Step 3[image: ] Click the Map Name that corresponds to the outdoor area, campus, building, or floor you want to edit.
 
     [bookmark: pgfId-1077344]Step 4[image: ] From the Select a command drop-down list, choose Map Editor, and click Go.
 
     [bookmark: pgfId-1077345]Step 5[image: ] It the Map Editor page, click the Draw Coverage Area icon on the toolbar.
 
     [bookmark: pgfId-1077346]A pop-up appears.
 
     [bookmark: pgfId-1077347]Step 6[image: ] Enter the name of the area that you are defining. Click OK.
 
     [bookmark: pgfId-1077348]A drawing tool appears.
 
     [bookmark: pgfId-1077349]Step 7[image: ] Move the drawing tool to the area you want to outline.
 
     
     	 [bookmark: pgfId-1077350]Click the left mouse button to begin and end drawing a line.
 
     	 [bookmark: pgfId-1077351]When you have completely outlined the area, double-click the left mouse button and the area is highlighted in the page.
 
    
 
     [bookmark: pgfId-1077352]The outlined area must be a closed object to appear highlighted on the map.
 
     [bookmark: pgfId-1077353]Step 8[image: ] Click the disk icon on the toolbar to save the newly drawn area.
 
     [bookmark: pgfId-1077354]

     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1077356][bookmark: 44098]Monitoring Geo-Location
 
     [bookmark: pgfId-1077357]The MSE provides physical location of wired clients, wired endpoints, switches, controllers, and access points present in a wireless network deployment. Currently, MSE provides location information in geo-location format to the external entities through northbound and southbound entities. 
 
     [bookmark: pgfId-1077358]To improve the accuracy of the geo-location information provided by MSE, this feature aims to transform the geometric location co-ordinates of a device to geo-location coordinates (latitude and longitude) and provides it to the external entities through northbound and southbound interfaces.
 
     
      
    
 
    
 
    [bookmark: pgfId-1077359]Note At least three GPS markers are required for geo-location calculation. The maximum number of GPS markers that you can add is 20.

     
     
 
    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-1099800]Note For CMX Analytics, the 2D OpenStreetMaps requires all points to be geo-located as latitude/longitude in order for the results to be displayed in the correct location.

     
     
 
    

    
 
     [bookmark: pgfId-1077360]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1077364]Adding a GPS Marker to a Floor Map
 
     	 [bookmark: pgfId-1077368]Editing a GPS Marker
 
     	 [bookmark: pgfId-1102610]Deleting a GPS Marker Present on a Floor
 
    
 
     
      [bookmark: pgfId-1077374][bookmark: 51389]Adding a GPS Marker to a Floor Map
 
      [bookmark: pgfId-1077375]To add a GPS marker to a floor map, follow these steps:
 
     
 
      [bookmark: pgfId-1077376] Step 1[image: ] Choose Monitor > Site Maps to display the Maps page.
 
      [bookmark: pgfId-1077377]Step 2[image: ] Choose Campus Name > Building Name > Floor Name.
 
      [bookmark: pgfId-1077378]Step 3[image: ] Choose the Add/Edit GPS Markers Information menu option on the top left menu to open the Add/Edit GPS page.
 
      [bookmark: pgfId-1077379]A GPS Marker icon appears on the top left corner of the map (X=0 Y=0).
 
      [bookmark: pgfId-1077380]Step 4[image: ] You can drag the GPS Marker icon and place it in the desired location on the map or enter the X and Y position values in the GPS Marker Details table on the left sidebar menu to move the marker to the desired position.
 
      
       
     
 
     
 
     [bookmark: pgfId-1077381]Note If the markers added are too close, then the accuracy of geo-location information is less.

      
      
 
     

     
 
      [bookmark: pgfId-1077382]Step 5[image: ] Enter the Latitude and Longitude degrees for the selected GPS Marker icon in the left sidebar menu.
 
      [bookmark: pgfId-1077383]Step 6[image: ] Click Save.
 
      [bookmark: pgfId-1077384]The GPS Marker information is saved to the database.
 
      [bookmark: pgfId-1077385]Step 7[image: ] Click Apply to other Floors of Building to copy GPS markers on one floor of a building to all the remaining floors of that building.
 
      
       
     
 
     
 
     [bookmark: pgfId-1084667]Note The GPS marker information is required by the CMX analytics to show results for the building in the 2D Open Street Maps view. A warning message is displayed if these GPS markers are not set.

      
      
 
     

     
 
      [bookmark: pgfId-1077386]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1084995][bookmark: 93698]Editing a GPS Marker
 
      [bookmark: pgfId-1084996]To edit a GPS marker present on the floor, follow these steps:
 
     
 
      [bookmark: pgfId-1084997] Step 1[image: ] Choose Monitor > Site Maps to display the Maps page.
 
      [bookmark: pgfId-1084998]Step 2[image: ] Choose the Campus Name > Building Name > Floor Name.
 
      [bookmark: pgfId-1084999]Step 3[image: ] Choose the Add/Edit GPS Markers Information menu option on the top left menu to open the Add/Edit GPS page.
 
      [bookmark: pgfId-1085000]Step 4[image: ] Select an existing GPS marker present on the floor.
 
      [bookmark: pgfId-1085001]Step 5[image: ] From the left sidebar menu, you can change the Latitude, Longitude, X Position, and Y Position which is associated with the GPS marker.
 
      [bookmark: pgfId-1085002]Step 6[image: ] Click Save.
 
      [bookmark: pgfId-1077396]The modified GPS marker information is now saved to the database.
 
      [bookmark: pgfId-1101045]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1084982][bookmark: 60980]Deleting a GPS Marker Present on a Floor
 
      [bookmark: pgfId-1084983]To delete a GPS marker present on a floor, follow these steps:
 
     
 
      [bookmark: pgfId-1084984] Step 1[image: ] Choose Monitor > Site Maps to display the Maps page.
 
      [bookmark: pgfId-1084985]Step 2[image: ] Choose Campus Name > Building Name > Floor Name.
 
      [bookmark: pgfId-1084986]Step 3[image: ] Choose the Add/Edit GPS Markers Information menu option to open the Add/Edit GPS page.
 
      [bookmark: pgfId-1084987]Step 4[image: ] Select an existing GPS Marker which is present on the floor from the left sidebar menu.
 
      
       
     
 
     
 
     [bookmark: pgfId-1084988]Note You can delete multiple GPS markers present on a floor by selecting the Multiple GPS Markers check box.

      
      
 
     

     
 
      [bookmark: pgfId-1084989]Step 5[image: ] Click Delete GPS Marker.
 
      [bookmark: pgfId-1084990]Step 6[image: ] The selected GPS marker is deleted from the database.
 
      [bookmark: pgfId-1101082]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1085598][bookmark: 65179]Inclusion and Exclusion Areas on a Floor
 
     
     	 [bookmark: pgfId-1085573]Inclusion and exclusion areas can be any polygon shape and must have at least three points. Points can sometime be located outside the building. If this is where the devices are, then a coverage area should be created. At other times, the points are actually inside and should be moved to the nearest inside location (same applies for unlikely areas inside). Defining inclusion and exclusion areas does this and therefore the analytic results are more consistent.
 
     	 [bookmark: pgfId-1085905]You can only define one inclusion region on a floor. By default, an inclusion region is defined for each floor when it is added to Prime Infrastructure. The inclusion region is indicated by a solid aqua line, and generally outlines the region.
 
     	 [bookmark: pgfId-1085946]You can define multiple exclusion regions on a floor.
 
     	 [bookmark: pgfId-1085983]Newly defined inclusion and exclusion regions appear on heatmaps only after the mobility services engine recalculates location.
 
    
 
     [bookmark: pgfId-1085988]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1086000]Defining an Inclusion Region on a Floor
 
     	 [bookmark: pgfId-1086020]Defining an Exclusion Region on a Floor
 
    
 
     
      [bookmark: pgfId-1085619][bookmark: 73074]Defining an Inclusion Region on a Floor
 
      [bookmark: pgfId-1085620]To define an inclusion area, follow these steps:
 
      [bookmark: pgfId-1085621]

      
      
 
     
 
     Step 1
     [image: ] Choose 
      Monitor > Site Maps . 
     
 
      [bookmark: pgfId-1085622]Step 2[image: ] Click the name of the appropriate floor area.
 
      [bookmark: pgfId-1085623]Step 3[image: ] From the Select a command drop-down list, choose  Map Editor .
 
      [bookmark: pgfId-1085624]Step 4[image: ] Click  Go .
 
      [bookmark: pgfId-1085625]Step 5[image: ] At the map, click the aqua box on the toolbar.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085626]Note A message box appears reminding you that only one inclusion area can be defined at a time. Defining a new inclusion region automatically removes the previously defined inclusion region. By default, an inclusion region is defined for each floor when it is added to Prime Infrastructure. The inclusion region is indicated by a solid aqua line and generally outlines the region.

      
      
 
     

     
 
      [bookmark: pgfId-1085627]Step 6[image: ] Click  OK  in the message box that appears. A drawing icon appears to outline the inclusion area.
 
      [bookmark: pgfId-1085628]Step 7[image: ] To begin defining the inclusion area, move the drawing icon to a starting point on the map and click once. 
 
      [bookmark: pgfId-1085629]Step 8[image: ] [bookmark: 61205]Move the cursor along the boundary of the area you want to include and click to end a border line. Click again to define the next boundary line.
 
      [bookmark: pgfId-1085633]Step 9[image: ] Repeat Step 8 until the area is outlined and then double-click the drawing icon. A solid aqua line defines the inclusion area.
 
      [bookmark: pgfId-1085634]Step 10[image: ] Choose Save from the Command menu or click the  disk icon on the toolbar to save the inclusion region.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085635]Note If you made an error in defining the inclusion area, click the area. The selected area is outlined by a dashed aqua line. Next, click the X icon on the toolbar. The area is removed from the floor map.

      
      
 
     

     
 
      [bookmark: pgfId-1085636]Step 11[image: ] Select the  Location Regions check box if it is not already selected. If you want it to apply to all floor maps, click  Save settings . Close the Layers configuration page. 
 
      [bookmark: pgfId-1085637]Step 12[image: ] To resynchronize Prime Infrastructure and MSE databases, choose  Services > Synchronize Services .
 
      
       
     
 
     
 
     [bookmark: pgfId-1085638]Note If the two DBs are already synchronized then a resynchronization happens automatically every time there is a change. There is no need for an explicit resynch. 

      
      
 
     

     
 
      [bookmark: pgfId-1085639]Step 13[image: ] In the Synchronize page, choose  Network Designs from the Synchronize drop-down list and then click  Synchronize .
 
      [bookmark: pgfId-1085640]You can confirm that the synchronization is successful by viewing two green arrows in the Sync. Status column.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085641]Note Newly defined inclusion and exclusion regions appear on heatmaps only after the mobility services engine recalculates location. 

      
      
 
     

     
 
      [bookmark: pgfId-1085642]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1085645][bookmark: 83171]Defining an Exclusion Region on a Floor
 
      [bookmark: pgfId-1085646]To further refine location calculations on a floor, you can define areas that are excluded (exclusion areas) in the calculations. For example, you might want to exclude areas such as an atrium or stairwell within a building. As a rule, exclusion areas are generally defined within the borders of an inclusion area.
 
      [bookmark: pgfId-1085647]To define an exclusion area, follow these steps:
 
      [bookmark: pgfId-1085648]

      
      
 
     
 
     Step 1
     [image: ] Choose 
      Monitor > Site Maps . 
     
 
      [bookmark: pgfId-1085649]Step 2[image: ] Click the name of the appropriate floor area.
 
      [bookmark: pgfId-1085650]Step 3[image: ] From the Select a command drop-down list, choose  Map Editor .
 
      [bookmark: pgfId-1085651]Step 4[image: ] Click  Go .
 
      [bookmark: pgfId-1085652]Step 5[image: ] [bookmark: 62325]At the map, click the purple box on the toolbar.
 
      [bookmark: pgfId-1085653]Step 6[image: ] Click  OK  in the message box that appears. A drawing icon appears to outline the exclusion area.
 
      [bookmark: pgfId-1085654]Step 7[image: ] To begin defining the exclusion area, move the drawing icon to the starting point on the map, and click once. 
 
      [bookmark: pgfId-1085655]Step 8[image: ] [bookmark: 12494]Move the drawing icon along the boundary of the area you want to exclude. Click once to start a boundary line, and click again to end the boundary line.
 
      [bookmark: pgfId-1085659]Step 9[image: ] [bookmark: 44083]Repeat Step 8until the area is outlined and then double-click the drawing icon. The defined exclusion area is shaded in purple when the area is completely defined. The excluded area is shaded in purple.
 
      [bookmark: pgfId-1085666]Step 10[image: ] To define additional exclusion regions, repeat Step 5 to Step 9.
 
      [bookmark: pgfId-1085667]Step 11[image: ] When all exclusion areas are defined, choose  Save from the Command menu or click the  disk icon on the toolbar to save the exclusion region.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085668]Note To delete an exclusion area, click the area to be deleted. The selected area is outlined by a dashed purple line. Next, click the X icon on the toolbar. The area is removed from the floor map.

      
      
 
     

     
 
      [bookmark: pgfId-1085669]Step 12[image: ] Select the Location Regions check box if it is not already selected, click  Save  setting s, and close the Layers configuration page when complete.
 
      [bookmark: pgfId-1085670]Step 13[image: ] To resynchronize Prime Infrastructure and location databases, choose  Services > Synchronize Services .
 
      [bookmark: pgfId-1085671]Step 14[image: ] In the Synchronize page, choose  Network Designs from the Synchronize drop-down list and then click  Synchronize .
 
      [bookmark: pgfId-1085602]You can confirm that the synchronization is successful by viewing two green arrows in the Sync. Status column.
 
      [bookmark: pgfId-1085736]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1083936][bookmark: 11164]Enabling CMX Analytics Service on the Mobility Services Engine
 
     [bookmark: pgfId-1083937]To enable CMX analytics service on the mobility services engine within the Prime Infrastructure UI, follow these steps:
 
    
 
     [bookmark: pgfId-1083938] Step 1[image: ] Choose Services > Mobility Services Engine.
 
     [bookmark: pgfId-1083939]The Mobility Services Engines page appears.
 
     [bookmark: pgfId-1083940]Step 2[image: ] In the Mobility Services page, click the Device Name to configure its properties.
 
     [bookmark: pgfId-1083941]Step 3[image: ] To enable CMX analytics service on the mobility services engine, select the check box next to the CMX analytics Service.
 
     [bookmark: pgfId-1083942]Step 4[image: ] Click Save.
 
     [bookmark: pgfId-1083973]Step 5[image: ] Click Done to save the settings.
 
     [bookmark: pgfId-1083974]

     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1085007][bookmark: 78685]Managing User Accounts
 
     [bookmark: pgfId-1085008]The Cisco Prime Infrastructure Administration enables you to schedule tasks, administer accounts, and configure local and external authentication and authorization. Also, set logging options, configure mail servers, and data management related to configuring the data retain periods. Information is available about the types of Prime Infrastructure licenses and how to install a license.
 
     [bookmark: pgfId-1085009]Organizations need an easy and cost-effective method to manage and control wireless network segments using a single management platform. They need a solution that supports limiting an individual administrator to manage or control the wireless LAN.
 
     [bookmark: pgfId-1085010]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1085014]Configuring Prime Infrastructure User Accounts
 
     	 [bookmark: pgfId-1085018]Deleting Prime Infrastructure User Accounts
 
     	 [bookmark: pgfId-1085022]Changing Passwords
 
     	 [bookmark: pgfId-1085026]Viewing or Editing User Account Information
 
     	 [bookmark: pgfId-1085030]Adding a New User
 
    
 
     
      [bookmark: pgfId-1085032][bookmark: 71649]Configuring Prime Infrastructure User Accounts
 
      [bookmark: pgfId-1085034][bookmark: marker-1085033]This section describes how to configure a Prime Infrastructure user. The accounting portion of the AAA framework is not implemented at this time. Besides complete access, you can give administrative access with differentiated privileges to certain user groups. Prime Infrastructure supports external user authentication using these access restrictions and authenticates the users against the TACACS+ and RADIUS servers. 
 
      [bookmark: pgfId-1085035]The username and password supplied by you at install time are always authenticated, but the steps you take here create additional superusers. If the password is lost or forgotten, you must run a utility to reset the password to another user-defined password. 
 
      [bookmark: pgfId-1085036]To configure a new user account to Prime Infrastructure, follow these steps:
 
     
 
      [bookmark: pgfId-1085039] Step 1[image: ] Start Prime Infrastructure server by following the instructions in the “Starting the Prime Infrastructure Server” section.
 
      [bookmark: pgfId-1085041]Step 2[image: ] Log into Prime Infrastructure user interface as  root .
 
      
       
     
 
     
 
     [bookmark: pgfId-1085042]Note We recommend that you create a new superuser assigned to the SuperUsers group.

      
      
 
     

     
 
      [bookmark: pgfId-1085043]Step 3[image: ] Choose  Administration > AAA. The Change Password page appears.
 
      [bookmark: pgfId-1085044]Step 4[image: ] In the Old Password text box, enter the current password that you want to change.
 
      [bookmark: pgfId-1085045]Step 5[image: ] Enter the username and password for the new Prime Infrastructure user account. You must enter the password twice.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085046]Note These entries are case sensitive.

      
      
 
     

     
 
      [bookmark: pgfId-1085047]Step 6[image: ] Choose  User Groups from the left sidebar menu. The All Groups page displays the following group names.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085048]Note Some usergroups cannot be combined with other usergroups. For instance, you cannot choose both lobby ambassador and monitor lite.

      
      
 
     

     
 
      
       
       	 [bookmark: pgfId-1085049]System Monitoring—Allows users to monitor Prime Infrastructure operations.
 
       	 [bookmark: pgfId-1085050]ConfigManagers—Allows users to monitor and configure Prime Infrastructure operations.
 
       	 [bookmark: pgfId-1085051]Admin—Allows users to monitor and configure Prime Infrastructure operations and perform all system administration tasks.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1085052]Note If you choose admin account and log in as such on the controller, you can also see the guest users under Local Net Admin.

      
      
 
     

     
 
      
       
       	 [bookmark: pgfId-1085053]SuperUsers—Allows users to monitor and configure Prime Infrastructure operations and perform all system administration tasks including administering Prime Infrastructure user accounts and passwords. Superusers tasks can be changed.
 
       	 [bookmark: pgfId-1085054]Users Assistant—Allows only local net user administration. User assistants cannot configure or monitor controllers. They must access the Configure > Controller page to configure these local net features. 
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1085055]Note If you create a user assistant user, log in as that user, and choose Monitor > Controller, you receive a “permission denied” message, which is an expected behavior.

      
      
 
     

     
 
      
       
       	 [bookmark: pgfId-1085056]Lobby Ambassador—Allows access for configuration and management of only Guest User user accounts.
 
       	 [bookmark: pgfId-1085057]Monitor lite—Allows monitoring of assets location.
 
       	 [bookmark: pgfId-1085058]Root—Allows users to monitor and configure Prime Infrastructure operations and perform all system administration tasks including changing any passwords. Only one user can be assigned to this group and is determined upon installation. It cannot be removed from the system, and no task changes can be made for this user.
 
      
 
     
 
      [bookmark: pgfId-1085059]Step 7[image: ] Click the name of the user group to which you assigned the new user account. The Group Detail >  User Group page shows a list of this permitted operations of the group.
 
      [bookmark: pgfId-1085060]From this page you can also show an audit trail of login and logout patterns or export a task list.
 
      [bookmark: pgfId-1085061]Step 8[image: ] Make any desired changes by selecting or unselecting the appropriate check boxes for task permissions and members.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085062]Note Any changes you make affect all members of this user group.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1085063]Note To view complete details in the Monitor > Client details page and to perform operations such as Radio Measurement, users in User Defined groups need permission for Monitor Clients, View Alerts & Events, Configure Controllers, and Client Location.

      
      
 
     

     
 
      [bookmark: pgfId-1085064]Step 9[image: ] Click  Submit to save your changes or  Cancel to leave the settings unchanged.
 
    
 
     
      [bookmark: pgfId-1085066][bookmark: 59927]Deleting Prime Infrastructure User Accounts
 
      [bookmark: pgfId-1085069]To delete a Prime Infrastructure user account, follow these steps:
 
     
 
      [bookmark: pgfId-1085072] Step 1[image: ] Start Prime Infrastructure server by following the instructions in the “Starting the Prime Infrastructure Server” section.
 
      [bookmark: pgfId-1085074]Step 2[image: ] Log into Prime Infrastructure user interface as a user assigned to the  SuperUsers group. 
 
      [bookmark: pgfId-1085075]Step 3[image: ] Choose  Administration > AAA .
 
      [bookmark: pgfId-1085076]Step 4[image: ] Choose  Users from the left sidebar menu to display the  Users page.
 
      [bookmark: pgfId-1085077]Step 5[image: ] Select the check box to the left of the user account(s) to be deleted.
 
      [bookmark: pgfId-1085078]Step 6[image: ] From the Select a command drop-down list, choose  Delete User(s) , and click  Go .
 
      [bookmark: pgfId-1085079]When prompted, click  OK to confirm your decision. The user account is deleted and can no longer be used.
 
    
 
     
      [bookmark: pgfId-1085082][bookmark: 28569]Changing Passwords
 
      [bookmark: pgfId-1085084]To change the password for a Prime Infrastructure user account, follow these steps:
 
     
 
      [bookmark: pgfId-1085087] Step 1[image: ] Start Prime Infrastructure server by following the instructions in the “Starting the Prime Infrastructure Server” section.
 
      [bookmark: pgfId-1085089]Step 2[image: ] Log into Prime Infrastructure user interface as a user assigned to the  SuperUsers group.
 
      [bookmark: pgfId-1085090]Step 3[image: ] Choose  Administration > AAA to display the  Change Password  page.
 
      [bookmark: pgfId-1085091]Step 4[image: ] Enter your old password.
 
      [bookmark: pgfId-1085092]Step 5[image: ] Enter the new password in both the New Password and Confirm New Password text boxes.
 
      [bookmark: pgfId-1085093]Step 6[image: ] Click  Save  to save your changes. The password for this user account has been changed and can be used immediately.
 
      [bookmark: pgfId-1100221]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1085095][bookmark: 39569]Viewing or Editing User Account Information
 
      [bookmark: pgfId-1085096]To see the group the user is assigned to or to adjust a password or group assignment for that user, follow these steps:
 
     
 
      [bookmark: pgfId-1085097] Step 1[image: ] Choose  Administration > AAA .
 
      [bookmark: pgfId-1085098]Step 2[image: ] From the left sidebar menu, choose  Users .
 
      [bookmark: pgfId-1085099]Step 3[image: ] Click a user in the User Name column. The User Detail :  User Group page appears.
 
      [bookmark: pgfId-1085100]You can see which group is assigned to this user or change a password or group assignment.
 
      [bookmark: pgfId-1100230]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1085102][bookmark: 63868]Adding a New User
 
      [bookmark: pgfId-1085103]The Add User page allows the administrator to set up a new user login including username, password, groups assigned to the user, and virtual domains for the user.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085104]Note You can only assign virtual domains to a newly created user which you own. By assigning virtual domains to a user, the user is restricted to information applicable to those virtual domains.

      
      
 
     

     
 
      [bookmark: pgfId-1085105]This section contains the following topics:
 
      
      	 [bookmark: pgfId-1085109]Adding User Names, Passwords, and Groups
 
      	 [bookmark: pgfId-1085113]Assigning a Virtual Domain
 
     
 
    
 
     
      [bookmark: pgfId-1085116][bookmark: 25415]Adding User Names, Passwords, and Groups
 
      [bookmark: pgfId-1085117]To add a new user, follow these steps:
 
     
 
      [bookmark: pgfId-1085118] Step 1[image: ] Choose  Administration > AAA .
 
      [bookmark: pgfId-1085119]Step 2[image: ] From the left sidebar menu, choose  Users .
 
      [bookmark: pgfId-1085120]Step 3[image: ] From the Select a command drop-down list, choose  Add User .
 
      [bookmark: pgfId-1085121]Step 4[image: ] Click  Go . The Users page appears.
 
      [bookmark: pgfId-1085122]Step 5[image: ] Enter a new  Username .
 
      [bookmark: pgfId-1085123]Step 6[image: ] Enter and confirm a password for this account.
 
      [bookmark: pgfId-1085124]Step 7[image: ] Select the check box(es) of the groups to which this user is assigned.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085125]Note If the user belongs to Lobby Ambassador, Monitor Lite, Northbound API, or Users Assistant group, the user cannot belong to any other group.

      
      
 
     

     
 
      
       
       	 [bookmark: pgfId-1085126]Admin—Allows users to monitor and configure Prime Infrastructure operations and perform all system administration tasks.
 
       	 [bookmark: pgfId-1085127]ConfigManagers—Allows users to monitor and configure Prime Infrastructure operations.
 
       	 [bookmark: pgfId-1085128]System Monitoring—Allows users to monitor Prime Infrastructure operations.
 
       	 [bookmark: pgfId-1085129]Users Assistant—Allows local net user administration only.
 
       	 [bookmark: pgfId-1085130]Lobby Ambassador—Allows guest access for configuration and management only of user accounts. If Lobby Ambassador is selected, a Lobby Ambassador Defaults tab appears. 
 
       	 [bookmark: pgfId-1085131]Monitor Lite—Allows monitoring of assets location.
 
       	 [bookmark: pgfId-1085132]North Bound API User—A user group used by Prime Infrastructure Web Service consumers. That is, any North Bound APIs.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1085134]Note If you are creating a North Bound API user from TACACS or RADIUS, the default user domain should be root.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1085135]Note North Bound API Users cannot be assigned a Virtual Domain. When a North Bound API group is selected, the Virtual Domains tab is not available.

      
      
 
     

     
 
      
       
       	 [bookmark: pgfId-1085136]SuperUsers—Allows users to monitor and configure Prime Infrastructure operations and perform all system administration tasks including administering Prime Infrastructure user accounts and passwords. Superuser tasks can be changed.
 
       	 [bookmark: pgfId-1085137]Root—This group is only assignable to 'root' user and that assignment cannot be changed. 
 
       	 [bookmark: pgfId-1085138]User Defined.
 
      
 
     
 
      [bookmark: pgfId-1085139]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1085143][bookmark: 25614]Assigning a Virtual Domain
 
      [bookmark: pgfId-1085145]To assign a [bookmark: marker-1085144]virtual domain to this user, follow these steps:
 
     
 
      [bookmark: pgfId-1085146] Step 1[image: ] Click the  Virtual Domains tab. This tab displays all virtual domains available and assigned to this user.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085147]Note The Virtual Domains tab enables the administrator to assign virtual domains for each user. By assigning virtual domains to a user, the user is restricted to information applicable to those virtual domains.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1085148]Note North Bound API Users cannot be assigned a Virtual Domain. When a North Bound API group is selected, the Virtual Domains tab is not available.

      
      
 
     

     
 
      [bookmark: pgfId-1085149]Step 2[image: ] Click to highlight the virtual domain in the Available Virtual Domains list that you want to assign to this user.
 
      
       
     
 
     
 
     [bookmark: pgfId-1085150]Note You can select more than one virtual domain by holding down the Shift or Control key.

      
      
 
     

     
 
      [bookmark: pgfId-1085151]Step 3[image: ] Click  Add > . The virtual domain moves from the Available Virtual Domains to the Selected Virtual Domains list.
 
      [bookmark: pgfId-1085152]To remove a virtual domain from the Selected Virtual Domains list, click to highlight the domain in the Selected Virtual Domains list, and click  Remove . The virtual domain moves from the Selected Virtual Domains to the Available Virtual Domains list.
 
      [bookmark: pgfId-1085153]Step 4[image: ] Click  Submit to save the changes or  Cancel to close the page without adding or editing the current user.
 
      [bookmark: pgfId-1085154]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1085157][bookmark: 60288]Logging into CMX Analytics User Interface
 
     [bookmark: pgfId-1085158]To log into CMX analytics user interface through a web browser, follow these steps:
 
    
 
     [bookmark: pgfId-1085159] Step 1[image: ] In the address line of browser, enter https://mse-ip-address/ui/, where mse-ip-address is the IP address of the CMX analytics server. CMX analytics user interface displays the User Login page.
 
     [bookmark: pgfId-1085160]Step 2[image: ] Enter your username.
 
     [bookmark: pgfId-1085161]Step 3[image: ] Enter your password.
 
     [bookmark: pgfId-1085162]Step 4[image: ] Click Login to log into CMX analytics. 
 
     [bookmark: pgfId-1085163]The CMX analytics home page appears.
 
     [bookmark: pgfId-1085164]

     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1085166][bookmark: 66175]WebGL Requirements
 
     [bookmark: pgfId-1085167]The CMX analytics in Release 7.4 and 7.5 provides ability to view the analytic results in both 2D (Open Street Maps) and 3D (WebGL) environments. This provides improved understanding of results on multiple floor paths, or when dwell times are calculated throughout a multi-storey building. The 3D environment presents the same information as the 2D environment. 
 
     [bookmark: pgfId-1096457]WebGL is an advanced feature that provides graphic capabilities. All browsers do not support WebGL on a particular hardware. Verify your browser compatibility at the following URL:  http://get.webgl.org/.  If your browser supports WebGL, then you must see a spinning cube. 
 
     [bookmark: pgfId-1085170]If your browser does not support WebGL, you must do the following:
 
     
     	 [bookmark: pgfId-1085171]Update your latest drivers for video card.
 
     	 [bookmark: pgfId-1085172]For Google Chrome, follow the instructions given in the Google Chrome support website.
 
     	 [bookmark: pgfId-1085174]For Firefox, follow these steps to enable WebGL:
 
    
 
     [bookmark: pgfId-1085175]–[image: ] In the browser address line, enter about:config
 
     [bookmark: pgfId-1085176]–[image: ] In the Search text box, enter webgl to filter the settings.
 
     [bookmark: pgfId-1085177]–[image: ] Double click webgl.forceenabled.
 
     [bookmark: pgfId-1085178]–[image: ] Make sure that webgl.disables is disabled.
 
     
     	 [bookmark: pgfId-1085179]For Safari, follow these steps to enable WebGL:
 
    
 
     [bookmark: pgfId-1085180]–[image: ] Download the latest building of Safari browser.
 
     [bookmark: pgfId-1085181]–[image: ] You must enable the Develop menu and enable the WebGL.
 
     [bookmark: pgfId-1085182]–[image: ] To enable Develop menu, choose Safari > Preferences.
 
     [bookmark: pgfId-1085183]–[image: ] Click the Advanced tab.
 
     [bookmark: pgfId-1085184]–[image: ] Select the Show Develop menu in menu bar check box.
 
     [bookmark: pgfId-1085185]–[image: ] Choose Enable WebGL from the Develop menu.
 
     
      
    
 
    
 
    [bookmark: pgfId-1085186]Note If your system does not support 3D, then the analytic results are displayed only in 2D Open Street Maps view.

     
     
 
    

    
 
     
     	 [bookmark: pgfId-1085188]Internet Explorer 10 does not have the built-in support for WebGL and Microsoft has not announced any plans for implementing it in the future. WebGL support can be manually added to Internet Explorer using third-party plugins such as Chrome-frame.
 
    
 
   
 
    
     [bookmark: pgfId-1086708][bookmark: 23405]Validating Analytics
 
     [bookmark: pgfId-1086713]After installing the analytics, you need to validate the results and ensure that the correct data is coming.
 
    
 
     [bookmark: pgfId-1086715] Step 1[image: ] Look at the date to see how much data is in the Analytics database. When the analytics starts for the first time, it downloads the previous three days data by default if it is available. This may take several hours if there is a lot of data stored in the MSE. Therefore, you should see the current data appearing after an hour or so.
 
     [bookmark: pgfId-1086919]Figure 2-4 
 
     
     [image: ] 
    
 
     [bookmark: pgfId-1086798]Step 2[image: ] Next check that the point data coming in is reflecting where in the building it is expected. Using the Heatmap option this show areas of high and low density of points. First, these points should be in locations where you can expect visitors and secondly they should reflect areas where high and low traffic is expected.
 
     [bookmark: pgfId-1086801]Step 3[image: ] Press the run button and this should carry out a typical location analysis for today across the whole building. Here we check that the distribution of device icons show areas where it is expected most/least people visited for the whole day. This check can be further refined by limiting the zones or time window.
 
     [bookmark: pgfId-1086769]Figure 2-5 Distribution of Devices across the Floor
 
     
     [image: ] 
    
 
     [bookmark: pgfId-1086742]Equally, we can validate areas where people spend more time than others, such as reception, restaurants, etc.
 
     [bookmark: pgfId-1086815]Figure 2-6 More Time Spend in Certain Areas
 
     
     [image: ] 
    
 
     [bookmark: pgfId-1086802]Step 4[image: ] Running the Snapshot report is a way to validate that the distribution of devices across the building at any one time is consistent and for any one zone how it changes during the day.
 
     [bookmark: pgfId-1086827]Figure 2-7 Numbers of Devices Across one Building
 
     
     [image: ] 
    
 
     [bookmark: pgfId-1086864]Figure 2-8 Numbers of Devices Across one Building at a Different Time Window
 
     
     [image: ] 
    
 
     [bookmark: pgfId-1086851]Step 5[image: ] These initial first validation steps will ensure that the data is making sense. Use the Rules at the left hand side to further focus in on certain time periods or zones where you know the number and type of visitors. Remember through that we are dealing with devices rather than actual people and so a conversion will need to be made.
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1054548]Licensing Requirement for CMX Analytics Service
      
      
 
     
 
 
     [bookmark: pgfId-1054549]Advanced Location service is introduced in Release 7.4 and it includes CMX analytics service and Mobile Concierge service. From Release 7.4, AP based licensing is supported for location and advanced location services. To accommodate this, new L-LS-licenses are introduced in Release 7.4.
 
     [bookmark: pgfId-1054550]Cisco MSE 3355 supports up to 500 access points for Cisco MSE Location Services or Advanced Location Services. The Cisco MSE virtual appliance supports up to 1,000 access points, depending on the server resources.
 
     [bookmark: pgfId-1054551]There is no change to endpoint support and MSE 3355 supports 25,000 and high end virtual appliance supports 50000. All licenses are additive.
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1058339]CMX Analytics Home Page Components
      
      
 
     
 
 
     [bookmark: pgfId-1058340]The CMX Analytics user interface allows you to analyze the wireless devices location information using different analysis technique.
 
     [bookmark: pgfId-1058341]Log into the CMX Analytics user interface with your username and password. The following figure shows the CMX Analytics User Login page.
 
     [bookmark: pgfId-1058345]Figure 4-1 CMX Analytics User Login Page
 
     
     [image: ] 
    
 
     [bookmark: pgfId-1058346]After logging in, the CMX Analytics home page appears.
 
     [bookmark: pgfId-1058350]Figure 4-2 CMX Analytics Home Page
 
     
     [image: ] 
    
 
     [bookmark: pgfId-1058351]The CMX Analytics home page contains the following:
 
     
     	 [bookmark: pgfId-1058352]Left Pane
 
    
 
     [bookmark: pgfId-1058356]–[image: ] 3D Analytics Tab
 
     [bookmark: pgfId-1058360]–[image: ] 2D Analytics tab
 
     [bookmark: pgfId-1058364]–[image: ] Reporting tab
 
     [bookmark: pgfId-1058368]–[image: ] Rules Group Box
 
     [bookmark: pgfId-1058372]–[image: ] Analysis Group Box
 
     
     	 [bookmark: pgfId-1058375]Right Pane
 
    
 
     [bookmark: pgfId-1058379]–[image: ] Visualization Pane
 
     [bookmark: pgfId-1058383]–[image: ] Auxiliary Information Window
 
     
      [bookmark: pgfId-1058385][bookmark: 93047]3D Analytics Tab
 
      [bookmark: pgfId-1058927]The CMX analytics system provides the ability to view analytics results in 3D environment. This provides a better understanding of results on multiple floor paths or when the dwell time is calculated for the multi-storey building.
 
      [bookmark: pgfId-1058387]This section contains the following topics:
 
      
      	 [bookmark: pgfId-1058391]Prerequisites for Viewing CMX Analytics in 3D
 
      	 [bookmark: pgfId-1058395]Viewing Analytics in the 3D Environment
 
     
 
    
 
     
      [bookmark: pgfId-1060127][bookmark: 44488]Prerequisites for Viewing CMX Analytics in 3D
 
      
      	 [bookmark: pgfId-1060131]Set up the CMX analytics system. See the  Process for Setting up the CMX analytics System  for more information.
 
      	 [bookmark: pgfId-1058407]The CMX analytics supports a 3D representation of analytics using the WebGL. See the WebGL Requirements for information on compatible browsers.
 
     
 
    
 
     
      [bookmark: pgfId-1058413][bookmark: 48755]Viewing Analytics in the 3D Environment
 
      [bookmark: pgfId-1058935]To view the analytics results in the 3D environment, follow these steps:
 
     
 
      [bookmark: pgfId-1058936] Step 1[image: ] In the Rules group box, you can establish specific devices that you want to analyze. For information on Rules parameters, see the Rules Group Box.
 
      [bookmark: pgfId-1058940]Step 2[image: ] In the Analysis group box, you can perform different analysis on devices that passes through a building or environment. See the Typical Locations, Most Popular Paths Analysis, Alternative Path Analysis, and Heat Maps for more information on analysis.
 
      [bookmark: pgfId-1058947]Step 3[image: ] Click Run.
 
      [bookmark: pgfId-1058948]Step 4[image: ] Click 3D Analytics to view the results in the 3D environment.
 
      [bookmark: pgfId-1058949]The results are displayed in the right pane.
 
      [bookmark: pgfId-1058429]Step 5[image: ] Click the Navigation buttons available in the Auxiliary Information window to see different overlays of the building and also different views of the floors. The 3D environment provides the ability to switch on/off floors and zones.
 
      [bookmark: pgfId-1058430]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058432][bookmark: 58155]2D Analytics tab
 
      [bookmark: pgfId-1059380]The CMX analytics provides the ability to view the analytic results in 2D. The 2D environment is primarily for outdoor visualization such as analyzing the open space or placing the building in its geographical context. This section contains the Viewing Analytics in 2D Environment..
 
    
 
     
      [bookmark: pgfId-1058438][bookmark: 99062]Viewing Analytics in 2D Environment.
 
      [bookmark: pgfId-1058966]To view the analytics results in the 2D environment, follow these steps:
 
     
 
      [bookmark: pgfId-1058967] Step 1[image: ] In the Rules group box, you can establish specific devices that you want to analyze. For information on Rules parameters, see Rules Group Box.
 
      [bookmark: pgfId-1058971]Step 2[image: ] In the Analysis group box, you can perform different analysis on devices that passes through a building or environment. In order to perform different analysis, see Typical Locations, Most Popular Paths Analysis, Alternative Path Analysis, Heat Maps
 
      [bookmark: pgfId-1058978]Step 3[image: ] Click Run.
 
      [bookmark: pgfId-1058979]Step 4[image: ] Click 2D Analytics to view the results in the 2D environment.
 
      [bookmark: pgfId-1058980]The result is displayed in the right pane.
 
      [bookmark: pgfId-1058993]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1058455][bookmark: 66303]Rules Group Box
 
     [bookmark: pgfId-1058456]The Rules group box allows you to identify the specific set of devices to which the analytics have to be applied.
 
     [bookmark: pgfId-1058457]The Rules group box displays the following:
 
     
     	 [bookmark: pgfId-1058458]Date/Time—The Date/Time rule allows you to select a specific date or range of dates and time or time period for which you want the analytics to be applied. Click the black inverted triangle icon located at the right of the Date/Time to see all available dates and configure date and time.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1058459]Note The date selector allows you to select only those dates for which there is some data available in the analytics database.

     
     
 
    

    
 
     [bookmark: pgfId-1058460]Select the Date check box to enable the Date and click the Date text box to open the calendar and to perform the following:
 
     [bookmark: pgfId-1058461]–[image: ] Specific Date—Click the blue inverted triangle icon located next to the Specific Date to open the Specific Date calendar and choose a specific date that you want to be considered for analysis.
 
     [bookmark: pgfId-1058462]–[image: ] All Dates On or Before—Click the blue inverted triangle icon located next to All Dates On or Before to open the calendar and choose a date. All dates before the selected date are considered for analysis.
 
     [bookmark: pgfId-1058463]–[image: ] All Dates On or After—Click the blue inverted triangle icon located next to All Dates On or After to open the calendar and choose a date. All dates after the selected date are considered for analysis.
 
     [bookmark: pgfId-1058464]–[image: ] Date Range—Click the blue inverted triangle icon located next to the date range to open the calenar and choose the start date and end date. The analytics will be applied between the selected Start Date and End Date.
 
     
      
    
 
    
 
    [bookmark: pgfId-1059318]Note Only those paths that are within the time period is considered for analysis. For example, if the time period is between 6 AM to 4 PM, then only paths that start after 6 AM and finishes before 4 PM are considered for analysis.

     
     
 
    

    
 
     [bookmark: pgfId-1059256]Select the Time check box to enable the Time and perform the following:
 
     [bookmark: pgfId-1059270]–[image: ] Time Before—If you select this option, all times before the selected time are considered for analysis
 
     [bookmark: pgfId-1059274]–[image: ] Time After —If you select this option, all times after the selected time is considered for analysis
 
     [bookmark: pgfId-1059279]–[image: ] Time Between—If you select this option, all times between the selected Start Time and End Time are considered for analysis.
 
     
     	 [bookmark: pgfId-1058465]Zones—Click the black inverted triangle icon located at the right of the Zones to configure the following:
 
    
 
     [bookmark: pgfId-1058466]–[image: ] Restrict to Zones—Select the Restrict to Zones check box and choose one or multiple zones from Restrict to Zones drop-down list to restrict your analysis to selected zones. If want to analyze only certain part of the building, then information about the selected part is displayed.
 
     
      
    
 
    
 
    [bookmark: pgfId-1058467]Note Zones are defined as coverage areas in the Prime Infrastructure.

     
     
 
    

    
 
     
     	 [bookmark: pgfId-1058468]Filters—Click the black inverted triangle icon located at the right of the Filters to configure the following constraints on the points with different dwell time.
 
     	 [bookmark: pgfId-1059431]Location Filters—Location filters allows you to select points for which you know the dwell times. This comes about when multiple points are detected in the same close proximity. These points are replaced by a single one and the dwell time attached to it is the elapsed duration between first and last point.
 
     	 [bookmark: pgfId-1059445]Path Filters—Path filters allows you to select the data for analysis based on quantitative constraints on paths. The different quantitative constraints that you can use on paths from the Path Filters are:
 
    
 
     [bookmark: pgfId-1058470]–[image: ] Length—Length restricts the analysis to those paths within the sum of the straight line distances between the points.
 
     [bookmark: pgfId-1059502]–[image: ] Duration—Duration restricts the analysis to the total duration between the first and the last time points on the path.
 
     [bookmark: pgfId-1059505]–[image: ] Hops—Hops is the measure of the number of location observations made on that path.
 
     
     	 [bookmark: pgfId-1058473]Path—Click the black inverted triangle icon located at the right of the Path to open the Path window. This allows you to select those devices that have followed a particular path through the predefined zones for analysis. The options are:
 
    
 
     [bookmark: pgfId-1058474]–[image: ] Starts In—Select the zone where the wireless device was first detected from the Starts In drop-down list.
 
     [bookmark: pgfId-1058475]–[image: ] Visits—Select the intermediate zone through which the device passes through from the Visits drop-down list.
 
     [bookmark: pgfId-1058476]–[image: ] Ends In—Select the zone where the device was last detected from the Ends In drop-down list.
 
     
     	 [bookmark: pgfId-1059675]Tags—Click the black inverted triangle icon located at the right of the Tag to open the Tag window. Tags are additional labels that can be associated to point, paths, and devices. This allows you to describe the choices of devices based on characteristics such as manufacturer, associate/probing etc.
 
    
 
     
      [bookmark: pgfId-1059413]Rulesets
 
      [bookmark: pgfId-1059419]Rulesets are packaged set of rules that can be saved, stored, and reused when you require them. This allows frequently used groups of conditions to be saved for repeated application.
 
      
      	 [bookmark: pgfId-1058480]Click 
 
      [image: ] to load a rule set. This option allows you to load the predefined rules. You can create a number of different rules and load them. A number of rules together creates a ruleset. 
     
 
      
      	 [bookmark: pgfId-1058484]Click 
 
      [image: ] to save the rule set. After creating rules, you can save them and load the rule when you require them.
     
 
    
 
     
      [bookmark: pgfId-1058487][bookmark: 10113]Analysis Group Box
 
      [bookmark: pgfId-1058488]The Analysis group box allows you to perform different analysis on devices that pass through a building or environment. The Analysis group box displays the following:
 
      
      	 [bookmark: pgfId-1058823]Type—Select the type of analyses you can perform from the Type drop-down list.
 
     
 
      [bookmark: pgfId-1058826]–[image: ] Typical Locations—For more information on Typical Locations, see Typical Locations.
 
      [bookmark: pgfId-1059172]–[image: ] Most Popular Paths—For more information on Most popular path analysis, see the Most Popular Paths Analysis.
 
      [bookmark: pgfId-1059176]–[image: ] Alternate Path Analysis—For more information on alternate path analysis, see the Alternative Path Analysis.
 
      [bookmark: pgfId-1058497]–[image: ] Heat Maps—For more information on heat maps, see the Heat Maps.
 
      
      	 [bookmark: pgfId-1059520]Advanced—Click the black inverted triangle icon to perform additional configuration for the analysis. The Advanced option is avialable only for Typical Locations and Most Popular Path analysis. If you select Typical locations as the analysis type, then the following is displayed:
 
     
 
      [bookmark: pgfId-1059766]–[image: ] Number of Locations—Enter the number of locations that you want to include in the analysis. A large number of locations for Typical location analysis results in a dense concentration of markers across an area.
 
      [bookmark: pgfId-1059745]–[image: ] Optimal—Select this check box if you want the number of locations to be determined mathematically according to which best represents the distribution of points found in the building.
 
      [bookmark: pgfId-1059774]If you select Most Popular path analysis from the Type drop-down list, then the following is displayed:
 
      [bookmark: pgfId-1059781]–[image: ] Number of Paths—Enter the number of popular paths that you want to include in the analysis.
 
      [bookmark: pgfId-1059799]–[image: ] Method—The possible options are Actual and Markers. The Actual method displays every point on the path. The markers method eliminates close points being displayed. The default for common paths is that there are a fixed number of predefined points that the path can go through. The purpose of this method is to reduce the numer of visible nodes, by essentially combining nodes close together to make it more readable.
 
      
       
     
 
     
 
     [bookmark: pgfId-1059521]Note The Advanced option depends on the initial type of analysis that you have chosen.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1058506][bookmark: 62964]Reporting tab
 
      [bookmark: pgfId-1059568]The CMX analytics reporting is necessary to monitor common behavioral patterns over time. A number of reports can be generated and it provides more zone oriented analysis on the patterns of behavior in different zones of the building as well as movements throughout the building. See the Reports section for more information.
 
    
 
     
      [bookmark: pgfId-1058512][bookmark: 10018]Visualization Pane
 
      [bookmark: pgfId-1058513]You can view the following in the visualization pane:
 
      
      	 [bookmark: pgfId-1058514]Analytics results in 2D or 3D environment.
 
      	 [bookmark: pgfId-1058515]Report results in the visualization pane.
 
     
 
    
 
     
      [bookmark: pgfId-1058517][bookmark: 31849]Auxiliary Information Window
 
      [bookmark: pgfId-1058311]You can access the Auxiliary Information window at the top right corner of the page. The auxiliary information window provides access to the 2D and 3D navigation and visible overlays on the building or area when you are in the 3D or 2D environment. Click icon in the right pane and choose the additional information on the building or area for analysis. You can include additional information like switching floors on/off, layout of access points, and zones.
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1054567]Information About Analysis
      
      
 
     
 
 
     [bookmark: pgfId-1054568]This chapter describes the different types of analysis that you can perform on devices in a building or environment. You can perform the following four types of analysis:
 
     
     	 [bookmark: pgfId-1058314] Typical Locations 
 
     	 [bookmark: pgfId-1058331] Most Popular Paths Analysis 
 
     	 [bookmark: pgfId-1058335] Alternative Path Analysis 
 
     	 [bookmark: pgfId-1058339] Heat Maps 
 
    
 
   
 
    
     [bookmark: pgfId-1054578][bookmark: 19576]Typical Locations
 
     [bookmark: pgfId-1054579]The typical location analysis determines different areas of the building and measures the behavior of people within them. The location analysis is a way of segmenting all points detected into representative areas on which parameters are calculated.
 
     [bookmark: pgfId-1057054]The location analysis process starts by clustering all devices into areas determined by the geographical layout of observations. Each point is allocated to a particular area and each area is represented by a center point. Once the set of areas are established, all parameters associated with each area are calculated, that reflects the movement of people in that part of the building.
 
     [bookmark: pgfId-1054581]The result of carrying out a location analysis is a set of areas represented by center points indicating the spread of points over the Wi-Fi detected area.
 
     [bookmark: pgfId-1054582]Areas and Zones
 
     [bookmark: pgfId-1054583]The concept of areas and zones are different but they work together. You need to consider the following while defining areas and zones:
 
     
     	 [bookmark: pgfId-1054584]Zone is a user-defined space with a name and it is used for reporting or for path rule purposes. The zones can be overlapping and need not cover the entire building, although every floor is also a zone.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1058500]Note Zones correspond to the coverage areas in the Prime Infrastructure.

     
     
 
    

    
 
     
     	 [bookmark: pgfId-1054586]Areas are defined by mathematical clustering on the detected Wi-Fi based locations.
 
     	 [bookmark: pgfId-1054587]Cluster areas are used when there is no known zones established or to ensure that all parts of the location space are accounted for. 
 
     	 [bookmark: pgfId-1054588]Each area is associated with a set of behavior parameters that are represented by icons.
 
    
 
     [bookmark: pgfId-1054589]There following are the different behavior measurements:
 
     
     	 [bookmark: pgfId-1054590]Dwell Time— Dwell time or wait time is an estimate of the time, that a person is spending in an area as they move through the building.
 
     	 [bookmark: pgfId-1054593]Crowding— Crowding is measured by the density of people within a particular area over a time period.
 
     	 [bookmark: pgfId-1054594]Number of devices—This shows the number of unique MAC addresses identified in a particular area and is defined based on filtered conditions.
 
    
 
     
      [bookmark: pgfId-1059736]Analyzing Areas of the Building Using the Typical Locations Analysis
 
      [bookmark: pgfId-1059737]To analyze different areas of the building using the most popular paths analysis, follow these steps:
 
     
 
      [bookmark: pgfId-1059738] Step 1[image: ] In the Analysis group box, do the following:
 
      
      	 [bookmark: pgfId-1061883]From the Building drop-down list, select the building where you want to conduct this analysis.
 
      	 [bookmark: pgfId-1061898]From the Type drop-down list, choose Typical locations.
 
      	 [bookmark: pgfId-1059740]Click the black inverted triangle icon located at the right of the Advanced option to configure the number of paths that you want to include in the analysis.
 
     
 
      [bookmark: pgfId-1059812]–[image: ] Enter the number of typical locations that you want to consider for analysis in the Number of Locations text box.
 
      [bookmark: pgfId-1059857]–[image: ] Select the Optimal check box to instruct the system to find the best number of locations for analysis.
 
      [bookmark: pgfId-1059746]Step 2[image: ] You can apply the parameterized rules to your analysis from the Rules group box. See Rules Group Box for more information.box.
 
      [bookmark: pgfId-1059748]Step 3[image: ] Click Run.
 
      [bookmark: pgfId-1059749]Step 4[image: ] Click 3D Analytics to view the results in 3D environment or 2D to view the results in 2D environment.
 
      [bookmark: pgfId-1060420]The following figure shows the density of people within a partucular area.
 
      [bookmark: pgfId-1060424]Figure 5-1 Density of People Within a Particular Area
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1060425]The following figure shows the distribution of median dwell times in the 2D map.
 
      [bookmark: pgfId-1060429]Figure 5-2 Distribution of Median Dwell Times
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1060430]The following information is displayed when you click a particular node:
 
      
      	 [bookmark: pgfId-1060431]Zones
 
      	 [bookmark: pgfId-1060432]Crowding Index
 
      	 [bookmark: pgfId-1060433]Median Dwell time
 
      	 [bookmark: pgfId-1060434]Median absolute deviation
 
      	 [bookmark: pgfId-1060435]Number of devices
 
      	 [bookmark: pgfId-1060436]As % of all filtered devices
 
      	 [bookmark: pgfId-1060437]No of visits
 
      	 [bookmark: pgfId-1060438]Number of points
 
      	 [bookmark: pgfId-1060476]Current analysis
 
     
 
      [bookmark: pgfId-1060574]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1059419][bookmark: 47586]Most Popular Paths Analysis
 
     [bookmark: pgfId-1059410]The most popular paths analysis analyses the behavior of devices or people as they move through the building. This analysis provides you with a set of typical paths taken by the devices on a particular day and time.
 
     [bookmark: pgfId-1057306]This analysis is carried out using the mathematical path clustering technique, that aggregates the paths into sets which are equivalent. Each resulting set is represented by an actual path and is shown graphically by a set of observed points linked by a straight line. The clustering allows you to identify the common routes that people usually take.
 
     
      
    
 
    
 
    [bookmark: pgfId-1060847]Note The CMX analytics application has a limit on the size of images that it can handle. This depends on the hardware, browser, and the device drivers present on your machine. Sometimes black floor plans are shown in the 3D environment. Google chrome on PC and Firefox on MAC seem most resilient. For better performance, keep the image files as small as necessary.

     
     
 
    

    
 
     
      [bookmark: pgfId-1057557]Analyzing Areas of the Building Using the Most Popular Paths Analysis
 
      [bookmark: pgfId-1057558]To analyze different areas of the building using the most popular paths analysis, follow these steps:
 
     
 
      [bookmark: pgfId-1057559] Step 1[image: ] In the Analysis group box, do the following:
 
      
      	 [bookmark: pgfId-1057560]From the Building drop-down list, select the building where you want to conduct this analysis.
 
      	 [bookmark: pgfId-1061931]From the Type drop-down list, choose Most Popular paths.
 
      	 [bookmark: pgfId-1057561]Click the black inverted triangle icon located at the right of the Advanced option to configure the number of paths that you want to include in the analysis.
 
     
 
      [bookmark: pgfId-1057562]–[image: ] Enter the number of paths that you want to display in the analysis results in the Number of Paths text box.
 
      [bookmark: pgfId-1057563]–[image: ] From the Method drop-down list, choose the method that you want to represent the paths before selecting the most popular path. The possible values are Markers and Actual.
 
      [bookmark: pgfId-1057567]Step 2[image: ] You can apply the parameterized rules to your analysis from the Rules group box. See Rules Group Box for more information.
 
      [bookmark: pgfId-1057569]Step 3[image: ] Click Run.
 
      [bookmark: pgfId-1057570]Step 4[image: ] Click 3D Analytics to view the results in 3D environment or 2D to view the results in 2D environment.
 
      [bookmark: pgfId-1057550]The most popular path presents you with a set of paths taken and the parameters associated with them in the right pane.
 
      [bookmark: pgfId-1061007]The following figure shows the third most popular paths across a shopping mall on a particular day and time in the 2D environment.
 
      [bookmark: pgfId-1061011]Figure 5-3 Most Popular Path Across One Floor in 2D Environment
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1061012]The following figure shows the most popular path between floors.
 
      [bookmark: pgfId-1061016]Figure 5-4 Most Popular Path Between Floors
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1061017]To obtain information associated with the parameter, click the node or use the location selector from the Auxiliary Information window. The following information is displayed when you click a particular node:
 
      
      	 [bookmark: pgfId-1061018]Number of paths in the cluster
 
      	 [bookmark: pgfId-1061019]Overall distance travelled
 
      	 [bookmark: pgfId-1061020]Number of point observations recorded along the path
 
      	 [bookmark: pgfId-1061021]Time took to complete the particular path
 
      	 [bookmark: pgfId-1061022]Average speed along the path (km/hr)
 
      	 [bookmark: pgfId-1061023]Date and time of the first and the last recorded point on the path
 
     
 
      [bookmark: pgfId-1061024]The following are the parameters displayed for a particular point:
 
      
      	 [bookmark: pgfId-1061025]Arrival date and time
 
      	 [bookmark: pgfId-1061026]Zones located within
 
      	 [bookmark: pgfId-1061027]Any tags associated with this point
 
     
 
      [bookmark: pgfId-1061028]The following are the parameters displayed for a particular edge:
 
      
      	 [bookmark: pgfId-1061029]Crow-files distance between the two points it joins
 
      	 [bookmark: pgfId-1061030]Difference in time between two points
 
      	 [bookmark: pgfId-1061054]Estimated speed between the two points
 
     
 
      [bookmark: pgfId-1057703]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1057704][bookmark: 55893]Alternative Path Analysis 
 
     [bookmark: pgfId-1057705]The alternative path analysis allows you to determine the device flow between different areas in the building. It shows a break down of the percentage of devices going to each destinations for each starting point and vice versa. If a device visits multiple destinations after visiting a starting point, then only the first one is considered for the analysis.
 
     [bookmark: pgfId-1061182]This analysis helps you to understand the different paths that people take while leaving one point to go to another point. It also allows you to set up arbitrary areas and estimate the time it takes to move between those areas. This analysis starts by identifying all paths passing within a certain radius of a circle whose center is the source point. 
 
     
      [bookmark: pgfId-1060122]Analyzing Areas of the Building Using the Alternative Path Analysis
 
      [bookmark: pgfId-1060061]To analyze different areas of the building using the alternative path analysis, follow these steps:
 
     
 
      [bookmark: pgfId-1060062] Step 1[image: ] In the Analysis group box, do the following:
 
      
      	 [bookmark: pgfId-1060063]From the Type drop-down list, choose Alternative Path Analysis.
 
      	 [bookmark: pgfId-1060067]From the Building drop-down list, choose the building that you want to consider for analysis.
 
     
 
      [bookmark: pgfId-1060070]Step 2[image: ] You can apply the parameterized rules to your analysis from the Rules group box. See Rules Group Box for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1061249]Note In order to run alternative path analysis, you need to define both starting point and destination points. You can define these points by clicking the map or building. 

      
      
 
     

     
 
      [bookmark: pgfId-1061240]Step 3[image: ] In the Auxiliary Information window, do the following to define the starting and destination points:
 
      
      	 [bookmark: pgfId-1061253]From the Floor drop-down list, choose the floor on which you want to define the starting and destination points.
 
      	 [bookmark: pgfId-1061274]Enter the radius in the Radius text box. The radius specifies the catchment area of each point. The device should pass through the catchment area to be considered for analysis.
 
      	 [bookmark: pgfId-1061279]Select the Start radio button and click the map to place the starting point.
 
      	 [bookmark: pgfId-1061283]Select the Destination radio button and click the map to place the destination point.
 
     
 
      [bookmark: pgfId-1060072]Step 4[image: ] Click Run.
 
      [bookmark: pgfId-1060073]Step 5[image: ] Click 3D Analytics to view the results in 3D environment or 2D to view the results in 2D environment.
 
      [bookmark: pgfId-1058258]The alternative path presents you with a set of paths taken and the parameters associated with them in the right pane.
 
      [bookmark: pgfId-1061118]The following figure has three points that are placed across the building. There is one source node and two possible destination nodes.
 
      [bookmark: pgfId-1061122]Figure 5-5 Specifying Beacon Points for Alternative Path Analysis
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1061128]Figure 5-6 Alternative Path Analysis in 3D
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1061129]
 
      [bookmark: pgfId-1061134]The following information is displayed when you click a particular node to show the distribution of durations and speeds:
 
      
      	 [bookmark: pgfId-1061135]Node ID
 
      	 [bookmark: pgfId-1061136]Radius
 
      	 [bookmark: pgfId-1061137]Numbe of devices filtered
 
      	 [bookmark: pgfId-1061138]Number of filtered devices passing start location
 
      	 [bookmark: pgfId-1061139]Number of those devices not passing any target
 
      	 [bookmark: pgfId-1061140]Target
 
      	 [bookmark: pgfId-1061141]Number Devices
 
      	 [bookmark: pgfId-1061142]Percentage
 
      	 [bookmark: pgfId-1061143]Median Duration (min)
 
      	 [bookmark: pgfId-1061144]Median Speed (km/hr)
 
      	 [bookmark: pgfId-1061160]Level
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1057881][bookmark: 26535]Heat Maps 
 
     [bookmark: pgfId-1059567]The heat map is a graphical representation of data and allows you to view all selected data on the map. The areas where there is a greater presence of data is represented in darker colors. These patterns help to indicate the real coverage of the access points across a region.
 
     
      [bookmark: pgfId-1061467]Analyzing the Traffic For Each Floor Using the Heat Maps Analysis
 
      [bookmark: pgfId-1061468]To analyze the traffic for each floor using the heat maps analysis, follow these steps:
 
     
 
      [bookmark: pgfId-1061469] Step 1[image: ] In the Analysis group box, do the following:
 
      
      	 [bookmark: pgfId-1061471]From the Building drop-down list, choose the building that you want to consider for analysis.
 
      	 [bookmark: pgfId-1062012]From the Type drop-down list, choose Heat Maps.
 
     
 
      [bookmark: pgfId-1061474]Step 2[image: ] You can apply the parameterized rules to your analysis from the Rules group box. See Rules Group Box for more information.
 
      [bookmark: pgfId-1061482]Step 3[image: ] Click Run.
 
      [bookmark: pgfId-1061483]Step 4[image: ] Click 3D Analytics to view the results in 3D environment or 2D to view the results in 2D environment.
 
      [bookmark: pgfId-1061484]The heat maps of the points for each floor is displayed in the right pane.
 
      [bookmark: pgfId-1061490]Figure 5-7 Heatmap Distribution of Number of Points
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1061496]
 
      [bookmark: pgfId-1061464]

      
      
 
     
 
     
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1069037][bookmark: 24829]Reports
      
      
 
     
 
 
     [bookmark: pgfId-1069038]The CMX analytics reporting provides a more regular, manager-oriented set of information through the provision of parameterized templates to measure various common trends and patterns that occur over time in the building. 
 
     [bookmark: pgfId-1067304]This section describes the report templates provided and the parameters they take in order to tailor them to the building information required. This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-1067340]Detected vs. Connected Devices
 
     	 [bookmark: pgfId-1074870]Device Count and Dwell Times By Day
 
     	 [bookmark: pgfId-1074879]Device Count by Time of Day
 
     	 [bookmark: pgfId-1074888]Device Count by Zone
 
     	 [bookmark: pgfId-1074897]Dwell Times by Time of Day
 
     	 [bookmark: pgfId-1074907]Movement Between Zones
 
     	 [bookmark: pgfId-1074992]Visit Frequency
 
    
 
   
 
    
     [bookmark: pgfId-1056661][bookmark: 62761]Detected vs. Connected Devices
 
     [bookmark: pgfId-1067895]The detected vs. connected devices report shows an overview of the number of devices that were connected to the network. This report shows those devices that were merely connected during a given time period for a particular zone.
 
     [bookmark: pgfId-1075118]See the Configuring Detected vs. Connected Devices on the Selected Zone for more information.
 
     
      [bookmark: pgfId-1056946][bookmark: 45548]Configuring Detected vs. Connected Devices on the Selected Zone
 
      [bookmark: pgfId-1056985]To configure the detected vs. connected devices report, follow these steps:
 
     
 
      [bookmark: pgfId-1057000] Step 1[image: ] Click the Reporting tab from the left pane.
 
      [bookmark: pgfId-1057024]Step 2[image: ] From the Select Report Type drop-down list, choose Detected vs. Connected Devices.
 
      
      	 [bookmark: pgfId-1057039]From the Date from drop-down list, choose the start date.
 
      	 [bookmark: pgfId-1057043]From the Date to drop-down list, choose the end date.
 
      	 [bookmark: pgfId-1062892]From the Time from drop-down list, choose the start time.
 
      	 [bookmark: pgfId-1062893]From the Time to drop-down list, choose the end time.
 
      	 [bookmark: pgfId-1072131]From the Zone drop-down list, choose the zone. 
 
     
 
      [bookmark: pgfId-1057045]Step 3[image: ] Click Run Report.
 
      [bookmark: pgfId-1058111]The detected vs. connected devices report is displayed in the right pane. The report shows the probing and associated client counts in the selected zone.
 
      [bookmark: pgfId-1068135]The result of this report contains the following:
 
      
      	 [bookmark: pgfId-1068136]A chart showing the number of detected and connected devices in the selected area over a time period.
 
      	 [bookmark: pgfId-1068170]Distribution image showing the distribution of devices on the floor. 
 
     
 
      [bookmark: pgfId-1068075]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1072688][bookmark: 90218]Device Count and Dwell Times By Day
 
     [bookmark: pgfId-1072689]The device count and dwell times by day report compares the number of devices in different dwell time categories for the same time period across consecutive days for a particular zone. The dwell time ranges provided in this report template are:
 
     
     	 [bookmark: pgfId-1072690]Less than 5 minutes (passing through)
 
     	 [bookmark: pgfId-1072691]5-45 minutes (short term customers)
 
     	 [bookmark: pgfId-1072692]45 minutes - 2 hours (long term customers)
 
     	 [bookmark: pgfId-1072693]Greater than 2 hours (staff)
 
     	 [bookmark: pgfId-1072694]All devices detected
 
    
 
     [bookmark: pgfId-1072698]See the Configuring Device Count and Dwell Times By Day for more information.
 
     
      [bookmark: pgfId-1072700][bookmark: 63241]Configuring Device Count and Dwell Times By Day
 
      [bookmark: pgfId-1072701]To configure device count and dwell times by day report, follow these steps:
 
     
 
      [bookmark: pgfId-1072702] Step 1[image: ] Click the Reporting tab from the left pane.
 
      [bookmark: pgfId-1072703]Step 2[image: ] From the Select Report Type drop-down list, choose Device Count and Dwell Times By Day.
 
      
      	 [bookmark: pgfId-1072704]From the Date from drop-down list, choose the start date. The report shows the number of devices broken down by dwell time from the selected date onwards.
 
      	 [bookmark: pgfId-1072705]From the Date to drop-down list, choose the end date. The report shows the number of devices broken down by dwell time until the selected date.
 
      	 [bookmark: pgfId-1072706]From the Time from drop-down list, choose the start time period for which you want to generate the report. The result shows the comparison of the same time period across consecutive days for a particular zone.
 
      	 [bookmark: pgfId-1072707]From the Time to drop-down list, choose the end time.
 
      	 [bookmark: pgfId-1072708]From the Zone drop-down list, choose the zone you want to reference as a zone of interest
 
     
 
      [bookmark: pgfId-1075170]Step 3[image: ] Click Run Report.
 
      [bookmark: pgfId-1075171]The device count and dwell times by day report shows the comparison of the time period across consecutive days for a particular zone.
 
      [bookmark: pgfId-1072851]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1072853][bookmark: 15475]Device Count by Time of Day
 
     [bookmark: pgfId-1072854]The device count by time of day report compares the number of devices in several dwell time categories for a time period over a number of days.
 
     [bookmark: pgfId-1068275]See the Configuring Device Count by Time of Day for more information.
 
     
      [bookmark: pgfId-1064429][bookmark: 69445]Configuring Device Count by Time of Day
 
      [bookmark: pgfId-1064430]To configure device count by time of day report, follow these steps:
 
     
 
      [bookmark: pgfId-1064431] Step 1[image: ] Click the Reporting tab from the left pane.
 
      [bookmark: pgfId-1064432]Step 2[image: ] From the Select Report Type drop-down list, choose Device Count by Time of Day.
 
      
      	 [bookmark: pgfId-1064433]From the Date from drop-down list, choose the start date. 
 
      	 [bookmark: pgfId-1064434]From the Date to drop-down list, choose the end date. 
 
      	 [bookmark: pgfId-1064437]From the Zone drop-down list, choose the zone you want to reference as a zone of interest
 
     
 
      [bookmark: pgfId-1064438]Step 3[image: ] Click Run Report.
 
      [bookmark: pgfId-1068514]The device count by time of day report is displayed in the right pane. [bookmark: 90430]
 
      [bookmark: pgfId-1072495]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1072470][bookmark: 54454]Device Count by Zone
 
     [bookmark: pgfId-1056860]The device count by zone report shows device counts for all zones in a given building for a predefined set of time period on a given day. This report shows device passing through and those staying for a significant time within the particular zone.
 
     [bookmark: pgfId-1058291]See Configuring a Device Count by Zone section for more information.
 
     
      [bookmark: pgfId-1056861][bookmark: 38490]Configuring a Device Count by Zone
 
      [bookmark: pgfId-1056862]To configure a device count by zone report, follow these steps:
 
     
 
      [bookmark: pgfId-1056863] Step 1[image: ] Click the Reporting tab from the left pane.
 
      [bookmark: pgfId-1056864]Step 2[image: ] From the Select Report Type drop-down list, choose Device Count by Zone.
 
      
      	 [bookmark: pgfId-1058299]From the Date drop-down list, choose the date for which you want the report to be generated.
 
      	 [bookmark: pgfId-1063256]From the Building drop-down list, choose the building on which you want to run the analysis.
 
     
 
      [bookmark: pgfId-1058336]Step 3[image: ] Click Run Report to view a graph of devices that are passing through or staying within the zone. The difference between device passing through or staying is determined by the amount of dwell time the device spends in that zone (5 minutes is the current cutoff time between passing and staying devices).
 
      [bookmark: pgfId-1058338]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1058303][bookmark: 19276]Dwell Times by Time of Day
 
     [bookmark: pgfId-1059103]The dwell times by time of day report shows for how the average dwell time changes over time in a given zone. The duration is measured every 15 minutes and the average is taken. This report excludes extremely short or long dwell time to give more balanced result.
 
     [bookmark: pgfId-1073821]See Configuring Dwell Times by Time of Day Report section for more information.
 
     
      [bookmark: pgfId-1059074][bookmark: 64879]Configuring Dwell Times by Time of Day Report
 
      [bookmark: pgfId-1059099]To generate a dwell times by time of day report, follow these steps:
 
     
 
      [bookmark: pgfId-1059109] Step 1[image: ] Click the Reporting tab from the left pane.
 
      [bookmark: pgfId-1059113]Step 2[image: ] From the Select Report Type drop-down list, Choose Dwell Times by Time of Day.
 
      [bookmark: pgfId-1062437]Step 3[image: ] From the Date drop-down list, choose the start date.
 
      [bookmark: pgfId-1062438]Step 4[image: ] From the Time from drop-down list, choose the start time.
 
      [bookmark: pgfId-1062439]Step 5[image: ] From the Time to drop-down list, choose the end time.
 
      [bookmark: pgfId-1059125]Step 6[image: ] From the Zone drop-down list, choose the zone point.
 
      [bookmark: pgfId-1059162]Step 7[image: ] Click Run Report.
 
      [bookmark: pgfId-1074048]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1074687][bookmark: 78175][bookmark: 18586][bookmark: 64051][bookmark: 79554]Movement Between Zones
 
     [bookmark: pgfId-1074688]The movement between zones report provides a breakdown of all zones at specific points as devices passes to and from the focus zone. This report gives the following information:
 
     
     	 [bookmark: pgfId-1066766]The zone where the device was first detected
 
     	 [bookmark: pgfId-1066767]The intermediate zone through which the device passes
 
     	 [bookmark: pgfId-1071197]The immediate zone before and after where the device was last detected
 
    
 
     
      [bookmark: pgfId-1063496]Configuring Movement Between Zones
 
      [bookmark: pgfId-1063497]To configure movement between zones, follow these steps:
 
     
 
      [bookmark: pgfId-1063498] Step 1[image: ] Click the Reporting tab from the left pane.
 
      [bookmark: pgfId-1063499]Step 2[image: ] From the Select Report Type drop-down list, choose Movement Between Zones.
 
      [bookmark: pgfId-1063500]The following parameters are displayed:
 
      
      	 [bookmark: pgfId-1063501]From the Date from drop-down list, choose the start date.
 
      	 [bookmark: pgfId-1063502]From the Date to drop-down list, choose the end date.
 
      	 [bookmark: pgfId-1063503]From the Time from drop-down list, choose the start time period for which you want to generate the report.
 
      	 [bookmark: pgfId-1063504]From the Time to time drop-down list, choose the end time period for which you want to generate the report.
 
      	 [bookmark: pgfId-1063505]From the Focus zone drop-down list, choose the zone you want to reference as a focus zone.
 
     
 
      [bookmark: pgfId-1063506]Step 3[image: ] Click Run Report.
 
      [bookmark: pgfId-1063507]The movement between zones report is displayed in the right pane.
 
      [bookmark: pgfId-1074827]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1074524][bookmark: 66251]Visit Frequency
 
     [bookmark: pgfId-1074525]The visit frequency report generates a list of devices with the most number visits to the venue. The time spent in the venue is considered a single visit as long as the device does not go undetected for one hour. The report considers the same time window over consecutive days. 
 
     [bookmark: pgfId-1074526]The result shows MAC address of the frequently seen devices in the building along with the frequency distribution of those devices.
 
     [bookmark: pgfId-1074530]See Configuring the Frequency of Visits for more information.
 
     
      [bookmark: pgfId-1074532][bookmark: 33995]Configuring the Frequency of Visits
 
      [bookmark: pgfId-1074533]To configure the frequency of visits, follow these steps:
 
     
 
      [bookmark: pgfId-1074534] Step 1[image: ] Click the Reporting tab from the left pane.
 
      [bookmark: pgfId-1074535]Step 2[image: ] From the Select Report Type drop-down list, choose Visit Frequency.
 
      [bookmark: pgfId-1074536]The following parameters are displayed:
 
      
      	 [bookmark: pgfId-1074537]In the Top Frequent Visitors text box, enter the number of top devices that were frequently seen during a particular time and date in the building. For example, if you want to see top 10 devices during a particular time period, then enter 10 in the Top Frequent Visitors text box.
 
      	 [bookmark: pgfId-1074538]From the Date from drop-down list, choose the start date. The report shows the frequently seen top N devices from the selected date onwards.
 
      	 [bookmark: pgfId-1074539]From the Date to drop-down list, choose the end date. The report shows the frequently seen devices until the selected date.
 
      	 [bookmark: pgfId-1074540]From the Time from drop-down list, choose the start time period for which you want to generate the report. The result shows the top N frequently seen devices in the building during the selected time. 
 
      	 [bookmark: pgfId-1074541]From the Time to drop-down list, choose the end time period for which you want to generate the report. 
 
     
 
      [bookmark: pgfId-1074542]Step 3[image: ] Click Run Report. The following report is displayed in the right pane.
 
      
      	 [bookmark: pgfId-1074548]A histogram showing the number of devices vs. number of visits. 
 
      	 [bookmark: pgfId-1074581]A table showing how frequently a particular device was seen in the building along with its MAC address.
 
     
 
    
 
   
 
    
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1286274]CMX Analytics System Messages
      
      
 
     
 
 
     [bookmark: pgfId-1281959][bookmark: marker-1286143]This appendix lists and describes system messages for Cisco CMX analytics service. The system software sends these messages to the console during operation.
 
     [bookmark: pgfId-1281960]This appendix contains the following sections:
 
     
     	 [bookmark: pgfId-1287880]During Setup
 
     	 [bookmark: pgfId-1287884]During Analytics
 
     	 [bookmark: pgfId-1288850]Analytics Error Message
 
    
 
   
 
    
     [bookmark: pgfId-1288851][bookmark: 23251]During Setup
 
     [bookmark: pgfId-1288889]The below table lists the error messages that you may get while setting up the CMX analytics system.
 
     
      
       
        [bookmark: pgfId-1288854]Table A-1 Error Messages During Setup
 
       
      
        
        	 
          
          [bookmark: pgfId-1288858]Error Message
         
  
        	 
          
          [bookmark: pgfId-1288860]Recommended Actions
         
  
       
 
        
        	 [bookmark: pgfId-1288862]No UI is displayed at all
  
        	
          
          	 [bookmark: pgfId-1288864]Check if Jboss is running. Use Telnet to connect and if it is not accepting connections on localhost, then connect using the IP address of the machine.
 
         
  
       
 
        
        	 [bookmark: pgfId-1288866]Can’t login to application
  
        	
          
          	 [bookmark: pgfId-1288988]Check if the MSE database is up and running and is accepting connections.
 
          	 [bookmark: pgfId-1288989]Execute ““java -jar QueryTool.jar “select count(*) from point””. Check it displays a number > 0. If not, then, check if the MSE API is up and accepting connections by running the MSE client. If not, check whether the MSE is running.
 
         
  
       
 
        
        	 [bookmark: pgfId-1288870]Invalid Username/Password
  
        	 [bookmark: pgfId-1288872]CMX analytics uses the same login and password that you give at the time of selecting the service in the Prime Infrastructure UI.
  
       
 
        
        	 [bookmark: pgfId-1289050]3D Environment appears but all floors are black
  
        	
          
          	 [bookmark: pgfId-1289036]Clear the browser cache.
 
          	 [bookmark: pgfId-1289037]Check that there are not large floor plan being loaded.
 
         
  
       
 
        
        	 [bookmark: pgfId-1288882]Can’t select dates
  
        	 [bookmark: pgfId-1288884]When the application starts up, it downloads information from the Oracle database. This may take a little time before available dates are present
  
       
 
        
        	 [bookmark: pgfId-1288886]No zones are referenced or shown
  
        	 [bookmark: pgfId-1288888]The user needs to enter the coverage areas in the Prime Infrastructure, which correspond to zones. Stop the Analytics and add zones and then restart.
  
       
 
        
        	 [bookmark: pgfId-1290914]Latest available date is not current
  
        	 [bookmark: pgfId-1290916]Login to the MSE and check /opt/mse/logs/analytics/mse.log for the latest download of data. This shows the latest data. Also check the MSEclient process (java -jar MSEclient.jar run) is running as this transfers data from the MSE to the CMX analytics. Check if the Prime Infrastructure is showing the current clients.
  
       
 
      
     
 
    
 
   
 
    
     [bookmark: pgfId-1288138][bookmark: 72878]During Analytics
 
     [bookmark: pgfId-1289189]The below table lists the error messages that you may during analytics.
 
     
      
       
        [bookmark: pgfId-1289192]Table A-2 Error Messages During Analytics
 
       
      
        
        	 
          
          [bookmark: pgfId-1289196]Error Messages
         
  
        	 
          
          [bookmark: pgfId-1289198]Recommended Action
         
  
       
 
        
        	 [bookmark: pgfId-1289200]Analytics hangs - no analytics results shown
  
        	
          
          	 [bookmark: pgfId-1289243]Restart jboss to see if that frees up some resources that were required but not available.
 
          	 [bookmark: pgfId-1289244]Check server.log to see the analytics progressing and look for which step does not succeed.
 
         
  
       
 
        
        	 [bookmark: pgfId-1289204] Points shown outside map or not where expected
  
        	
          
          	 [bookmark: pgfId-1289269]There may be an outdoor area defined in which case this is deliberate. However, it typically indicates that points are being located outside the building by the MSE triangulation algorithm. One way to address this is to make sure the floors have the default inclusion region, which is usually the boundary of the image. The inclusion region makes sure, that anything located outside the floor is snapped to the closest boundary. 
 
          	 [bookmark: pgfId-1289270]Check GPS marker placements on NCS map (for 2D) to confirm they are correctly placed.
 
          	 [bookmark: pgfId-1289271]Check for recent changes in dimensions of floor plan which puts historical points outside.
 
          	 [bookmark: pgfId-1289459]Check also AP placement
 
         
  
       
 
        
        	 [bookmark: pgfId-1289208]No results appear in reports
  
        	
          
          	 [bookmark: pgfId-1289295]This may be because the parameters specify no solution.
 
          	 [bookmark: pgfId-1289296]Check that the same type of analysis can be done in the analytics.
 
         
  
       
 
        
        	 [bookmark: pgfId-1289212]Analytics not relating to believed reality
  
        	
          
          	 [bookmark: pgfId-1289353]There are many aspects which may not match expectations (busier in areas which are meant to be calm, dwell times shorter than expected, etc.) The main ones are the number of the number of devices being shown and where they are located within the building.
 
          	 [bookmark: pgfId-1289354]Historically, we have seen areas of high interference in which many more devices were detected than were in the area, even from up to 100m away. However, this should not be apparent in well configured networks with few, if any rogue APs. 
 
          	 [bookmark: pgfId-1289355]There are many places to check to see if everything is in order.
 
         
  [bookmark: pgfId-1289356]–[image: ] 1. Examine the heatmap option. This shows where points have been located and the density of them. Typically, the darker colors should be in areas of high traffic. You should not be seeing inordinate amounts of traffic in areas with believed few people. If the distribution of points is skewed, and/or with artefacts, then you are perhaps looking at a suboptimal network layout. See example below. In addition, the user can turn on the AP locations and verify that detected points are around them.
  [bookmark: pgfId-1289357]–[image: ] The points on which the analytics take place are taken directly from the MSE history database. The Analytics is a way of visualizing this data, and at the same time it may show times at which the MSE or network was down where there is lack of device presence. Check the previous availability of the MSE. Analytics brings in each point from the MSE and builds a database of device/paths. Therefore, by looking directly at the Analytics database will show what the subsequent analytics is based up.
  [bookmark: pgfId-1298779]–[image: ] To check the number of devices for a certain rules in the analytics, select "Typical locations" with "no of locations" set to 1. The balloon on the resulting single node will indicate the number of devices/paths and points. This facility will be made more explicit in future releases.
  [bookmark: pgfId-1289214]3. Look at the reports as they show long term behavior and so the user should be seeing things like weekend trends or peak times. This may help focus the diagnosis into particular parts of the databases.
 
  
       
 
      
     
 
    
 
   
 
    
     [bookmark: pgfId-1288366][bookmark: 52389]Analytics Error Message
 
     [bookmark: pgfId-1289491]The below table lists the Analytics error messages.
 
     
      
       
        [bookmark: pgfId-1298802]Table A-3 Analytics Error Message
 
       
      
        
        	 
          
          [bookmark: pgfId-1298806]Error Message
         
  
        	 
          
          [bookmark: pgfId-1298808]Recommended Action
         
  
       
 
        
        	 [bookmark: pgfId-1298810]not enough data, please broaden your search terms"
  
        	 [bookmark: pgfId-1298812]No data was found for the specified set of rules. Try to remove or extend some of the filters to see if that makes the message go away. If it does not, then you need to check that there is data in the database.
  
       
 
        
        	 [bookmark: pgfId-1298814]Max Point Limit Reached, using sample
  
        	 [bookmark: pgfId-1298816]Too much data was found for the specified set of filters. A maximum of 250k points are currently considered for the analysis. This means that the figures for number of devices is fixed below the actual detected level, however the other parameters such as dwell, crowding are still valid. This is a hard limit at the moment. 
  
       
 
        
        	 [bookmark: pgfId-1298818]Please provide correct beacon points”
  
        	 [bookmark: pgfId-1298820]No beacon points have been set to carry out alternative path analysis.
  
       
 
        
        	 [bookmark: pgfId-1298822]Internal server error
  
        	 [bookmark: pgfId-1298824]Need to contact CMX analytics Team (mse-analytics@cisco.com)
  
       
 
      
     
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1011492]Preface
      
      
 
     
 
 
     [bookmark: pgfId-1011552]This preface contains the following sections:
 
     
     	 [bookmark: pgfId-1011556]Conventions
 
     	 [bookmark: pgfId-1011560]Related Documentation
 
     	 [bookmark: pgfId-1011564]Obtaining Documentation and Submitting a Service Request
 
    
 
   
 
    
     [bookmark: pgfId-1011568][bookmark: 20732][bookmark: 19287]Conventions
 
     [bookmark: pgfId-1011570]This guide uses the following conventions:
 
     
      
       
        [bookmark: pgfId-1011573]Table 1 Conventions
 
       
      
        
        	 
          
          [bookmark: pgfId-1011577]Convention
         
  
        	 
          
          [bookmark: pgfId-1011579]Indication
         
  
       
 
        
        	 [bookmark: pgfId-1011581] bold font 
  
        	 [bookmark: pgfId-1011583]Commands and keywords and user-entered text appear in bold font.
  
       
 
        
        	 [bookmark: pgfId-1011585]italic font
  
        	 [bookmark: pgfId-1011587]Document titles, new or emphasized terms, and arguments for which you supply values are in italic font.
  
       
 
        
        	 [bookmark: pgfId-1011589][ ]
  
        	 [bookmark: pgfId-1011591]Elements in square brackets are optional.
  
       
 
        
        	 [bookmark: pgfId-1011593]{x | y | z}
  
        	 [bookmark: pgfId-1011595]Required alternative keywords are grouped in braced and separated by vertical bars.
  
       
 
        
        	 [bookmark: pgfId-1011597][x | y | z}
  
        	 [bookmark: pgfId-1011599]Optional alternative keywords are grouped in braced and separated by vertical bars.
  
       
 
        
        	 [bookmark: pgfId-1011601]string
  
        	 [bookmark: pgfId-1011603]A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.
  
       
 
        
        	 [bookmark: pgfId-1011605]courier font
  
        	 [bookmark: pgfId-1011607]Terminal sessions and information the system displays appear in courier font
  
       
 
        
        	 [bookmark: pgfId-1011609]<>
  
        	 [bookmark: pgfId-1011611]Nonprinting characters such as passwords are in angle brackets.
  
       
 
        
        	 [bookmark: pgfId-1011613][ ]
  
        	 [bookmark: pgfId-1011615]Default responses to system prompts are in square brackets.
  
       
 
        
        	 [bookmark: pgfId-1011617]!, #
  
        	 [bookmark: pgfId-1011619]An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.
  
       
 
      
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1011621]Note Means reader take note

     
     
 
    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-1011622]Tip Means the following information will help you solve a problem.

     
     
 
    

    
 
     
      
    
 
    
 
    
     [bookmark: pgfId-1011624]
     Caution Means 
     reader be careful. In this situation, you might do something that can result in equipment damage or loss of data.
      
      
 
     

    
 
     
      
    
 
    
 
    [bookmark: pgfId-1011625]Warning This warning symbol means danger. You are in a situation that could cause bodily injury. Before you work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar with standard practices for preventing accidents. (To see translations of the warnings that appear in this publication, refer to the appendix "Translated Safety Warnings.")

     
     
 
    

    
 
   
 
    
     [bookmark: pgfId-1011628][bookmark: 45314]Related Documentation
 
     [bookmark: pgfId-1011629]See the  Cisco 3310 Mobility Services Engine Getting Started Guide or Cisco 3350 Mobility Services Engine Getting Started Guide for mobility services engine installation and setup information. 
 
     [bookmark: pgfId-1011630]These documents are available on Cisco.com at the following URL:
 
     [bookmark: pgfId-1011632] http://www.cisco.com/en/US/products/ps9742/tsd_products_support_install_and_upgrade.html 
 
   
 
    
     [bookmark: pgfId-1011638][bookmark: 46730]Obtaining Documentation and Submitting a Service Request
 
     [bookmark: pgfId-1011639]For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly  What’s New in Cisco Product Documentation , that also lists all new and revised Cisco technical documentation, at:
 
     [bookmark: pgfId-1011641] http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html 
 
     [bookmark: pgfId-1011642]Subscribe to the  What’s New in Cisco Product Documentation  as an RSS feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco currently supports RSS Version 2.0.
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